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GET EXACTLY 
THE RIGHT MEMORY 

FOR YOUR MAC ... 
FOR A FRACTION OF WHAT 

YOU'D EXPECT TO PAY! 

Y
ou know that finding just the right 

memory upgrade plays a big part in 

getting the performance you want from 

your Mac (and that upgrading your Mac's RAM 

can save you a bundle of cash compared to buying 

a new system). Now that you're ready to get your 

upgrade installed and start enjoying better 

performance, how do you figure out w ho has 

"the best deal" on Mac memory? You'll see tons 

of " lowest-price-anywhere!" deals, but really 

getting the best deal involves more than just 

price-it's also about things like compatibility, 

performance, and support. That' s w here Crucial 

comes in. 

Will your memory be 
COMPATIBLE with my Mac? 
Today's Macs require specific memory designed to 

exacting standards. Do you really feel 

comfortable trying to sort through a foreign

looking list of base part numbers to figure out 

which memory is right for your Mac? Our Crucial• 

Memory Advisor'" tool has approximately 594 

upgrade choices for 250 distinct Mac models. In 

just three clicks, we 'll provide you w ith a specific, 

detailed list of compatible upgrades, 

recommended upgrades, and even the most 

popular upgrades. Your FREE memory upgrade 

advisor report wi ll show you only the parts that 

we guarantee w ill work in your Mac, or your 

money back! 

We're able to do this because Crucial is a division 

of Micron, one of the world's largest memory 

manufacturers and a supplier to leading 

notebook and desktop manufacturers (OEMs). 

Micron collaborates w ith OEMs to develop 

memory that w ill perform compatibly w ith the 

rest of the system specifications; in fact, chances 

are good that you have Micron memory in your 

Mac right now! 

What kind of PERFORMANCE 
can I expect? 
Whether you use your Mac as a tool for 

schoolwork or household bills, an entertainment 

center for music or movies, or as part of your job 

in image editing and design, a Crucial memory 

upgrade is a fast and easy way to prepare your 

Mac to run faster, multi-task between 

applications, and open large files. Our Memory 

Advisor tool provides you with information to 

advise you and explain the various levels of 

performance gains you can expect when you 

purchase a certain upgrade. 

Exclusive offer for 
MacAddict readers! 

Visit Crucial today, and in just three mouse clicks, get your 

memory upgrade advisor report for your specific Mac 

desktop or notebook, including specific performance recommendations, 

the most popular upgrades, and the best upgrade value for you. And, for a 

limited time, Crucial is offering Mac users a SPECIAL DISCOUNT. To find the 

right memory for your system in just seconds (and get a great deal!) visit: 

www.crucial.com/macaddict 

Will your PRICE max out my 
credit card? 
You want the assurance that your memory 

upgrade is the right match for your Mac and that 

it will be the same quality as the original 

manufacturer's parts, but you hate paying the 

premium "dealership " price. As the only 

consumer memory upgrade provider that's part 

of a major DRAM manufacturer, Crucial sells OEM

quality modules over the Internet at factory

direct prices. 

On top of that, enjoy free shipping (for a limited 

time, on orders shipped within the contiguous 

U.S.), free customer service, free tech support, and 

a free limited lifetime warranty. 

Will you SUPPORT the 
product after the sale? 
Don't worry; we won't leave you hanging if you 

need help. Our expert technical support-all 

"levels" of it-is always free. And our 30-day, no

risk compatibility guarantee means that if the 

memory you purchased through the Memory 

Advisor tool isn't compatible with your Mac or 

doesn 't perform as you expected, simply package 

it up and send it back. 

Crucial is the answer for Mac 
memory! 
With Mac memory from Crucial, you get premium 

quality and premium service without paying 

premium price! Crucial's user-friendly Memory 

Advisor tool and helpful customer support make 

it easy to get compatible memory for your Mac. 

Order yours today and start enjoying better 

performance for your Mac tomorrow! 

crucial® 
T E C H N 0 L 0 G Y 

A Division of Micron 

The Memory Experts'M 

C>2005 M icron Technology, Inc. All rig hts reserved. Information is subje~ to chan9e without notic.e. Crucia l Techr:iology •. t.he Cruci~l logo, M~mory Advisor, and The Me~orx Experts are trademar~s/- service n:iarks 
of Micron Technology, lnc . All other trademarks are the property of th eir respective owners. Crucial Technology 1s a div1s1on of M icron Semiconductor Products, Inc., w htCh 1s a w holly owned subs1d1ary of Micron 
Technology. 



features 
16 Understanding ilife '05 

Can't make the five apps living in Apple's new creativity suite get along? Our 
experts answer questions and give advice about common GarageBand 2, iPhoto 
5, iMovie HD, iDVD 5, and iTunes issues. by Shelly Brisbin, Brad Miser, Andrew 
Tokuda, and Johnathon Williams 

26 Untwist 
Your Wrist 
Too much typing turning your 
mitts into twisted talons? Here 
are some keyboards that may help 
save your wrists. Just don't get too 
self-conscious-some of them look 
kinda funny. by Jake Widman 

32 Tanks for Your Memories 
Don't know xD from SD? Wondering where to shove your Memory 
Stick? Our field guide to media cards will help you keep your 
digital-camera storage options straight. by Fredric Paul 

how to 
52 Ask Us 
We show you how to make Yahoo and Hotmail get along with Mail, train you how to break 
the password protection on encrypted PDFs, and teach you what to do with those annoying 
expired demos that just won't go away. We've even got a sewing tip this month! 

54 Max Out 
Your Mac mini 
You may like your Mac 
mini just the way it is, but 
our resident mad scientist (and How-To 
editor) knows secret ways to unlock its 
hidden potential-some of which are 
crazier than others. by Niko Coucouvanis 

59 Convert PC Video 
Files to QuickTime 
Sick of running into WMV and AVI files 
whenever you want to watch a video? 
Here's how to translate alien video 
formats into something QuickTime can 

understand. by Johnathon Williams 

60 Put Linux on Your iPod 
Prove your supreme geekery to the 
world by installing everyone's favorite 
open-source operating system on your 
personal music player. Make a penguin 
proud! by Alex Handy 

61 Use Skype 
to Chat While 
Gaming 
Typing's so 2004. 
You can speak with 
your friends in World of Warcraft and 
other on line games by using Skype, a 
powerful, simple-to-set-up on line voice
chat app. by Chris Barylick 
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a better machine. a better magazine. 

ever~ month 
08 Editors' Page 
Our editor in chief discovers that Apple's marketing 
department is far too modest. 

10 Get Info 
There's an iPod out there with your name on it-maybe 
it's one of the new 4GB and 6GB iPod minis. One of them 

is even less than $200 (guess which one). Also, the 
iPod Case of the Month gets fuzzy, how to fix Software 
Update, helpful AppleScript books, why the accordion is 
cool again, and more. 

35 Reviews 
38 12-inch PowerBook G4 notebook 
38 15-inch PowerBook G4 notebook 
38 17-inch PowerBook G4 notebook 
50 AirPlay iPod FM transmitter 
42 Business Inkjet 1200d inkjet printer 
45 Call of Duty: United Offensive first-person shooter 
46 Callisto mk II speakers 
40 Carrara 4 Pro 30 software 
46 DJ Console audio mixer 
41 Evolt E-300 camera 
50 H-D70 FlipUp camera-LCD sunshade 
48 iDive video-management software 
36 iWork '05 productivity suite 
49 MTX: Mototrax dirt-bike racing game 
50 Picture Rescue media-card utility 
44 Primatte Chromakey 2.0 Photoshop masking plug-in 
48 The Mouse BT Bluetooth mouse 
49 TrayDock hard-drive enclosure 
44 Treo 650 phone and PDA hybrid 
47 VerticalMouse 2 ergonomic mouse 

78 Log Out 
78 Letters 

79 Contest 

51 The Hot List 
We'd spend our own hard-earned 
money on these products. 

QUICK TIPS 

Our readers tell us their blog 
secrets, show us their crafty iPod 
cases, and-best of all-share 

their cookies! Also, one astute 
reader uncovers a disc-design 
conspiracy worthy of The X-Fi/es. 

Win a set of ProSticks powered 
speakers from DVForge and have 

your neighbors call the cops on 
your next party. 

80 Shut Down 
Apple's mass-market 
penetration is complete. 

FROM THIS MONTH'S ISSUE 

+ WIRELESS MINI 
Upgrading a Mac 

min i's RAM, hard 
drive, and optical 
drive is a simple 
procedure that most people can do at 
home. Adding AirPort and Bluetooth, 
however, requires parts that only an 
authorized Apple representative can 
supply-and install. 
From "Max Out Your Mac mini," p54. 
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+ BRAKE BEFORE 
TURNING 
Tight corners are 
great places to 
improve your time in 
any MTX: Mototrax 
race. The trick is to 
press the clutch (or let up on the gas) 
just before a turn, then punch it about 
midway through the turn . 
From Reviews, p49. 

+ iMPROVISE 
Need a low-budget microphone? Apple's 
in-ear iPod headphones work in a pinch. 

From "Put Linux on Your iPod," p60. 

+ FIND & REPLACE BUG 
Be careful when using iWork's Find & 
Replace. It puts your replacement word 
wherever your cursor is located before it 
seeks out the first instance of the word . 
From Reviews, p36. 





the disc 
Become a guitar god with eMedia's 
Rock Guitar Method, record audio 
passing through your Mac with 
Rogue Amoeba's Audio Hijack, make 
free long-distance Internet phone 
calls with Skype-and then dig into 
the rest of this month's collection of 
55 killer apps and utilities. 

Rock Guitar 
Method demo 
A guitar pro teaches you 
all the techniques you'll 
ever need if you want 
to play rock, punk, and 
metal. 

Record the sound 
output of any Cocoa or 
Carbon app-including 
Internet radio-and 
save it as a file. 

With Skype, you'll be 

making free Internet 
phone calls in no 
time-and it's good for 
chatting while playing 
on line games, as well. 

AUDIO & MUSIC 
Audio Hijack 2.1.3 
shareware 

Make Bookmarkable 
freeware 

MPFreaker 1.0 shareware 
Rock Guitar Method demo 
WireTap Pro 1.0.1 shareware 

DEVELOPMENT 
REALbasic OS X 5.5.4 
demo 

TextWrangler 2.0 freeware 

FUN&GAMES 
A Farewell to Kings 2.0.4 
shareware 

Lugaru 1.01 shareware 
Midnight Mansion 1.0.1 
shareware 

MTX: Mototrax 1.0 demo 
Pow Pow's Puzzle Attack 
1.0demo 

Solitaire XL 1.1 freeware 
wordSword 1.0 shareware 

GRAPHICS & MULTIMEDIA 
CandyBar 2.0.1 shareware 
Forty-Two DVDVX Plus 2.4 
shareware 

IDlve 1.2.5 shareware 
iPhoto Diet 3 .0.2 freeware 
IPhoto Library Manager 
2.0 freeware 

Photo to Movie 3 .1.1 
shareware 

UPGRADE 

Picture Rescue 1.1.0 trial 
Shoebox 1.0 .2 shareware 
Slick Sampler freeware 

INTERNET& 
COMMUNICATION 
BetterHTMLExport (for 
IPhoto 4) 2 .0.19 shareware 

BetterHTMLExport (for 
I Photo 5) 2.1 shareware 

Conference Recorder 
1.0.1 shareware 

Direct Mail 1.4.3 shareware 
Feeder 1.0 .2 shareware 
FllckrExport 1.2.1 freeware 
HTTPMail Plugin (Jaguar) 
1.42 freeware 

HTTPMail Plugin (Panther) 
1.42 freeware 

JiWlre Portable Hotspot 
Locator 1.0 freeware 

Mall Forward X 2.4 
shareware 

MailArchive 1.1 
shareware 

Photon 1.1 freeware 
PhotoToTypePad 1.1 
freeware 

phpMyAdmin 2.6.1-pl2 
freeware 

Skype 1.0.0.7 freeware 

PRODUCTIVITY 
AquaScribus freeware 
Directors Boards 1.1 
freeware 

Directors NoteBook 
SA 1.6.1d shareware 

Directors NotePad 1.0h 
shareware 

IClip 3.5.2 shareware 
!Present It 1.1 .1 shareware 
Presentation Prompter 4.1 
shareware 

Scribus 1.2.1 freeware 

UTILITIES 
BatChmod 1.34 freeware 
DiskTracker (Classic) 2 .3 
shareware 

DlskTracker (OS X) 2.3 
shareware 

DoubleCommand 1.5 .3 
freeware 

Fink 0 .7.1 freeware 
FlnkCommander 0.5.3 
freeware 

IPhoto Extractor 2.0b6 
free ware 

I Pod Linux Installer 0.3a 
freeware 

uControl 1.4.6 freeware 

SPONSORS 
JiWlre Portable Hotspot 
Locator 1.0 freeware 

Photo to Movie 3.1 .1 
shareware 

Picture Rescue 1.1.0 trial 

If you don't receive the Disc with your copy of MacAddict, you might want to consider upgrading. Each monthly 
disc contains cool demos, useful shareware and freeware, and the inimitable MacAddict Staff Video. To get 12 
issues of MacAddict that include this value-packed disc with your subscription (prorated If necessary) for just $1 
more per issue, call 888-771-6222-the operator will take care of everything. 
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Wanted: Control Freaks! 

DiskStudio™ allows you to create 
and remove disk partitions on the 
fly! Want to create a new partition 
for games or photos? No problem. 
Want to get rid of that old OS 9 
partition without backing up and 
reformatting your drive? It's easy. 

Podlock™ is a new utility that lets you 
do cool new stuff with your iPod. 
Optimize the data on your iPod so it 
works faster. You can also create a 
secret drive within your iPod that 
allows you to keep sensitive data away 
from prying eyes. And much more! 

Podlock"' 

Podlock'M 

J'J U G 
Ooll;t Volu~s Fuottfons 

~1:. 1.. ;~ • 
litrit ~~ Mui.mt i>.uw"1Md t>tlett 

O : ~D11ta 

Main Volume~ F\Jn(tlons 

Micromat is dedicated to bringing you cool and useful utilities for your 
Macintosh and iPod. Our flagship product, Tech Tool® Pro, has helped 
thousands of Macintosh users keep their Macs running at their absolute 
best. Tech Tool Pro can even recover lost data and resurrect faulty disk 
drives. Learn more about Micromat products by visiting our website. 

Jb] Micromat Inc. 800-829-6227 707-566-3831 info@micromat.com www.micromat.com 

©2005 Micromat, Inc. All rights reserved. DiskStudio, Pod Lock and Tech Tool are trademarks of Micromat, Inc. 



08 /\ EDITORS' PAGE 
f;-J a note from the kernel 

Doing the Numbers 
Marketing types rarely understate a 
product's capabilities. And so it was with 
some puzzlement that I read an ad for the 
1GB iPod shuffle's random-play feature, 
which stated, "240 songs. A million 
possibilities." Now, I'm no math wiz, but 
I do know that 240 songs could most 
definitely be played in more than a million 
different sequences. 

"But how many more?" I wondered. So 
I fired up my copy of Wolfram Research's Mathematica((:; 
Apr/05, p47), entered the appropriate query-and stared goggle
eyed at the answer: The number of different orders in which you can 
play 240 songs is 4,067,885,363,647,058,120,493,575,921,486, 
885,310, 172,051, 259,182,827, 146,069, 755 ,969,081,486,918,92 5, 
585, 104,009, 100, 729, 728,348, 52 2, 923,820,890, 245 ,870,098, 
659, 147, 156,051, 905 '732' 563,147,381, 599,098,459,244, 7 52,463, 
027,688, 115, 70 5, 371, 704,628, 286,326,621, 238,456,543,307, 267, 
608,612,545'168, 33 7, 779,669, 138, 7 59,451, 760,395 ,968,217,423, 
617,9 54,3 30, 737,034,164, 596,496, 963 ,986,817, 722' 252, 2 21,059, 
768,080,852,489,940, 99 5,605'579,171,999,666, 916,004,042,965' 
293, 896, 799,800, 598,079,985,264, 195, 119, 506,681,5 77,622,056, 
215,044,851,618,236,292,136,960,000,000,000,000,000,000, 
000,000,000,000,000,000,000,000,000,000,000,000,000. We' ll 
call that a bit over "a million possibilities." 

Just how big is this number (which, by the way, most sentient 
beings round off to the number 4 followed by 468 zeros-science
types write that as 4x10468)? Well, some theorists opine that all 
matter will decay after the universe turns 1035 years old , so if you 
played your iPod shuffle continuously until you went through all the. 
possible combinations of 240 four-minute songs, you'd have to play 
them for 7.4x10 430 life cycles of the universe. Better get started. 

While in math mode, I decided to delve into a few more Apple
related stats. In early March, the iTunes Music Store sold its 300 
millionth song-it'd take you over 2,283 years to listen to them all, 
during which time a snail crawling at 0.013 meters per second could 
circumnavigate the Earth more than 23 times. The 10 millionth iPod 
was sold in mid-December 2004-laid end to end, all those iPods 
would reach almost from Atlanta to Philadelphia . Around 55 million 
people have visited Apple Stores worldwide-that's roughly the 
population of Spain, Greece, and Denmark combined . 

Enjoy, --:-'I) 
l 1;4 

comingsoon :june2005 
Here's what our editors are preparing for the next issue of MacAddict. 

Niko Coucouvanis BORN 20 MILLION MINUTES AGO 

What's your favorite statistic? 
My favorite is actually a meta-statistic: the fact that 
marketing greed-weasels can twist numbers and 
hard data into pretty much whatever bottom line they 
want- such as the relationship between market share by 

revenue and by actual number of units sold. And no, I'm not talking 
about the iPod. OK, I am. 

Mark Rosenthal DR. ANIMALS 

What's your favorite statistic? 
Ratio of nuts buried by squirrels but never recovered to 
those buried and recovered-80:1. 

Sean Molloy MATHEMAGICIAN 

What's your favorite statistic? 
It's a tie between two useless stats I actually heard 
TV news reporters use to express shocking hugeness: 
either how many postage stamps you can fit on an IMAX 
screen, or how long it would take Niagara Falls to fill 

the dome of some new sports stadium if you turned that dome 
upside down. 

Peter Marshutz PETER REPEATER 

What's your favorite statistic? 
My favorite statistic is the recently revised average life 
expectancy for American males. We now have 77 years 
to live-that's 28,105 days, 674,520 hours, or 40,471,200 

Jake Widman ONE OUT OF FIVE EDITORS 

What's your favorite statistic? 
The utterly useless stats that are offered during 
sports broadcasts. "The team's gone 18-34 with him 
in the lineup, 9-17 with him hurt," or "He bats 0.254 
left-handed, 0.263 right ." 93.6 percent of the time, 

they tell you nothing. 

Roman Loyola BELLY ITCHER 

What 's your favorite statistic? 
Springtime. Statistics. Naturally, baseball comes to 
mind. Hall of Farner Dennis Eckersley's 1990 season as 
a closer was amazing: 48 saves, 73 strikeouts in 73.3 
innings, a 0.61 ERA, and he walked only four batters. 

Plus, he had one of the greatest mullets of all time-and there's no 
way to quantify that. 

What's your favorite statistic? 
Over 2,400,000 copies of MacAddict are printed 
each year- that 's more than enough copies for each 
and every resident of Paris, France; Paris , Arkansas; 
Paris, Idaho; Paris, Kentucky; Paris, Michigan ; Paris, 

Mississippi; Paris , Missouri; Paris, Ohio; Paris, Tennessee; Paris, 
Texas; and Paris, Virginia. 

t 
We'll teach you how to improve your photographs with iPhoto 5's new tools-and tell you when it's time to turn to Adobe 
Photoshop and its plethora of plug-ins. We'll show you how to set up your Mac for your kids' summer vacation, and 
explain all optical-disc formats, including CD-R, DVD+ and DVD- , and archival discs. We'll plug an IR transmitter into a 
Mac to create the ultimate universal remote, soup up our wireless network with homebrew Wi-Fi antennae, and share 
our favorite PowerBook travel tips. Finally, we'll take a look at the Sonos Digital Music System, Adobe Acrobat 7.0, 
Aspyr's Doom 3, and a whole lot more. 
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iPdDS FOR EV 
iPod Iii!} 

Music > 
Etttras 
Settings 

Bocklight 

> 
> 

The World's Greatest Music Players Form 
a United Front Against All Competition. 

W hen Apple announced its new iPod lineup in late February, 

the company made it clear to its competitors that it had no 

intention of relinquishing any segment of its commanding 

lead in the digital-music-player biz-and also made it clear to all us 

Mac addicts that there's no reason to even think of buying a player 

that's not an iPod. From $99 to $449, Apple's got us all covered. 

iPOD SHUFFLE 
There's not much new to report about 
the iPod shuffle ( t:H:H~e;,d Apr/05, 
p39). The wee white 0.78-ounce shuffle 
still comes in two flavors: the 512MB 
base model ($99) and the twice-as
capacious lGB model ($149)-no price 
changes, no changes in features or 
functions. The only new ponderable is 
why would you not want to plunk down 
an extra fifty bucks for a 4GB iPod mini 
($199). Unless, of course, you're a 
marathoner who needs the ultimate in 
skip protection and for whom each and 
every ounce counts. Or, for that matter, if 
you're the owner of a hard drive-based 
iPod who wants a second 'Pod for when 
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you're out and about-or, if you happen 
to live in Saskatchewan, for when you're 
oot and aboot. 

What's Another 
Fifty Bucks? 
It now costs $50 per notch to 
climb Apple's iPod ladder from the 
120-song 512MB iPod shuffle to 
the 15,000-song 60GB iPod photo. 
Well, sure, the last step up is a 
hundred bucks, but you get the 
picture-there's now an iPod for 
every economic strata. 

iPod rnlnl ----- - -- --
1\lUSI( 

f >ctras 

Settings 
Shuffle Songs 

Backflght 

iPOD MINI 
We thought that the original iPod mini 
was a bit too pricey for mass acceptance 
when it appeared in January 2004 at a 
relatively hefty $249. We were wrong. 
Style-conscious music lovers snapped 
up millions of the petite multicolored 
beauties. Now the 4GB iPod mini has 
slipped beneath the magic $200 barrier, 
and a 6GB bigger brother ($249) has 
joined it. Sister, actually, if Apple's new 
iPod mini marketing materials are any 
gauge of their targeted buyers-Apple's 
Web site touts the min i's vastly 
improved 18-hour battery life (the 
original mini was rated at 8 hours) as 

MENU 

.. II 

Price Model Capacity Songs Battery Life 

$99 iPod shuffle 512MB 120 12 hours 
+$50 
$149 240 12 hours iPod shuffle 1GB 

+$50 

$199 
+$50 
$249 

+$50 

$299 

+$50 

$349 
+ 100 

$449 

iPod mini 

iPod mini 

iPod 

iPod photo 

iPod photo 

4GB 1,000 18 hours 

6GB 1,500 18 hours 

20GB 5,000 12 hours 

30GB 7,500 15 hours 

60GB 15,000 15 hours 



ERYONE! 
being sufficient for ''a transatlantic flight, 
the limo ride to your hotel, and a few solid 
hours of boutique shopping," coos that 

it "goes with everything: Macs, 
PCs, sequins, and tees," and 
refers to its aluminum matte
finish case as sturdy enough to 
survive "the jostle of overzealous 

paparazzi." 
The mini now comes in four 

colors : silver, and punched-up 
versions of the original pink, 
blue, and green-if you own an 
original gold mini, you now have 
a collector's item. In another nod 
to fashion, the clickwheel icons 
now match the case color-
gray is so passe. Stylin' new 
armbands are available in gray, 

orange, yellow, blue, and pink-but unless 
your taste runs to the aforementioned 
passe gray, you'll need to purchase your 
armband at Apple's on line store. A new 
mini lanyard is also available for $19. 

Not all the news is good, however. 
Although both minis ship with-and sync 
and charge over-a USB 2.0 cable, a 
FireWire cable is now a $19 option; so is a 
$39 iPod mini Dock. 

iPOD CLASSIC 
No, that's not what Apple calls it; that's 
just what we call it here in the MacAddict 
Intergalactic Nerve Center. The no
surname iPod now comes in only one 
lonely model: a 20GB version for $299. 
Although both USB 2.0 and FireWire 
cables are included, you have to pay $39 
extra for a Dock. 

It's not strictly correct to call the 20GB 
iPod the only classic 'Pod still available. 
As of press time, Apple was still offering 
the $349 iPod U2 Special Edition; the 
extra fifty bucks buys you a sleek black 
case, red clickwheel, and $50 off The 
Complete U2 digital box set of 400 U2 
tunes-UTunes?-available from the 
iTunes Music Store for $149. Personally, 
we're waiting for the iPod 50 Cent Special 
Edition with faux bullet holes on its case . 

iPOD PHOTO 
When we reviewed the iPod photo 
(e:l tH:;tj Jan/05, p34), we had two 
major beefs : Its two-inch screen was too 
small for effective image viewing, and 
there was no way to download photos 
to it directly from a digital camera-you 
had to put your photos into iPhoto and 
then politely ask iTunes to convert 
them and transfer them to your 'Pod. 
Well, the kind folks at Apple have 
answered one of our complaints with a 
new iPod Camera Connector (more on 
that in a bit), but they've kept the iPod 
photo's squintalicious two-inch color 
LCD-which, it must be admitted, is a 
vast improvement over the classic 'Pod's 
monochrome display. As if by way of 
apology, Apple has lowered the price of 
the 60GB model a full 25 percent, from 
$599 to $449. We accept the apology. 

The 40GB iPod photo ($499) has been 
sent packing; its replacement is a slim 
(0.63-inch) 30GB model that comes in at 
a cool $349. The bad news? If you want 
to equip either model with a Dock, the 
iPod photo Dock Kit will cost you another 
$39. Want to connect either to a TV? 
You'll need the optional $19 iPod photo 
AV Cable. Both were included with the 
original iPod photo, making the price 
drop a bit less impressive. 

But, as we said, we're in a forgiving 
mood-and the reason is the iPod 
Camera Connector we mentioned 
before. Set to ship by the time you read 
this, the $29 Camera Connector lets you 
connect your iPod photo to your digital 
camera and download photos directly 
from your camera into your 'Pod . 
You'll then be able to view the photos 
individually or in a slide show, and 
then upload the originals into iPhoto 
when you're back at your Mac. OK, so 
the iPod photo should have had this 
capability from the beginning, and we'd 
prefer it to be built into the 'Pod and not 
a $29 option, but it's still a welcome 
addition to the flagship of Apple's more
affordable iPod line.-Rik Mys/ewski 

NEW STUFF 

~ REBEL SWELL 
Canon EOS Digital 
RebelXT 

--~1 ·· ~".· ··· :-: .... 1~ .. ·· .. ·• . / ,,,..-- },,,/ 
, ·..Ill 
~ -.. -~.) 

$999 [with lens), 
$899 [body only) 
www.canon.com 
Available: Now 

Its cause? Fast, 
fine-lookin' pies_ 

Nikon's latest digital SLR camera doesn't 
replace the EOS Digital Rebel (eeeeu 
Mar/04, p48)-it fills the quality slot 
above it. The Rebel XT is smaller, lighter, 

and faster than its predecessor, and it 
features an 8-megapixel CMOS sensor 
and Canon's speedy DIGIC II image-signal 
processor. Oakland Raiders fans rejoice: 
You can choose between either a si lver or 
black body. 

~ SMART STORACiE 
CONTROL 
ProSoft Drive Genius 
$99 
www.prosofteng.com 
Available: Now 
Your hard drive needs 
some tender lovin' 

r .!.~~ : !P_ .Q ~ 

An organized utility for 
your disk in disarray. 

care, and Drive Genius just might be the 
proper caretaker. This set of hard drive 
utilities includes an optimizer, a disk 
tester and analyzer, a volume rebuilder, 
benchmark tools, and more-and they're 
all accessible through a friendly interface. 
Drive Genius can also securely wipe 
out data using standards set by the 
Department of Defense. 

~ WATCH OUT, WACOM 
Adesso CyberTablet 
12000 
$169 
www.adesso.com 
Available: Now 
This 12-by-9-inch 
tablet comes with a 

We haven't seen 
the previous 11,999 

mouse and pressure- versions. 
sensitive pen-both ~ 

wireless-for use with image editing and ~ 

illustration apps. The pen has two buttons a 

and 512 gradations of pressure sensitivity, ~ 
and the two-button mouse can be used by 8 
lefties or righties . 
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12 /1 GET INFO 
tr the news of the month in bite-size chunks 

DROOLWORTHY 
Sexy, Stuff We Can 't Wait to Get Our Mitts On 

I 

Ball and 
Refrain -+ 
Blue Microphones' Snowball 
($139, www.bluemic.com) is a USB 
microphone designed for professional 
recording. It has three recording capsules : 
one for vocals, one for instruments, and a 
third for combined vocal and instrument 
recordings. Snowball can be used with any 
recording app, including GarageBand.and 
Logic Pro. 
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HALO IN UT2004? SIGN US UP! 
~ Have Unreal Tournament 2004 and can't get enough Halo? 
Project Torland has released a full-scale total-conversion mod 
aimed at cramming as much content from the original Halo 
as possible into the UT2004 engine. Play as the Covenant or 
the Flood while driving Warthogs and Ghosts, each with new 
configurations.-MO 

MEN OF VALOR DOA 
~ Aspyr Media announced that they 
have cancelled the Vietnam-era 
first-person shooter, Men of Valor. 
According to a company statement, 
"The decision to remove the title 
from Aspyr's calendar was a result 
of several different factors and much 
deliberation." One of the factors may 
have been the increase in cost for the 
online-multiplayer management system 
hosted by GameSpy, reported here in 
Game News (Mar/OS, p13).-MO 

Aspyr Media 
www.aspyr.com 

FREE FRAGGIN' IS GOOD FRAGGIN' 
~ Nexuiz is a free 3D death match game 
based on Darkplaces, an 
advanced Quake 1 engine. 
The game features curved 
surfaces, bump mapping, 
real-time shadows, 
and 64-player support 
with over 30 characters 
to choose from. The 
development team's goal is 
to bring death match back 
to the basics, which 
they see as well
balanced weapons 
and fast-paced 
action .-MO 

TIPS & TRICKS: COMMAND & CONQUER: GENERALS ZERO HOUR 

The Command & Conquer: Generals ( t; -.i Jul/04, p58) expansion pack, Zero Hour, has you fighting the world's most elite 
commanders for battlefield domination . Here are a couple of tips to keep you from getting owned.-MO 

BEWARE THE TUNNEL RUSH A Tunnel Rush is when a player 
builds tunnels right away for an early sneak attack. You won't 
be able to see an enemy's tunnel until they are coming out of 
your floorboards. Be especially careful when playing against 
Prince Kassad-he has this ability instantly. Dragon Tanks and 
Scout Drones are effective counters, but building your own 
tunnels works, too. 

PICK A POTENT GENERAL Team up with Tsing Shi Tao, The 
China Nuke General, and Anvil Fai, The China Infantry General
they make highly effective use of the resources available to 
them. Alexis Alexandra, The USA Super Weapon General, and 
Dr. Thrax, The GLA Toxin General, have weak defenses and the 
worst offenses. 

May 2005 MacAddlct 13 



' l I ~ i1 "i (I I { : ' I ' l 

the news of the month in bite-size chunks 

NAPSTER TAKIES 
ON iTUNES 
N apster (www.napster.com) is taking on Apple's iTunes 

Music Store and iPod by offering a $14.95 subscription
based on line music service. Napster claims it's a better 
value, which can be true-as long as you don't want to use an 
iPod or Mac and don't want to actually own anything. Here's 
the lowdown. 

iPod ignored. Before we get to Napster's pricing, know this : 

iPods make this 
kitty scowl. 

You can't use the iPod, iPod mini, or iPod shuffle with Napster. Here's something else: 
Napster isn't Mac compatible. If this instantly eliminates Napster as a choice for you, 
skip the rest of this article . Or keep reading-you might need rhetorical fodder for the 
next time you're at a gathering and some blowhole spouts off about subscription
based services versus the iTunes Music Store. 

Forever linked. Napster's subscription service lets you download an unlimited · 
number of songs, which is a good way to try an album with little consequence. But every 
month, Napster reauthorizes your music, and if you cancel your service, your music 
won't play. If you don't care about owning your music, then this might be no big whoop. 

CD conundrum. No iPod or Mac support? How about burning Napster songs to a 
CD, then importing them into iTunes on your Mac? It's possible, but you have to pay 
an extra fee on top of the $14.95 per month-the subscription service is for playing 
music on your MP3 player or PC only. The fee (which happens to be 99 cents per song, 
but discounts are available) gives you a version of the song that you can burn onto a 
CD. That's one advantage: You can try before you buy, and then buy only the songs 
you want.-Roman Loyola 

BUG OF THE MONTH 
Troubleshooting Solutions for the Macintosh 

SICKLY SOFTWARE UPDATE 

Sometimes Mac OS X's Software Update doesn't display the appropriate 
updates, or it fails to properly apply updates that have been successfully 

downloaded (in the latter scenario, you may get a permissions error referring to 
the /tmp/501/Temporaryltems/com.apple.SoftwareUpdate directory). Here are 
a few things you can try if you encounter one of these problems. 
REPAIR PERMISSIONS Try using .Apple's Disk Utility (located in /Applications/ 
Utilities) to repair permissions. This often works all by itself. 
DON'T MOVE APPS If you moved an Apple app from its original location inside 
the Applications folder, Software Update may not be able to locate it. Leave 
Apple-installed applications where they are originally installed. 
DELETE RECEIPTS In some cases, the issue can be resolved by deleting one 
or more files in the Library folder. Try deleting the receipts that correspond to 
the application or Mac OS X version you are attempting to update (files such as 
iPhotoUpdate403.pkg or MacOSXUpdatel0.3.8.pkg). The receipts are located 
in /Library/Receipts and appear with a .pkg extension. 
SWING THE BAT TOOL Use BatChmod (on the Disc, or download from http:// 
macchampion .com/arbysoft) to modify permissions for the /tmp/501 directory: 
0 In the Finder, press Command-F. In the first search field, type 501 (or 
whatever number is identified in the message). Press the plus sign to add a 
second search criterion , and then select Visibility in the first menu and Visible 
And Invis ible Items in the second menu. Click Search. 
6 In the Search Results window, click and drag the 501 folder 
onto the BatChmod icon. In BatChmod, select Apply Ownership 
And Privileges, and click Apply. 
TRY AGAIN Wait a few minutes. Sometimes this just works. 
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ON THE 
DISC 

BatChmod 1.34 

~ :2: Gibson unveiled 
the Gibson 

Digital Guitar (www 

~ ~ .gibsondigital.com), a 
Les Paul-style guitar v QJ that can pick up string 
motion, send it to a 

r-+- digital converter, and 

...... then transmit the 

CJ) signal from the guitar 
3: to a breakout box via c: 

Ethernet. Brian Moore (/) z () Guitars announced 
):lo the iGuitar.USB (www I"' 

z CD 
.brianmooreguitars 

(/) .com), a guitar that 
-f connects to your :II 
c: 

~ 
Mac via USB to 

3: directly interface with "' z GarageBand, Logic 
-f 
(/) Pro, or Pro Tools . 

(Could a digital 

Put your personal 
touch on your tunes
literally. 

air guitar be 
next?) Fender's G

DEC ($359.99, www.fender 
.com) is a practice amp for guitarists; 

it has a MIDI synthesizer, 17 amp types, 
29 effects, and 10 reverbs. 

Haken Audio's Continuum 
Fingerboard (pictured; $5,290 full size, 
$3,390 half size, www.hakenaudio 
.com) is a FireWire MIDI controller with 
a keyboard-like playing surface that 
allows you to use finger movements to 
dynamically control the sound. Think of 
The Musicpole (www.themusicpole 
.com) as a keyboard wrapped around 
a pole . You play this MIDI controller by 
stroking and spinning the pole in your 
hands (get your mind out of the gutter!) 
while wearing special thumb pads. 

Steinberg unveiled Virtual Bassist 
($249.99, www.steinberg.de). It has a 
collection of samples from 25 different 
music styles and features GrooveMatch, 
which syncs the bass line to an existing 
drum line. Steinberg also has Groove 
Agent 2 ($249.99), with 27 new drum 
styles and nine new drum kits. East 
West/Quantum Leap's Symphonic 
Orchestra ($995, www.soundsonline 
.com) is a 24-bit choir-sample library 
with a utility that lets you type words you 
want the choir to sing.-Miche/le Victoria 



SHAREWARE PICK OF THE MONTH 
lml!m http://inventive.us $19.95 

ON THE 
DISC 

iCllp 3.5.2 

Your Comma~d, C, a~d V keys _are probably w~rn.to the nubbins from years of copying and pasting. iClip minimizes the repetitive 
nature of this practice by letting you store clippings. It even remembers your most recent clippings.-Andrew Tokuda 

iClip j:Editl Help New Clipping Set 

Name:) MacAddiccJ 

Duplicate Current Clipping Set ... Bin coun1: 8 

Clip ~ 

~~. 
Manage Clipping Sets .. . ~ Name your Clipping Set. 

nw 
Clear All Clipping Bins 
Delete Current Clipping Set 

New Tut Clipping 

SlncerC!lyyour.s. OU 

nC 
ve1 
he 

ultirt 

Copy Tex.I from All Clipping Bins 
Paste Text to Multiple Clipping Bins 

M" 
M.lcAddict Magazine 

0 Each time you copy data, it's stored 

automatically in iClip's Clipboard 
Recorder. 

@ For more permanent storage of common 
clippings, create a new Clipping Set by 
selecting New Clipping Set from iClip's 
Edit menu. 

0 Store common text, such as 
email signatures, by clicking on 
an empty bin, then typing away. 

0 Need a faster way to 

copy and store data? 
Select your data in 
whatever application 
you're in, then click the 
copy icon (the arrow that 
points to your bin). 

iPOD CASE OF THE MONTH 

You might call it a Muppet pelt or a punk-rock Tribble (we did 
both) , but you'll certainly call HotRomz' Tactile iPod Cases 

($16.95 for iPod mini, $19.95 for iPod; www.hotromz.com) 
unique. These handmade fur-balls are colorful, fuzzy, and flashy 

cases similar to Apple's own iPod Socks. In Gilligan 's Island
speak, the Tactile iPod is Ginger, and the iPod Sock is Mary Ann. 

Pictured here is the Pink Devil, a celebratory coterie of pink 

shag and rainbow-hued fuzzy bits . Other Tactile cases include 
the Little Green Monster, a hairy 
green case; the Hedonist, made 
of blue mohair and metallic silver 

thread; and Birds of a Feather, 
graced with red, white, and pink 

faux feathers. All of the Tactile 
cases are hand washable and can 
be air dried . 

If sock-like cases aren't your 
thing, HotRomz also makes iPod 
Tattoos ($3.99) that overlay your 
iPod.-Michelle Victoria 

SUBMIT YOUR CASE Whether your iPod case is a custom-made one
off or a mass-produced product, you can submit it for Case-of-the-Month 
consideration-just send it to iPod Case of the Month, MacAddict, 150 
North Hill Dr., Ste. 40, Brisbane, CA 94005. Please note that we cannot 
return cases. 

0 To paste the 

. .. ~". f ;rfie,;Y.~~;~ . clipping data into 
an application like 
TextEdit, click on the 
paste icon (the arrow 
that points away from 
your bin). 

BookReviews 
>>>> 

\ 

APPLESCRIPT: A Comprehensive Guide to Scripting 
and Automation on Mac OS X 

APPLESCRIPT: The Missing Manual 

When it comes to AppleScript, it's helpful to have a couple 
of reference books handy. That's why we like both 

AppleScript: The Missing Manual ($24.95, www.oreilly 
.com) and AppleScript: A Comprehensive Guide to Scripting and 
Automation on Mac OS X ($59.99, www.friendsofed.com) . 

AppleScript: The Missing Manual was written by teenager 
Adam Goldstein, who also worked on Mac OS X: The Missing 
Manual and Mac OS X Power Hound. Goldstein's new book is 
a great way to introduce yourself to AppleScript, and it al~o 
serves as a good quick reference. 

But if you want to be an AppleScript power coder, you'll 
need to dive deep into the technicalities . That 's where Hanaan 
Rosenthal's Comprehensive Guide comes in. Useful to both 
beginners and experts, this 900-page paean to AppleScript 
includes tons of sample scripts.-Roman Loyola 
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iT <mer iMovie HD 
iPhotoS iDVD 5 Gara9eBand 2 

When have Mac addicts ever enjoyed such great ways to combine 

fun and practicality? From editing movies to making music without 

having to play a note, the ilife creativity suite helps you do things you 

didn't know you could-and enjoy yourself while doing them. ,-i But 

let's face it, as great as these apps are, they don't always work like they're 

supposed to. And even when they do, they can't do everything you want 

them to. Frustrating, ain't it? ,-i we've gathered a group of ilife experts to 

answer some of your most common "How can I fix ... ?" and "Why can't 

I do ... ?" questions. In addition, they share their favorite tips and tell 

you the first steps you should take to resuscitate an apparently sick 

or dying app. Read on-your ilife's about to get a lot better. 

by S.helly l3ris-bin, Brad Mis-er, AndrelN Tokvda, 
and Jo.hnatJ..ion Williams-
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© I don't have a .Mac account, but I still want to post 
my pictures onllne. Can I use any other photo-sharing 
services with iPhoto? 
0 You sure can . Several plug-ins extend iPhoto's export 
ability for exactly this purpose. Our favorite is FlickrExport (on 
the Disc, or download from www.speirs.org/flickrexport), a 
freeware utility that uploads selected photos directly to your 
Flickr account. It's compatible with both iPhoto 4 and iPhoto 5. 

Once installed, FlickrExport appears as an additional tab 
in iPhoto's Export dialog (Share> Export). You can resize, set 
titles, and assign Flickr content tags before uploading. There are 
other free plug-ins that serve the same purpose: 
• PhotoToTypePad (on the Disc, or download from www 
.daikini.com/products/photototypepad) lets you upload 
finished photo galleries to your TypePad account. 
• Photon (on the Disc, or download from www.daikini.com/ 
photon) lets you export photos directly to your Movable Type, 
Type Pad, Blojsom, or Word Press blog. 
• iPhotoToGallery (http://zwily.com/iphoto) lets you upload 
photos to any Gallery-powered photo page. 

~·' M~~eo-.-------
so.---lqMI~• 

FlickrExport is one of several iPhoto plug-ins that 

let you use photo-sharing services other than .Mac. 
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© I use the Export To HTML feature to post image 
galleries to my Web site, but its output options are 
limited. Is there a way to adjust the appearance and 
layout of photo pages short of editing the finished HTML? 
0 Another problem, another plug-in. BetterHTMLExport (on 
the Disc, or download from www.droolingcat.com/software/ 
betterhtmlexport) offers the same basic functionality as 
iPhoto's built-in Web-page export, but it throws in a truckload 
of additional controls and options. Post full-size images, fine
tune your HTML code, create and save your own custom page 
templates-the list goes on. Once installed, BetterHTMLExport 
appears as a tab labeled Better Web Page in the Export dialog. 

BetterHTMLExport is 

-f ...... "~'N'" ....... °"'"" c. .... m '"'' ~ shareware (registration 

Iii 11tle:~sion 
COiumns: 3 Rows: S I Pagt 

hckground: 6 Color [!!!) Tut Colar. ~ 

Q 1ma9e ~ 

Pa9c Extension: html 

~eTemelalt 

{ Built-In ! } ( Cet More Tempi.nu ) 

( Open Templ.ite Manager ) 

costs $20), and versions 
for both iPhoto 4 and 5 
are available. 

With BetterHTMLExport, 

you can expand iPhoto's 

Web-page-design 

options. 

© I tried to improve one of my photos but ended up 
ruining it. Is there some way I can start over? 
0 When you modify a photo, iPhoto automatically archives 
the original in a separate folder called-creatively enough
Originals. In both iPhoto 4 and 5, you can get the original back 
by highlighting the photo and choosing Photos> Revert To 
Original. 

We like the insurance, but some iPhoto users complain about 
the extra files on their hard drives. To get rid of them, use iPhoto 
Diet (on the Disc, or download from http://pages.cpsc.ucalgary 
.ca/-fuhrer/personal/freestuff/iphotodiet), which scans your 
library and deletes originals and other duplicates. 

Dieti n Options 

0 Remove All Orig inals 

Remove Selective ly 

~Redundant Duplicates 

IYf Unrotated Originals 

~ Orphans 

0 Strip Icon Thumbnails 

But be warned: Once your 
Originals are gone, they're 
gone forever-unless they're 
still in your camera or on a 
backup CD. (iPhoto 5 users 
should see "Johnathon's 
Top iPhoto Tip," p19, for 
additional information 
about RAW support.) 

iPhoto Diet removes 
( Start Diet j Auto Start duplicate images from your 

hard disk-permanently. 

© My pictures look fuzzy in !Photo, but they're nice and 
sharp in other applications such as Photoshop Elements. 
Why is this? 
0 Your pictures look slightly blurry because of the way iPhoto 
renders them. (/Applications/Preview does the same thing.) 
To see a photo in its full, sharpened glory, open it in iPhoto's 
Edit pane and click any one of the adjustment sliders. You don't 
need to move the slider-just clicking it is enough. 



© My !Photo llbrary Is bursting at the seams. Is there a 
way to move It to a different disk? 
0 The process of moving your library isn't intuitive, but it is 
easy. Quit iPhoto and drag your library folder to its new location. 
Then relaunch iPhoto; the app will ask you to either find your 
missing library or create a new one. Click Find Library, select the 
folder's new location, and you're done. 

0 I want to upgrade from !Photo 4 to 5, but I'm worried 
about the safety of my humongous photo collection. What 
should I know before I take the plunge? 
0 Any upgrade is always a risk-but things get a bit more 
worrisome when your entire precious photo collection is at 
stake. For a worry-free upgrade, first make a complete backup 
of your photo library. Then rebuild your library by holding down 
Option-Shift as iPhoto launches. 

When that's complete, install iPhoto 5, but don't launch it. 
First, run Software Update and install the iPhoto update from 
Apple. (If you don't see an update, then your ilife disc must 
have included the latest version.) When the update is installed, 
you're ready to go. 

The Photo Library needs to be upgraded 
to work with this vuslon of !Photo. 

Your Photo Library will not be rtadablc by prc-Aous It 
versions of iPhoto after the upgrade. The upgrade 
process may take nvcr.il mlnutu depending on !he 
number of photos in the library. 

There's no going 
back when you 
upgrade your 
IPhoto Library, 
so be sure to 
back it up first. 

0 My wife and I each have extensive photo collections 
on separate Macs, but now we'd like to keep all of our 
pictures on a single machine. Is there a way to easily and 
safely consolidate our collections? 
0 The fastest and most reliable way is to open iPhoto on the 
Mac you want to move your pictures from and export your entire 
library as full-size originals to an external hard drive. Then plug 
the drive into the Mac where the consolidated collection will 
live and use iPhoto to import all of the photos. You will lose 
the album and roll information, but alt of your pictures will be 
preserved. 

If you don't have an external hard drive, you can use the same 
technique to transfer photos between two FireWire-capable 
Macs. Export the first Mac's photos to a folder on its desktop, 
connect the two machines with a FireWire cable, and reboot 

0 Johnathon's 
Top iPhoto Tip 
Back up your photos. Yeah, we know, you were expecting 
something more profound, but this is the most practical advice 
we can give. Most of the time, iPhoto works so well that you 
forget how fragile your photo data is. In the meantime, your 
priceless photo collection is growing by the gigabyte. 

Backing up is always a bit of a hassle, but it 's far better than 
the alternative. Trust us, you don't want to have to explain. 
to your spouse where your kid 's baby pictures went. 

the first Mac while holding the T key-that will make it start up 
in FireWire Target Disk Mode, effectively transforming it into an 
external hard drive as far as the other Mac is concerned. 

A more time-consuming method, but one which would 
preserve your album and roll info, is to burn all of the first Mac's 
albums onto a CD-R/W or DVD-R from within iPhoto. Then, insert 
the disc into your target Mac, go to iPhoto, and drag each album 
from the CD to your library. If you use this method, be sure both 
Macs are running the same version of iPhoto. 

0 Apple's making a big deal about !Photo's new RAW 
support. What's It good for? 
0 iPhoto S's RAW support is nice for storing, organizing, and 
previewing RAW images, but it's pretty useless for editing them. 
The problem is that when you add a RAW image to your library, 
iPhoto immediately generates a JPEG for you to work with and 
places the RAW image in the Originals folder. This keeps iPhoto 
nice and snappy (RAW images are processor hogs), and it makes 
these images available in a format that's easy to share, but it 
defeats the entire purpose of RAW, which is to preserve alt of the 
image data recorded by your camera. 

To edit a RAW image in its native format, export it to your 
hard drive using the Original setting. (Opening a RAW image in 
an external editor from within iPhoto will only open the JPEG.) 
Then you can use your favorite RAW-ready editor (Photoshop or 
Photoshop Elements, for example) to take care of business. 

If you're planning on using iPhoto Diet to delete Originals, 
remember that this will delete all of your RAW images, leaving 
only the JPEGs that were generated on import. Be careful. 
-Johnathon Williams 

0 i PhOIO CPR iPhoto crashing on launch? Running too slow? Try these steps to get it back in the pink: 

0 RESTART YOUR MAC Sometimes this is all it takes. 

6 REBUILD YOUR LIBRARY The most common source of trouble is an error in iPhoto's data files. Hold down Option-Shift 
while launching iPhoto, click Yes when asked if you want to rebuild your library, and iPhoto will copy your data into a new 
library, removing errors in the process. Note: If you have a lot of photos, this process can take an hour or more. If iPhoto isn't 
its old reliable, snappy self when you're done, repeat the process- it may take a few passes to correct some errors. 

€> BUILD A NEW LIBRARY If the rebuild fails, then it's time to start over. First, get iPhoto Extractor (on the Disc, or download 
from http: //homepage.mac.com/butlers/iPhotoExtractor) . This neat little bit of freeware will separate your photos from the junk 
in iPhoto's library structure and put them in a Pictures folder. When Extractor is finished, move your iPhoto Library folder out of 
Pictures > iPhoto, launch iPhoto, and click Create Library to make a new, undamaged library. Finally, import the Pictures folder 
into your new library. You'll lose your album and roll information, but you'll have your photos- and a better-behaved iPhoto. 
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unes 

© I recently sold an old Mac that had one of the five 
authorizations for the songs I've bought from the iTunes 
Music Store. How do I get more authorizations for the 
new Mac I plan to buy? 
0 The only way to deauthorize a Mac you no longer own is to 
contact Apple Support, using the form at www.apple.com/ 
support/itunes/authorization.html. Apple promises you'll have 
an answer within 72 hours. 

© I've been collecting music for a while now, and I 
bought an external hard disk to hold it all. What's the 
best way to move my library? 
0 Whether you want to move your library to an external drive 
or to a new Mac, take the time to do it right. First, create a 
folder for your music at the new location. Connect the external 
hard drive (or new Mac) to your current system via FireWire, 
then go to iTunes >Preferences. ln the Advanced pane, click 
Change and locate the folder you just created. Click the Copy 
Files To iTunes Music Folder When Adding To Library check 
box, then click OK. When you close Preferences, the library 
information will update. Finally, choose Consolidate Library 
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from the Advanced menu 
to copy your music files. 

Making a new music folder 
and designating it as your 
official iTunes Music folder 
is the first step in properly 
moving your iTunes library. 

© My hard drive recently crashed and took a lot of my 
not-backed-up iTunes Music Store songs with it. Is there 
any way I can get them back without having to buy them 
all over again? 

0 iTunes CPR 
Problems you encounter when starting up iTunes usually 
have to do with library files, those all-important repositories of 
info about your music and playlists. Try these steps first: 

0 UNLOCK YOUR LIBRARY FILE One day, you may come 
face-to-face with an error message saying that your iTunes 
library is locked or that you don't have write permissions 
for the file. To fix the problem, quit iTunes and open your 
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0 Apple doesn't offer a way to retrieve purchased music-but 
you may be able to, just the same. First, be sure your hard drive 
is really and truly dead; a disk-recovery app such as Micromat's 
Tech Tool Pro 4 ($97.97, www.micromat.com), ProSoft's Data 
Rescue ($89, www.prosofteng.com), or Alsoft's DiskWarrior 
($79.95, www.alsoft.com) may resuscitate it-and all three 
together will probably cost less than your lost music. A repair 
service like DriveSavers (www.drivesavers.com) may also be 
able to recover your precious tunes. Such services are expensive, 
though-it might be cheaper to just buy the music again . 

If your lost songs are still on an iPod, download a shareware 
app such as iPod Access ($10, www.ipodaccess.com), and copy 
files from the 'Pod to your Mac. In iPod Access, search by kind 
for Protected AAC Audio Files, or just copy everything. 

0 Shelly's 
Top iTunes Tip 
To easily back up music purchased from the iTunes Music 
Store, create a smart playlist that looks for files of the 
Protected AAC Audio File kind . Burn that playlist to a data 
CD or DVD. To incrementally back up items as you add to 
the iTunes library (including purchased music), create a 
smart playlist that finds files added in the past x days. 

© I have audio books, recorded class notes, and 
podcasts in MP3 and standard AAC formats that I want 
to convert to bookmarkable AAC files so I can save my 
place. Is that possible? 
0 Sure. First, you need to convert the MP3s to standard AAC. 
Do this by opening each file in iTunes and choosing AAC from 
Import Preferences. Control-click the file you want to convert 
and choose Convert To AAC. Now you have a standard AAC file 
with the .m4a extension . To make the file bookmarkable, you 
need to change that extension to .m4b. The easiest way to do 
that is with Make Bookmarkable (on the Disc, or download from 

www.malcolmadams.com/itunes), a free AppleScript from the 
excellent Doug's AppleScripts for iTunes collection. Install the 
script as directed, then reopen iTunes and select the file you 
want to bookmark. From the new Script menu, choose Make 
Bookmarkable.-She//y Brisbin 

/Music/iTunes folder. Drag the iTunes 4 Music Library file to 
the desktop. Reopen iTunes, which will now show an empty 
library. Choose File > Import, navigate to /Music/iTunes, and 
import the iTunes Music Library.xml file. Your library-minus 
any song files iTunes couldn't match with listings- will open. 

~ AVOID FREEZES If you have a power-sucking iSight 
camera connected to your Mac, connecting or syncing an 
iPod via FireWire may freeze your Mac. To avoid the problem, 
simply disconnect the iSight before you connect your iPod. 



0 I recently shot a home movie Indoors, and some of the 
scenes are really dark. The Brightness effect In IMovle 
HD didn't help much-ls there anything else I can do In 
!Movie HD to Improve the brightness? 
Q First, be sure your monitor is calibrated correctly using 
the Calibrate command in System Preferences> Display. This 
will give you a better sense of how dark the footage really is. 
Next, try a third-party plug-in. GeeThree's Slick Transitions and 
Effects Volume 6 ($70, www.geethree.com, or check out the 
Slick Sampler on the Disc) includes a color correction effect, as 
does Jerry Lawrence's Effects Pack 1 (www.cis.rit.edu/-jerry/ 
Software/iMovie). Install these and experiment. Finally, view 
your movie on a TV monitor before finalizing your project
iMovie playback isn't always a reliable indicator of final results. 

0 I have MPEG video flles that were created on a 
Windows machine, and I can't get them to open In IMovle 
HD, even though the application supports MPEG. Is there 
a way to Import Windows video Into IMovle HD? 
6) iMovie HD can import MPEG-4 movie files, the kind that many 
still cameras create. It does not directly support other MPEG 
flavors, however, including MPEG·l, MPEG-2, or MPEG transport 
streams. You'll need to convert them with MPEG Stream clip 
(free, www.alfanet.it/squaredS/mpegstreamclip.html) and 
the QuickTime 6 MPEG·2 Playback Component (included with 
Final Cut HD and DVD Studio Pro, or $20 from Apple) in order 
to use them in iMovie. Open your file in MPEG Streamclip and 
then export it as a DV file. If the fi le is longer than 9 minutes, 

28 seconds, the movie will 
be divided into smaller files. 
When this (lengthy) process is 
complete, you can drag the DV 
files into iMovie as clips. 

Use MPEG Streamcllp to open an 
MPEG that !Movie HD can't read 
and export It as one !Movie can. 

0 I'd llke to use Magic IMovle to save some time. How do 
I get the most benefH from It? 
6) Magic iMovie automates the movie-making process by 
turning your footage into an iMovie project as you import it. 

0 Shelly's 
Top iMovie HD Tip 
Unlike previous versions, iMovie HD uses non-destructive 
editing : When you trim or split a clip, the cut footage is 
hidden but not deleted. If you copy the clip into a new 
project, all of the unwanted footage comes along with it. 

So don't use copy and paste-instead, select the 
edited clip and choose Share from the File menu. In 
the QuickTime tab, click the Share Selected Clips Only 
checkbox and choose Full Quality. Now you can save the 
clip as a file and bring it into another iMovie project, take 
it to iDVD, or archive it on tape. 

0 iMovie HD CPR 
Repairing permissions with Disk Utility (/Applications/ 
Util ities) can solve many iMovie problems. Here are 
a few iMovie-specific tweaks that can help as well : 

0 TRASH PREFERENCES Quit iMovie and delete 
iMovie preferences files from /user name/Library/ 
Preferences. If you 've used previous versions, you'll find 
files like com.apple.imovie.plist. Trash 'em and relaunch. 

~ RESOLVE CONFLICTS OS X's FileVault has been 
known to give iMovie fits. Try turning it off in the Security 
pane in System Preferences. Alternatively, you could 
store your iMovie files outside your home directory- the 
home directory is where FileVault does its thing . 

~ FIX OR REMOVE PLUG-INS Try disabling the 
third-party plug-ins stored in /user name/Library/iMovie/ 
Plug-Ins. Remove that folder and launch iMovie. If all is 
well, add your plug-ins back one at a time to isolate the 
problem. You can also disable or remove Apple plug-ins 
and iMovie support files. Select the iMovieHD application 
and press Command-I. Click the Plug-Ins disclosure 
triangle and uncheck one or more plug-ins. 

It provides a title clip, makes separate video clips and scene 
transitions, and moves clips to the timeline. You can then edit 
the results in iMovie HD, unless you choose to have your Magic 
iMovie imported straight into iDVD. In that case, there's no 
opportunity to tweak the project, making the advice that follows 
even more important. 

Because Magic iMovie imports all of your footage in the 
order it was taken, the most painless Magic iMovies are those 
without a lot of boring filler, badly shot material, or too many 
abrupt transitions. That makes Magic iMovie ideal for events 
that proceed in a set order and don't require much camera 
movement or editing, such as a school play or sporting event. 

To get the most out of Magic iMovie's automated operation, 
plan your production very carefully-putting together a shot list 
will help. You can pause the recording while nothing is going on 
to avoid extraneous footage, but be aware that Magic iMovie 
will automatically create transitions at those breaks. 
-Shelly Brisbin 



© My Mac doesn't have a SuperDrive. Can I use iDVD with 
a non-Apple DVD drive, such as an external DVD drive? 
O As of version 5, iDVD is no longer tied to the SuperDrive-

you can run the app on any Mac that meets iDVD's system 
requirements and burn DVDs using a third-party drive. You will, 

however, have to perform a custom install if you don't have a 
SuperDrive (the standard ilife installation looks for one) . When 
you launch the program, you' ll see a warning that you won't be 

able to burn a disc. Ignore the warning and create your project. 
When you're done, save it normally, and then choose File> 
Save As Disc Image. You'll get a disc image file with the .img 
extension; now you can use other applications that support 
third-party DVD burners to burn a DVD with that file. You can also 
use Mac OS X's Disk Utility to burn the disc image to DVD. 

© Apple's themes are nice enough, but I don't want my 
movies to look like everyone else's. Can I create custom 
themes and reuse them in other projects? 
0 You can create a custom theme by modifying an existing one. 
Choose Project > Show Customize Panel, and pick a theme. Go 
to the Settings pane and drag in a new background image, add 

your own music, change text properties, and so on. Click Save 

l ••. 

As Favorite, name your theme, and check 
Shared For All Users if you want everyone 
who uses your Mac to be able to use your 
theme. Uncheck Replace Existing if you 

want to keep the original theme. To use your 
new themes, open the Theme pane and 
choose Favorites from the pop-up menu. 

You can customize an existing theme and 
save it so your project will express your 
unique personality. 

© When I burn a DVD, the soundtrack becomes 
unsynced from the video. What can I do? 
0 First, make sure your video camera captures 16-bit sound; 
12-bit sound can cause the problem. Second, use Software 

Update to be sure you have the latest versions of the ilife 
applications and QuickTime. Third, make sure the hard disk 
on which the iDVD project is stored has plenty of free space 
(at least 5GB, preferably more) . Fourth, quit all applications 
except iDVD while you burn a disc (it's also a good idea to 
make sure other users are logged out) . 

If these general guidelines don't help, you'll have to change 
the project itself. If you mixed different versions of the ilife 
applications (such as iMovie 4 with iDVD 5), recreate the 
movies in iMovie HD and replace the old versions in your iDVD 
5 project. If your DVD has long movies, use iMovie HD to add 
chapter markers, or break the movies into shorter versions. 

For a really drastic solution, you can try extracting the 
movie's audio in iMovie HD. Open the Timeline, choose Edit> 
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0 Brad's 
Top iDVDTip 
You can add iPhoto, iMovie, and iTunes files to the DVD
ROM part of an iDVD project without exporting them 

from their native applications. In iDVD, choose Advanced 
> Edit DVD-ROM Contents to open the DVD Contents 

window. In the iDVD Drawer, click the Media button to 
open the Media Browser. Choose the source of your files 
(such as iPhoto), and the files will appear. Drag files from 

the iDVD Media Browser into the DVD-ROM Contents 
window to add them to the DVD-ROM part of the project. 

Select All, and then choose Advanced > Extract Audio. Place the 
extracted audio in one of the sound tracks, and then mute the 

main sound track by deselecting its check box. 

© Is there a way to delete unused iDVD 5 themes to save 
some disk space? 
O Yup. Quit iDVD. Open the Applications folder, then Control
click on the iDVD icon and select Show Package Contents. 

Open the Contents folder and then the Resources folder. View 
that folder in list view and sort by kind; all the themes will be 

grouped. Now trash the themes you don't want. (You can always 
reinstall them using the ilife '05 installer.) 

Niimi h. f<fnd -·-·- _ _, 

~ 003_Cen_Y.theme · IOVD Theme 
~ 0003_ltne_81ack.theme IDVD Theme 
~ OLWedding_Sllver_One.theme IDVO Theme 
~ 004_PlctureJn_Plcture.theme IOVO Theme 
~ 0004_Travel_Cards.theme IOVO Theme 

If you group the items in 
iDVD's Resources folder by 
kind, you can easily find the 
themes you want to delete. 

© I want to include high-quality still images and other 
DVD-ROM content on a DVD. Can I use iDVD 5 to link that 
content through a text or image link, the way commercial 
movie DVDs with DVD-ROM content do? 
0 Unfortunately, you can't link the DVD-ROM contents of an 
iDVD project directly to a menu on the disc. There are other 
ways to point viewers to your content, though . For example, 

create a short movie, image, or slideshow that directs viewers 
to the DVD-ROM content, and then place that on the viewable 
part of the disc. You could also create an image file contain ing 
instructions on how to access those files and then create a menu 

with this image as the background. Place a button leading to 
this menu on the main menu of the disc. Workarounds like these 
won't get your viewers to the files as easily as a link would, but at 
least you can let them know they're there.-Brad Miser 

0 iDVD CPR 
When iDVD's not behaving, try these: 

0 GET CURRENT Make sure you have the latest 
versions of iDVD and QuickTime installed. 

@ MAKE REPAIRS Run Disk Utility and repair all disks 
and permissions. 

€) FLY SOLO Quit all other applications and log out of 
other user accounts before launching iDVD. 

0 ADOPT AN ALIAS Create a new user account and run 
iDVD while logged in under the new account. 



0 GarageBand can record more than two tracks 
simultaneously. How can I do that with just a single Mac 
audio input? 
0 You can't-sorry! You'll have to spend some money to 
purchase a USB or FireWire audio interface. After that, 
though, it's easy. In most cases, because of Mac OS X's 
Core Audio technology, it's as simple as plugging your 
audio interface into your Mac. GarageBand will recognize 
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the interface, and 
1 you'll suddenly find a 

multichannel recording 
option in your Real 
Instrument track . 
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Add a multichannel audio 
interface, and GarageBand 
will present you with 
channel choices galore. t'l!.~""•17.t. '~I 

0 I've got a bunch of audio files I'd like to use as Apple 
Loops. How can I convert them? 
0 The easy way is to drag a file into a GarageBand project. 
Then highlight it; select Edit> Add To Loop Library; choose the 
appropriate key, genre, and descriptors; and click Create. 

You might notice that the option to classify the new Apple 
Loop as a Loop or One-Shot is grayed out. This is because an 
imported file is unalterable, meaning changing the tempo or key 
won't affect the pitch or timing of the imported audio file (unless 
you're clever; see "Andrew's Top GarageBand Tip," p24). 

0 I've got a big external hard drive I'd like to use to store 
my loops. How do I move them over? 
O You have to install GarageBand on the same drive as Mac OS 
X, but it's easy to offload your Apple Loops to an external drive 
after that. First, quit GarageBand. Go to your /Library/ Audio/ 
Apple Loops/ Apple/ Apple Loops For GarageBand folder, which 
holds a little over a gigabyte of audio files. Drag that folder to 
your external hard drive. 

Now go get the loops you created yourself-they're in your 
/user name/Library/Audio/SingleFiles folder. Copy that to your 
external drive as well. Delete the original folders. 

You'll also find a folder called Apple Loops Index in each of 
those Audio directories. Delete the contents of each. Now, when 

you launch GarageBand, you'll get a message telling you that 
no Apple Loops were found. Click OK. Click the eyeball icon, 
and a Loop Browser appears at the bottom of the GarageBand 
interface. Drag your new folders to anywhere in the Loop 
Browser. GarageBand will ask if you want to copy the loops 
to the Apple Loops folder or just use them from the current 
location. Choose Current Location, and you're ready to rock (or 
rap, or whatever). 

No Apple Loops round 
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a new one-for the 
loops you've moved to 
an external drive, for 
example. 

0 I'd like to use GarageBand 2's multitrack recording 
feature. How do I record my guitar and vocals at the 
same time? 
e There are two ways. One way uses a mixer plugged into 
your Mac's audio input, and the other employs a USB or 
FireWire audio interface. If you have a mixer, plug your guitar 
(let's assume it's electric) into channel one and plug a 
microphone (for your voice) into channel two. Pan the 

guitar hard left (turn the pan knob all the way to the ~ 
left) and pan the microphone hard right. Create 
two Real Instrument tracks, setting the first 

tracks's Input to Channel 1 (mono) and 0 
the second track's Input to Channel 2 

(mono). Make sure the Monitor is on~ 
so you can hear yourself. Turn on 
the Record Enable buttons for second. 

both tracks (when they're r You can 
on, they're red). When apply effects 
you record, the guitar ~ to either track as 
will record on the needed. For audio 
first track and A~ interfaces, the process is 
your voice ,, the same, but you don't need 
on the ~ to do any panning. The Input 

selection will vary depending on the 
interface you're using, but you simply 

~ route the guitar channel to first track and OY'"" the microphone to the second track. 

0 How do I Import MIDI? How do I export MIDI? 
e MIDI files contain musical data sans actual sounds. 

To play a MIDI file in GarageBand, drag the file into an empty 
GarageBand window-literally empty, with no tracks, Loop 
Browser, or track editor open. Just make sure the file has a 
.mid extension. If you have a complex MIDI sequence that uses 
a lot of instruments, use the Lock Tracks feature to offload 
CPU-intensive Software Instrument tracks to your hard drive 
(external, if possible). 

If you want to export MIDI from GarageBand, though, you're 
out of luck. GarageBand won't do it. 

0 I don't want to buy a MIDI keyboard, but I hate using 
that little onscreen keyboard in GarageBand 2. Is there 
a way I can use my Mac keyboard instead? 
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O Yes indeed. GarageBand has a feature called Musical Typing. 
Select Window> Musical Typing, and you'll get a window that 
maps your keyboard to a range of notes. You'll probably wind up 
hating it as much as the onscreen keyboard, but go ahead and 
try it out. 

You can use your 
regular Mac 
keyboard to play 
your Software 
Instruments-but 
after a few notes, 
you may not 
want to. 

0 Can I use VST effects or Instruments In GarageBand? 
0 VST is a popular digital-audio plug-in format-except in 
Apple's eyes, apparently. None of Apple's audio apps support 
VST, simply because the company's Audio Units architecture 
(according to Apple) is far superior and works safely with OS 
X's Core Audio. There is a possible workaround-though your 
results may vary. You can try FXpansion's VSTTo AudioUnit 
Adapter ($99, www.fxpansion.com), which makes VST plug
ins available in apps that normally support only Audio Units. 
It's handy when it works, but you'll probably want to urge VST 
developers to create Audio Units versions of their plug-ins. 

0 Can I use Soundfonts with GarageBand? 
0 Soundfonts are like GarageBand's Software Instruments, and 
they're widely available on the Internet-in fact, many of them 
are free. (Check out Kenneth Rundt's list of links at www 
.saunalahti.fi/kru99/links-to-SF-sites.htm.) When you download 
Soundfonts, they should have a .sf2 extension. Place the files 
in your /user name/Library/Audio/Sounds/Banks folder. Then, 
in Garage Band, create a new Software Instrument track. Select 
the track, click on the Track Info button (the "i" button), and 
click on the arrow to bring up the instrument details. Select 
DLSMusicDevice from the pop-up menu next to Generator. Click 
on the pencil icon to the right of that. Now find and select your 

0 GarageBand CPR 
Though GarageBand may be considered a consumer 
or hobbyist app compared to Apple heavyweights 
Logic Express and Logic Pro, it's just as taxing on your 
Mac. The three main ingredients in good GarageBand 
performance are as follows: 

0 PROCESSOR SPEED Software Instruments and 
audio effects are processor hogs. A high-speed G4 is 
good . A GS is better. A dual GS is best. 

@ RAM Install as much RAM as you can. More RAM 
means better Software Instrument performance and less 
disk reading and writing. 

€) HARD DRIVE SPEED Get a fast second hard drive 
so GarageBand can handle more audio tracks with less 
chance of error messages. It also helps Real Instrument 
performance. 
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9 Andrew's 
Top GarageBand Tip 
You can import an audio file and add it to your Loop Library, 
but you can't affect its pitch and speed-unless you fool 
GarageBand into thinking it's a recorded Real Instrument. 

First, create a new project in the key of the audio file . 
Using the peaks in the waveform, the timeline grid, and the 
metronome, adjust the project tempo to match the tempo of 
the imported file. Set the cycle region to repeat the portion 
of the audio you want to turn into a loop (a measure or two), 
and make sure it plays without any hiccups. Adjust the 
placement of the clip and the tempo until it sounds smooth. 

Crop this segment by using Edit > Split at the beginning 
and end of the cycle. Now create a Real Instrument track 
and record silence for one beat to create a purple clip. 
Here's the trick: Drag your orange clip onto the Real 
Instrument track right after the purple clip, select both 
clips, and choose Edit > Join. Click Create to make a 
single purple clip. Chop off the beat of silence at the start. 
You can now add it to your Loop Library as a loop that 
adjusts to tempo and key changes just like "normal" loops. 

Turn imported 
audio into an Apple 
Loop by modifying 
the tempo (top), 
dropping it next to 
a Real Instrument 
track (center), and 
then joining the two · 
(bottom). 

Soundfonts from the Sound Bank pop-up menu. You can then 
save them as Software Instruments for easy retrieval later. 
Compatibility can be hit-or-miss, but remember: Soundfonts are 
free.-Andrew Tokuda 
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,~How do we know our authors are ilife experts? Well, Shelly 
'!!...l Brisbin writes books like The Ma cAddict Guide to Living the ilife; 

Brad Miser wrote Mac OS X and ilife ; Andrew Tokuda makes music 
(check out www.digitaldroo.com) ; and Johnathon Williams writes 
regularly for a bunch of people (including us). They've got 60-odd years 
of Mac experience among them-but we're not letting them retire yet. 



Ed was beginning to have the sneaking 
susp1c1on that something in his morning 
routine had gone horribly awry. 
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ADESSO INTELLIMEDIA PRO 
PRICE: $59.99 

CONTACT: 800-467-1195, www.adesso.com 

The biggest problem with the lntellimedia Pro was setting it 
up. The keyboard came with a CD that installed some kind of 
controlling software-but the installer didn't say what it was or 
where it went. The Read Me file on the CD offered the helpful 
advice, "After the install complete, the user can go /Application 
folder and run the KbdPowerto do the USB keyboard key 
redefine." Doing the USB redefine sounded promising, so we 
went and found the KbdPower application, which let us assign 
the special Mail key to Microsoft Entourage (or anything we 
wanted) and the Web key to Firefox (ditto) . Unfortunately, the 
keys still didn't work. Next, we went to the Adesso product page 
to look for drivers and found one-but after downloading it, it 
turned out to be the driver for OS 9. Hello, what year is this? 

Adesso tech support kindly emailed us a link to an updated 
driver on their Web site. (Fortunately it was a direct link, 
because as of this writing, the only driver offered on the 
product page is still the OS 9 version.) Once we got that driver 
downloaded and installed, all the special keys finally worked, 
including Calculator and Sherlock2. 

As a keyboard, the lntellimedia Pro is fine. The keys are divided 
into two parts that are angled away from each other, reducing 
ulnar deviation. The sections are essentially flat, though, so it 
does nothing for pronation. The keys have a good tactile feet, 
though we prefer the firmerfeet of the less-expensive Microsoft 
Natural Elite Keyboard (p30). Given this keyboard's $59.99 price 
tag and shaky Mac support, it's hard to get enthusiastic about it. 
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DATADESK SMARTBOARD 
PRICE: $119 

CONTACT: 888-446-3222, www.datadesktech.com 

At first glance, the Smartboard looks like all the other split 
keyboards. There are two big differences, however: One, the 
keys are stacked directly above one another rather than offset 
as on a normal keyboard; two, the top keys are larger than the 
bottom ones. The idea is that those two changes make the key 
layout more closely match the way your fingers naturally fan 
out from the palm. That makes sense in theory, but in practice 
it doesn't really seem to make much difference-only months of 

use would reveal whether it's really better (and really worth the 
$119 price tag) to move your fingers straight down than slightly 
to the side. 

The other aspect of the Smartboard that sets it apart is its 
noisiness. This keyboard uses mechanical key switches like 
those in the beloved old Apple Extended Keyboard and similar 
to those used in the IBM keyboards that Apple mimicked. 
The thing is, that plastic clacking isn't a part of most people's 
computing environments anymore. The return of the clacking is 
likely to be distracting-if not to you, then to your coworkers. 

The construction also gives the Smartboard's keys more 
resistance than the others in this group and Apple's current 
standard keyboards. If you like a firm keyboard with auditory 
feedba<:k, you'll probably like the Smartboard-but be 
prepared to miss a lot of characters while you're getting 
used to it. 
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KEY OVATION GOLDTOUCH USB 
ADJUSTABLE ERGONOMIC KEYBOARD 
PRICE: $119.95 

CONTACT: 866·277·9994, www.keyovation.com 

The Goldtouch keyboard (like the Kinesis Maxim, p30) 
both splits apart to reduce ulnar deviation and raises in 
the middle, or tents, to reduce pronation. You set it up by 
releasing a locking handle, which allows the two halves 
of the keyboard to move around a ball-and-socket joint. 
You spread it apart, tilt it up, and lock it into position by 
securing the handle. The two halves of the keyboard can 
be placed at 30 degrees to the horizontal- about twice as 
steep as the Maxim can achieve, and closer to a wrist
neutra l posit ion . 

The big problem with the Goldtouch is that with the 
keyboard tented, nothing is supporting the center-it's 
like an A with no crossbar. The result is that while you're 
typing, the keyboard bounces up and down a tiny bit-not 
enough to mess up your typing, but enough to trigger a 
vague sense of alarm. Plus, since much of the keyboard is 
elevated, there's no desk beneath to rest your wrists on. 

You'd be best off investing in the optional gel-filled wrist 

KINESIS ADVANTAGE 
PRO 
PRICE: $159 

CONTACT: 800·454-6374, 

www.kinesis-ergo.com 

With its silver face and recessed 
key wells, the Advantage Pro 
looks like a prop from Star Trek
you just want to look up from it 
and intone, " Engage! "-but this 
bizarre-looking specimen just 
feels right straight out of the box. 
You're normally not supposed to 
type with the heels of your hands 
resting on the keyboard because 
it increases wrist extension, but 
with this design, your fingertips 
remain lower than your palms 
even with your hands at rest. 
(Kinesis includes thin cushions 
to stick on the keyboard to make 
using it even more comfortable.) 

That's not to say it doesn't 
take some practice to get up 
to speed. Some of the keys 
are in new places, and finger 
movements are a little different 
(shorter, which is a good thing). An independent-and small
study at Ohio State University found that it only took an hour 
for subjects to get back up to 86 percent of their normal typing 
speed on the Advantage. And some of the new key placements 
feel like real improvements-putting the Backspace key under 
the left thumb and the Return/Enter key under the right thumb 
is truly convenient; we missed that when we went back to more 
conventional keyboards. 

rests that Key Ovation sells for $14.95. 
The Goldtouch is a Windows-oriented keyboard with 

key-remapping issues, like others in this group ; in this 
case, there's a Control-Alt pair that you can turn into 
Option-Command, but there's nothing you can easily 
change into a Control key. Key Ovation says that they plan 
to produce a Mac-oriented version of the keyboard by the 

end of 2005. Wait. 

Other new key placements are more questionable, like 
putting the arrow keys on a row beneath the standard bottom 
letter row. If you use the arrow keys a lot already, you're used 
to them being separate from the letters; those who don't 
use them much have to stop and look for them anyway-why 
not just put them in the middle of the keyboard rather than 
someplace where it's easy to accidentally hit them? But all in 
all, we'd happily remap our fingers for this keyboard . 
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KINESIS MAXIM 
PRICE: $359 

CONTACT: 800-454-6374, 

www.kinesis-ergo.com 

The Maxim aggressively takes 
on every fault of the standard 
keyboard. First, it splits down the 
middle and spreads apart (locking 
into one offive positions) to reduce 
ulnar deviation. With the keyboard 
on our desk, we liked the widest 
setting; using a keyboard tray with 
our elbows rested on the arms 
of our chair, it felt better to move 
the keyboard in a stop or two. The 
Maxim also tents in the middle to 
one of three positions (including 
flat), which helps reduce pro nation. 
After setting the spread and tilt 
the way you like it, you adjust the 
detachable wrist rests until the whole contraption is stable. 

This setup looks implausible, as if there's no way the 
keyboard could stand up to serious typing. But even when 
widely spread and fully tented, it feels perfectly solid, and your 
hands fall into a natural, comfortable position. 

The Maxim doesn;t have a separate numeric keypad, which 

MICROSOFT NATURAL KEYBOARD ELITE' 
PRICE: $44.95 

CONTACT: 888-218-5617, www.microsoft.com 

Every so often, the folks in Redmond get something right. This 
keyboard is one of those times. When viewed from above, the 

DO THESE KEYBOARDS REALLY WORK? 
The manufacturers of these alternative keyboards like to toss around 
expressions like "ergonomic" and "pain relief." But is there any real 
evidence that these keyboards do any good? 

As a matter of fact, there is. A 1999 study tracked 80 computer users 
with musculoskeletal disorders and compared four different keyboards
one standard and three ergonomic. After six months, the researchers 
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shortens the keyboard and moves the mouse closer to your 
right hand. Instead, several keys near the center behave like a 
numeric keypad when you press the Function key. The standard 
top-row 7, 8, and 9 keys serve as the 7, 8, and 9 of the numeric 
keypad, with the rest of the keypad numbers and operands 
arrayed around and below. 

Natural Elite is practically indistinguishable from the Adesso 
lntellimedia Pro: The keys are at almost exactly the same 
angle, and the keyboard's almost exactly the same size. 
Like the Adesso, it's separated into right and left sets of 
keys-not as widely as the Kinesis Maxim or the Key Ovation 
Goldtouch, but enough to make a comfortable difference. But 
this keyboard has something the Adesso doesn't: a slope in 
the middle that gives a moderate tenting effect-again, not as 
much as on the ones that actually come apart, but enough to 
relieve discomfort from pronation. In addition to all that, the 
keys have a nice, firm responsiveness and a modest "clack" 
that we liked . 

As you'd expect, the Natural Elite has the usual 
disadvantages of a peecee-oriented keyboard. It requires a 
PS/2-to-USB adapter-but it's included in the box, so that's 
no big deal. But it also has a PC-oriented key arrangement 
with a Control-Windows key-Alt cluster that maps to Control
Command-Option on the Mac by default. You need to either 
retrain your fingers or use a remapper to swap the Option and 
Command keys. But really, for a keyboard that we've seen for 
$39.99 at a local computer superstore, this one offers a lot of 
comfort for not much empty-wallet syndrome. 

found that while there was no provable clinical improvement, pain 
lessened and hand function increased with alternative keyboards. 

Another 1999 study measured joint movements during typical typing 
tasks. The study concluded that alternative keyboard designs could 
reduce tendon travel by as much as 11 percent. And in 2001, a different 
group of researchers published results showing that while alternative 
keyboards may not improve overall typing comfort, they probably do 
improve the comfort level of your shoulders and wrists. 



SAFE TYPE 
PRICE: $295.00 (plus $19.99 for USB adapter) 

CONTACT: 858-204-0520, www.safetype.com 

Take your keyboard, cut it in half, and stand the two halves on 
their ends, sticking up vertically. Now you've got something 
vaguely like the SafeType keyboard. The idea behind the 
Safetype is this: If you stand with your arms at your sides and 
bend your elbows to put your hands straight out in front of you, 
you'll notice that your palms are facing each other across a foot 
and a half or so of space. Wouldn't it be nice to type that way? 

It is, in a way-it's certainly easier on the wrists. But there's 
nothing to rest your hands or arms on. If the Safe Type is on a 
keyboard tray and down at the right level for your shoulders to 
relax while your forearms stick out perfectly straight, you're 
golden. Otherwise, you have to hold your arms up in the air 
while typing, which gets tiring awfully fast. 

Furthermore, our brain-finger communication didn't adapt 
to the new orientation easily. Apparently, that's not a rare 
problem: The SafeType comes with a pair of rearview mirrors 
that let you see what your fingers are doing. Wacky, but true. 

No doubt about it, the SafeType requires more of a 
commitment than any of the other keyboards. Fortunately, 
the company offers a 30-day money back guarantee on 
new keyboards and invites customers to contact them for 
suggestions in getting acclimated to the new way of typing_ 

,~Features Editor Jake Widm an's momma warned him to beware of 
"!:J ulnar deviates. She was ri ght. 

TYPEMATRIX El-REACH 
PRICE: $99.00 ($75.00 if buying 2 or more) 

CONTACT: 866-439-7322, www.typematrix.com 

The EZ-Reach is small-not much bigger than a PowerBook 
keyboard pried out of its case. It's thin , too-just over half an 
inch thick. Ergonomically speaking, the idea is that condensing 
the keys into a small area and placing some of them in more 
convenient positions (the Enter and Backspace keys run down 
the middle of the keyboard, for example) will reduce the amount 
of overall hand movement required . Once you get in the habit of 
reaching over with your index finger or thumb to hit Enter, it's a 
much smaller stretch than it is for your pinky to reach Enter on a 
regular keyboard. 

The downside is that the keys are so close together that 
it's easy to press the wrong one (the keys themselves are 
slightly smaller than a PowerBook's keys)-pressing the 
spacebar instead of N is trivial, but pressing Return instead 
of an apostrophe can get annoying. Furthermore, while the 
thinness of the keyboard helps reduce wrist extension, its 
small horizontal size means it hardly does anything for ulnar 
deviation. And while you tan use a keyboard remapper to 
change the Control and Alt keys into Option and Command, 
there's no key availal:ile to turn into the Mac's Control key. If 
you have small hands or already prefer typing on a laptop over 
typing on a regular keyboard, you might like the EZ-Reach. 
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Tanks for Your Memories 
Most digital cameras store images on slices of capacity numbers are only estimates-there are 

thumbnail- or matchbox-size circuitry called many factors that determine how many pictures will 
media cards or memory cards. When you choose a fit on a card of a given capacity. Also, the prices 
digital camera, you're also choosing the type of card listed are from Amazon.com in late February-due 
that you're going to use-most cameras support only to the volatility of memory prices, they may have 
one, or at best two, types. On these pages, you'll changed by now.) If you lust after a particular 
find life-size snapshots of the most popular formats camera, make sure it supports a card big enough to 
available today, along with info on subformats, handle all the photos you're likely to take in a day-

capacity, cost, and more. (Note that our picture and don't forget to factor in the cost of that card. 

BY FREDRIC PAUL 

SanDisk (www.sandisk.com) 

introduced CompactFlash (CF) in 
1994, and it's still the most widely 
used digicam storage format. 

Over the years, advancing technology 
has packed in impressive storage space. 

ALTERNATE FLAVAS: A wide variety of speeds is 
available-buy the fastest you can afford. 
HOLD EVERYTHING: Up to 8GB (about 5,840 3-megapixe l 

images). Cards above 2GB require cameras compatible 
with the FAT32 file system. 

SIZE MATTERS: Type I: 1.78 by 1.4 by 0.13 inches; Type II: 
1.78 by 1.4 by 0.197 inches. 

WHO'S ON BOARD: Agfa, Aiptek, Argus, Canon, Concord, 
Epson, Fujifilm, HP, Kodak, Konica, Kyocera, Matsushita, 
Minolta, Minox, Nikon, Olympus, Panasonic, Pentax, 
Polaroid, Ricoh, Samsung, Sanyo, Sigma, Sony, UMAX, 
Vivitar, Yashica. 

PRICE TAG: From $40 for a 512MB CF II card to $1,400 for 
an 8GB CF Pro card. 

COOLNESS FACTOR: My card is bigger than yours. 

BOTTOM LINE: Still your best choice unless you need a 
small point-and-shoot camera. 

MicroDrives pack a tiny hard 
drive into a package compatible 

with CompactFlash Type II devices. 
Developed by IBM in 1998, MicroDrives 

are now built by Hitachi, Sony, and 
Seagate. 

Introduced by Sony in 1998, Memory 
Sticks are used in all kinds of Sony 

devices, from cameras to digital music 

players to TV sets. A few other companies make 
memory sticks, but only one-Konica-uses them in 

its cameras. 

ALTERNATE FLAVAS: Memory Stick Pro has more storage 
space and faster read/write speeds. Memory Stick Duo is a 
miniature version for cell phones and other small devices. 
Adapters let you use the Duo in a standard Memory Stick slot. 

HOLD EVERYTHING: Up to 2GB for Memory Stick Pro (about 
1,450 3-megapixel pictures). 

SIZE MATTERS: Memory Stick and Memory Stick Pro: 0.82 by 
1.95 by 0.0975 inches; Memory Stick Duo: 0.78 by 1.22 by 
0.06 inches. 

WHO'S ON BOARD: Sony, Konica. 
PRICE TAG: From $47 for a 256MB Memory Stick to $700 for 
Sony's 2GB Memory Stick Pro. 

COOLNESS FACTOR: Lexar makes a version that lights up 
when it's in use. 

BOTTOM LINE: Great choice if you're an all-Sony household. 

Otherwise, you're probably better off with a more 
standard medium. 

HOLD EVERYTHING: Up to 5GB (about 3,650 3-megapixel images). 
SIZE MATTERS: 1.78 by 1.4 by 0.197 inches. 
WHO'S ON BOARD: Any camera that can accommodate a CF II 
card . 

PRICE TAG: From $130 for a 2GB MicroDrive to $165 for a 4GB 
MicroDrive. 
COOLNESS FACTOR: It's an actual hard drive, dude! 
BOTTOM LINE: Now that CompactFlash cards can hold up to 8GB, 
the value of a MicroDrive is harder to fathom. 



xD-Picture Cards 
Developed by Fuji and Olympus in 2002, the 

small size of extreme Digital (xD) Picture Cards has 

quickly made them popular in digital cameras as well as other 

devices. Adapters let you use xD-Picture Cards in CompactFlash 

readers and (so their vendors claim) cameras, but xD cards can't 

match the capacity of their larger competitors. 
ALTERNATE FLAVAS: None. 

HOLD EVERYTHING: Up to lGB (about 730 3-megapixe l pictures). 

SD and MMC Cards 
Developed in 1997 by SanDisk and Siemens 

from the older Multi Media Card (MMC) 

standard, the Secure Digital (SD) card 

has emerged as the primary mainstream 

challenger to CompactFlash. SD cards 

include an erasure-prevention switch to 

help prevent accidental data loss. 

ALTERNATE FLAVAS: SD adds security for 

copyrighted data and transfers data four times 
faster than MMC. Most SD devices also accepts MMC 

cards, but MMC devices may not support SD cards. 

miniSD cards are even smaller and often come with 

Old Busted Joints 
If you like to search the bargain bins, you may still find digital 

cameras that use these storage methods. No matter how cheap they 

are, don't buy them-you'll regret it later when you want more speed 

or storage space. 

PC CARDS The same kind that slide into in your PowerBook, these 

cards can hold many gigabytes, but they're so big that they're used 

mainly in professional studio cameras. 

3-INCH co Some Sony cameras burn mini CD-Rs to store pictures. The 

CDs make it easy to transfer images to your Mac (unless you have a 

slot-loading drive, in which case don't even try), but they're relatively 

slow-and unless you use CD-RW media, you'll run through a lot of discs. 

SMARTMEDIA Thin and fragile, Toshiba's SmartMedia cards hold only up 

to 128MB. That capacity hasn't increased since the year 2000, and fewer 
and fewer cameras support the format. 

SIZE MATTERS: 0.78 by 0.975 by 0.066 inches. 

WHO'S ON BOARD: Canon, Fujifilm, Olympus. 

PRICE TAG: From $27.45 for a 128MB xD card to $64 for a 512MB 
xD card. 

COOLNESS FACTOR: Small is beautiful. 

BOTTOM LINE: xD-Picture Cards are typically a bit more 

expensive and have a much smaller capacity than other 

digital camera storage options, but they're a great choice 

when small size is the most important factor-think cell

phone cameras. 

adapters for use in SD devices. 

HOLD EVERYTHING: SD cards hold up to lGB (about 730 3-

megapixel images); SanDisk will release a lGB miniSD card 

later this year. 

SIZE MATTERS: SD: 1.26 by 0.94 by 0.083 inches; miniSD: 0.846 

by 0.787 by 0.084 inches; MMC: 0.94 by 1.2 by 0.046 inches. 

WHO'S ON BOARD: Casio, Kodak, Konica, Kyocera, Minolta, 

Panasonic, Sharp, Toshiba. 
PRICETAG : $37 for a 512MB SD card; $66 for a 512MB miniSD 

card with adapter; $51 for a 512MB MMC card. 

COOLNESS FACTOR: Smaller than CompactFlash, but just as dull. 

BOTTOM LINE: SD and MMC are more compact than CompactFlash, 
but they can't match the capacity of the newest CF cards. Still, 

they're the media of choice in many small consumer cameras. 

FLOPPY DISK Early cameras like 

Sony's MVC-FD200 Digital Camera 

store snaps on floppies. Puh-lease. 
INTERNAL MEMORY Many cameras 

have digital storage built in. That's 

great in a pinch -especia lly if you 
get 32MB or more-but avoid low-

Hotness NeW About half as wide 
USS fLASHCARD s an SD card, the USB 
and twice as thick a b ' \t-in USB connector 

end cameras that have only 
internal storage. 

d f tu res a ui 
Flash Car ea . d' ct\y into your Mac. 

\ug 1t ire ( 2 
so you can P f \\ Speed USB 1 
Developed by Lexar, 1u6~B 32MB, and 

Mbps) versio_n_s with d Hi-S~eed USB (480 
64MB capac1t1es an MB 256MB, 512MB, 
Mbps) in 64MB, 128 • y day now. few 
and 1GB sizes are duefanmat yet, but it 
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Let me take 
• you on a trip ... 

Quick, where do you most often listen to music? In your car, right? 

The easiest way to enjoy all of that music in your car is the Griffin 

iTrip. Snap iTrip on your iPod or iPod mini and suddenly your music 

is filling up your next road trip, daily commute or business trip - right 

through the built-in FM stereo of any car. Buy an iTrip for your iPod 

or iPod mini and your favorite song will always be on the radio. 

iTrip 
FM Transmitter for iPod 

·The only FM Transmitter designed 
exclusively for the iPod & iPod mini 

• iTrip for 4G iPods also 
available. Please visit us 
online for more information 

s3999 

~own 
·Choose any empty station from 
87.7to107.9, and change your 
iTrip stations directly from the iPod 

• Draws power from the iPod, no 
batteries ever needed-or wasted 

(actual size) 

iCurve 
s3999 

Laptop Desktop Stand 

• Raises notebook screen to eye level -
no more sore neck from looking down 

• Creates room on the desktop for your 
favorite USB keyboard and mouse -
wireless versions work great 

·Keeps your notebook running cool 
(and loud fans off} with 360° airflow 

s3999 

iMic 
USB Audio Interface 

• Record your old records and tapes to play 
in iTunes, put on your iPod, or burn to CDs 

·Connect any keyboard, guitar or 
microphone directly to GarageBand for 
high quality recording 

·Use line level output to connect your Mac 
to a stereo or external powered speakers 

11!1 

iTalk 
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Voice Recorder for iPod 

·Turn your iPod into a digital voice recorder 
with thousands of hours of recording time 

·Automatic Gain Control assures the best 
possible signal level for recordings 

• Features internal microphone and built-in 
laptop quality speaker for playback 

·Connect an external microphone or even 
headphones to the built in pass-through 
mini jack connection on top 

Another great idea from ( GRlf'f'IN) 

Buy now at www.griffintechnology.com 
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iWork '05 
PROMISING WORD PROCESSOR AND PRESENTATION APPS 

Don't let iWork's less-than-inspiring 
name deceive you, as both of the 

applications under its roof- Keynote 
2 and the all-new Pages-are at times 
brilliant conduits to creativity. Both have 

solid, well-designed tool sets and clean, 
well-organized interfaces, and both 
address compatibility issues (to varying 
degrees of success). After creating 
projects with each app, however, it 
became clear that Keynote and Pages 
are in different stages of development. 
While Keynote is now in full bloom, the 
little ingenue Pages has some growing 
up to do. 

The iWork apps do have things in 
common. Each has a handy-dandy Media 
browser, which pulls up your iTunes, 
iPhoto, and iMovie collections . From the 
Media browser, you can drag and drop 
media directly into your documents. 
Both apps also feature an Inspector 
window-an all-purpose tool shed that 
serves as the hub of formatting info. 
(Note: You can now view more than 
one Inspector window at a time.) And 
just as you can build tables and charts 
directly into these apps, so can you crop 
photos-the new masking tool lets you 
crop any photo to better fit your page 
layout. 

Unfortunately, the two apps also share 
something not so cool : a Find & Replace 

T 
lex1 

bug that puts your replacement word or 
phrase wherever your cursor is located 
before it seeks out the first instance of 
the word you're trying to find. Also, if you 
don't remember where the search began 

and continue to press the Replace and 
Find buttons, you end up inputting the 
replacement word or phrase twice twice 
(like that). So much for quality control. 
Hopefully, by the time you read this, 
Apple will have released an update that 
fixes these annoying problems. 

Keynote 2 
When Keynote debuted in 2003, 

it had beauty-now it has brains. You 
can animate individual characters, lines 
of text, or object builds with precise 
timing (down to fractions of a second) 
on individual slides. We appreciated the 
ability to preview effects before applying 
them, and we liked having the choice to 
either trigger effects automatically or by 
clicking our mouse. You can also add a 
soundtrack with the option to loop, or 
attach an audio file to a single slide. 

Version 2 also offers better text 
handling. The Text Inspector is now 
divided into two tabs : Text and Bullets 
& Numbering. You can add bullets, set 
margins around paragraphs, and change 
the spacing between characters, lines, 
and paragraphs. You can also type text 

0 

A 
lnspt.ttor Medio1. Colon Fanti 

Q l CnMlc 

D ll~l <> T c9 # m ..oil Q Q 

0 

, .... 
ll 

m 

"'' 

ChOOSf/ ... 

0 

Keynote 2 lets you place and resize 12 shapes with options for transparency, text, color, and fill. 
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directly into shapes and create free text 
boxes (sans bullets) ; a Fonts browser 
allows you to quickly access any font on 
your system. 

In addition to exporting and importing 

presentations to and from PowerPoint, 
you can import data from Excel or 
AppleWorks for use in one of eight chart 
types . The improved table tool makes 
easy work of creating headers and 
resizing rows and columns. 

Makeover. Meanwhile, Keynote 
has slapped on a little makeup. You 
now have a choice of 20 themes, most 
of which are nice in a tasteful-but
unoriginal, Pottery Barn sort of way
we're grateful that there's an option to 
design your own custom master slides 
and themes. Using new transitions 
(now five 30 and 18 20 effects in all), 
we burned, popped, and otherwise 
mutilated ours in style . 

There are now three different types of 
slideshow: normal, self-playing (great 
for kiosk demos), or hyperlinks-only 
(for interactive presentations). In the 
Hyperlink section of the Inspector, 
you can add links to the Web or email, 
or create buttons for slide navigation 
(previous/next). Plus, you can place 
a snapshot of a Web page in your 
presentation that will automatically 
update as you present (as long as you're 
connected to the Internet) . 

If you have two displays, you can now 

type notes as you create your slides; 
when it comes to presentation time, you 
can view the notes as you go without 
showing them to your audience. You can 
also keep tabs on the elapsed time or 
time remaining, and show the current 
slide, the next slide, or both . 

• ~~~c~~der text within 
each Pages template seems remarkably 
representative of Pages itself. The text 
is taken from Cicero's work De Finibus 
Bonorum et Ma/arum, which translates to 
The Extremes of Good and Evil. Likewise, 
Pages is about opposites-a sum of both 
brilliant and surprisingly lame parts. 

Let's get it out there: Pages is no 
Microsoft Word . It does, however, 
combine fundamental-even quite 
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Pages is neither a full-featured word processor nor a 
pro design application-but it works when you need 
something in between. 
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decent-word-processing tools with 
design basics to make an interesting and 
rather useful application. 

Like Keynote, you begin by choosing 
from a variety of templates, each of 
which contains several predefined 
page designs (and as in Keynote, you 
can customize galore) . Pages offers a 
total of 41 stylish templates: one blank, 
six newsletter, three journal (we loved 
these), six invitation, six stationery, 
three resume, six education (including 
lab notes, a syllabus, and a quiz form), 
and six marketing (including a menu). 

Pages offers live feedback with rulers 
and alignment guides for when you 
adjust text and objects. You can display 
ruler units as percentages and change 
ruler units of measurement if you prefer 
picas to points . And you can choose to 
view or not to view invisible characters . 
Any object (shapes, graphics, media) 
you import can either be fixed (text flows 
around it) or in line (moves with text) . 
You can also layer, resize, and move 
objects , or change object properties 
with relative freedom, although doing so 
often feels clumsy. 

footers . Essential page-setup features, 
hyphenation options, and ligature 
preferences are at the ready but at their 
most basic . 

Now for the sticky bits. Compatibility 
is a great thing-when it actually works . 
It was exciting news to hear we could 
export our Pages documents to Word, 
RTF, Plain Text, HTML, and PDF formats, 
but our spirits dampened when we 
read the disclaimer in the manual that 
elements would move or be lost in 
translation-and real disappointment 
set in when we actually tried exporting 
for ourselves. Line spacing, special 
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effects, graphics, and more translated 
inconsistently. We had luck with PDF 
files in general, and some documents 
made the transition to Word without 
much alteration, but exporting to HTML 
and RTF proved fairly useless. Also, 
don't count on successfully exporting 
movies or audio from Pages. Use 
Keynote instead. 

Disappointment gave way to 
annoyance when it came to deleting 
unwanted pages from a project. In 
Keynote, the clever outline window at 
the left of the canvas allows you to snip, 
move, and otherwise manipulate pages 
of your presentation at will. In Pages, if 
you wish to delete a page, you have to 
systematically select each object in your 
layout (making sure it's unlocked) and 
delete it. This is a hassle, especially if 
you are deleting or significantly revising 
a complex document. Until Apple comes 
out with a fi x, we'll probably go with the 
clunky "undo" system, saving versions 
as we go along. 

The bottom line. iWork may one day 
become a powerful productivity suite 
to replace AppleWorks (Apple's word 
processing, spreadsheet, database, and 
design conglomerate) and rival Microsoft 
Office-but that's a ways off. In the 
meantime, we' re pleased as punch with 
Keynote ... and looking forward to an 
update to Pages.-Jenifer Morgan 
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You can view paragraph, list, and 
character styles in the tidy Styles Drawer. 
Modifying and creatin.g new paragraph 
styles is simple via the Text Inspector. 
Other good formatting options include an 
auto-updating table of contents, footnote 
styles, and customizable headers and 

Our export from Pages to Microsoft Word (right) turned out decently, but the layout 
completely transformed when we exported it to HTML (left). 

COMPANY: Apple REQUIREMENTS: 500MHz G3 PowerPC, 
CONTACT: 800-795-1000 or G4 PowerBook, Mac OS 10.3.6 or later, 128MB 
408-996-1010, www.apple.com RAM, 8MB of video memory, 1GB disk space, 
PRICE: $79 Quick Time 6.5 or later, DVD drive 

GOOD NEWS: Innovative trans1t1ons, animations. and 
effects Clean interface. Handy tools. Inspires creat1v1ty 
BAD NEWS: Find & Replace bug. Occasionally clunky. 
Noticeable ceiling on features 
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At long last, upgrades 
to the PowerBook line. ~ 

12-lnch, 15-lnch, and 17-lnch 
PowerBook G4s 
SPEED-BUMPED, FEATURE-ENHANCED NOTEBOOKS 

It's been a while since we've seen a 
revi sion of Apple's PowerBooks, and 

we finally got a speed jump-just not 
the one we really wanted . To be fair, 
word on the street is that the GS CPU 
is tricky to keep cool in the confines 
of a notebook-give Apple credit for 
taking the time to (quietly) do it right. So 
although the new PowerBook G4s have 

reached a new speed echelon, it's a 
lower echelon than we had hoped. 

There's more new hardware inside 
the PowerBooks than just the faster G4 
processors. Apple now includes 512MB 
of RAM with the stock model of each 
PowerBook (high fives all around!) . 
The hard drives are faster-5,400-rpm 
instead of 4,200-rpm drives. And not 
only are the 8X DVD±RW SuperDrives 

speedier, but they also let you say 
buh-bye to those annoying DVD-format 
restrictions (although you can't burn 
dual-layer DVDs) . 

The PowerBooks' track pads have 
also received a speed upgrade-sorta. 
You can now scroll by placing two fingers 
on the pad and dragging them in the 

direction you want to scroll, including 
diagonally. For example, if you want to 
scroll down when reading a Web page, 
you just put two fingers on the pad 
and drag them down . It takes practice, 
especially when you want to scroll only a 
few lines, but it is a faster way to scroll. 
If you don't like the new two-finger 
scroll, you can turn it off in the Keyboard 
& Mouse System Preferences. 

The other key new feature in the 
PowerBooks is one we were afraid to 
test: Apple's Sudden Motion Sensor. 
The Sensor is designed to park the 
hard-drive heads in the event of a fall 
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or sudden movement, preventing them 
from banging against the disk platters. 

Call us wusses, but we couldn't bring 
ourselves to purposely drop a brand
new PowerBook to test this feature; we 
could do more than just damage the 
hard drive. (The truth: No MacAddict 

editor felt like having his salary docked to 
buy a replacement PowerBook.-Ed.) 

These PowerBooks still get plenty 
toasty after several minutes of use- and 
studies have shown that notebook heat 
can reduce a male's fertility. That may be 
a good or bad thing. You decide. 

Configurations. Of the five new 
PowerBook configurations, we looked at 
three: a 12-inch, a 15-inch, and a 17-inch 

PowerBook, each with a SuperDrive. The 
two we left out? The Combo Drive
equipped 12-inch and 15-inch models. 

Both of the 12-inch PowerBook 
models have a 1.SGHz PowerPC G4 
processor, 12.1-inch TFT display, 
64MB nVidia GeForce FX Go5200 video 

subsystem, Bluetooth, 10/lOOBase-T 
Ethernet, FireWire 400, V.92 modem, 

analog-audio in / out, and mini-DVI out. 
The SuperDrive model has a 80GB hard 
drive, while the Combo Drive version has 
a 60GB drive. Unfortunately, the 12-inch 
PowerBooks are the only ones in the line 
that don't have illuminated keyboards . 

The main difference between 

the SuperDrive-equipped 15-inch 
PowerBook we reviewed and the Combo 
Drive version is the processor: You get 

a 1.67GHz PowerPC G4 processor with 
the SuperDrive model and a 1.SGHz 
PowerPC G4 with the Combo Drive. 
The common specs: a 15.2- inch TFT 
widescreen display, 64MB ATI Mobility 
Radeon 9700 video subsystem, 80GB 
hard drive, Bluetooth, Gigabit Ethernet, 
FireWire 400 and 800, V.92 modem, 

analog-audio in/out, DVI and S-Video 
out, and an illuminated keyboard . 

There's only one 17-inch PowerBook; 

it has a 1.67GHz PowerPC G4, 17-inch 
widescreen TFT display, 128MB ATI 
Mobility Radeon 9700 video subsystem, 
lOOGB hard drive, and SuperDrive. 
Everything else about the 17-inch 

SUBTLE DIFFERENCES 
To gauge the performance of the PowerBooks, we ran several real-world tests-far 
too many to include here. We tested the PowerBooks with their stock SuperDrive 
configurations, which include 512\MB of RAM. We performed the timed tests with 
System Preferences> Energy Saver> Optimize Energy Settings set to Highest 
Performance and the power adapter plugged in. We performed our DVD playback 
test with battery power and the Optimize Energy Settings set to DVD Playback. 

iDVD5.0 
Create 3.3GB DVD Image 

lnDesign CS 
Export 6.9MB PDF tile 

iTunes 4.7.1 QuickTime 6.5.2 
Rip 31:47-minute audio CO Convert 2GB video to MPEG-4 

12-lnch1.5GHzG45iiJ EEJ == == 15-inch 1.676Hz 64 
17-lnch 1.&76Hz 64 

10 20 30 0 3 0 

Times are in minutes. Times are in seconds. Times are in minutes. Times are in minutes. 
Shorter bars are better. Shorter bars are better. Shorter bars are better. Shorter bars are better. 



PowerBook-connectivity, video- and 
audio-out, keyboard-is the same as the 
15-inch PowerBook. 

Interestingly, each PowerBook we 

tested contained a hard drive from 
a different manufacturer: a Hitachi 

Travelstar 5K100 in the 12-incher, 

Fujitsu MHT2080AH in the 15-incher, 

and Seagate Momentus 5400.2 in the 

17-incher. Apple, like most personal

computer manufacturers, installs a 

variety of hard drives into its products
you have little or no say over which you'll 

receive. All three drives are comparable 
performers-but if, for example, you 

fancy Hitachi, you'll need to run System 

Profiler (/Applications/Utilities) before 

buying a particular PowerBook to see 
what brand of hard drive it contains. 

Speed. The main objective of our 
testing was to uncover the speed 
differences between the 1.5GHz and 

1.67GHz G4 processors. It turns out that 
they're marginal. For example, when 
exporting a QuickTime movie in iMovie 
HD, the 1.67GHz G4 PowerBooks were 

8 percent faster than the 1.5GHz G4 
12-inch PowerBook. When saving a DVD 

image in iDVD, the 1.67GHz G4s were 6 
percent faster; and when converting a 
DV movie to MPEG-4 in QuickTime, the 
1.67GHz G4s were 5 percent faster. Our 
Unreal Tournament 2004 video tests 
yielded bigger differences-the 1.67GHz 

G4 PowerBooks were 27 percent faster 
in the flyby test and 10 percent faster in 
the botmatch test. 

In a couple of other tests, 
performance results were nearly 
identical: importing photos in iPhoto, 

ripping The Shaggs' Philosophy of the 
World CD in iTunes, and saving a 100MB 
file in Photoshop. Curiously, the 12-inch 
PowerBook was consistently faster than 
the 15-inch and 17-inch PowerBooks 

when performing a Photoshop Action 
that mimics real-world graphics chores. 

We also watched a Lawrence of Arabia 
DVD to see how far into the film we could 
get on fully charged batteries . On all 
three PowerBooks, we got through about 

2 hours and 35 minutes of the 3-hour
and-48-minute movie. 

The bottom line. The new speed and 
features are enough for owners of older 
'Books to seriously consider upgrading, 
and for new buyers to plunk down 
their cash . We think they're worth the 
money.-Roman Loyola 

Apple Powerbooks 
COMPANY: Apple 
CONTACT: 800-795-1000 or 
408-996-1010, www.apple.com 
GOOD NEWS: 12-incher is ultra-portable. 15-
incher is the perfect size. 17-incher is gloriously 
huge. Stock 512MB of RAM (!).Good speed boosts. 
Backlit keyboards on 15- and 17-inchers. Nice, 
exceptionally bright displays. Hard drive motion 
sensor protects your drive from drops. New scrolling 
feature on trackpad is easy to use. 
BAD NEWS: They're not PowerBook G5s. 12-
incher may be too small for the big-pawed. 17-incher 
may be awkward to carry. No PC Card slot on 12-
incher. A bit hot for using on your lap. 

Never Lose 
Anything Again 
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Photos, e-mails, graphics, 
documents. Who knows what 

you've got hidden away? 

NoteBook takes all those snippets and 
turns them into searchable catalogs of 
information. Find anything instantly. 

Publish to the web in one step. 
NoteBook puts you in the driver's seat. 

You can take control. 
Note Book can help. 

So why not give NoteBook a try? 

Introducing 
Circus PoniesTM 

Note Book 

Powerful outlining and 
organizing for your ideas! 

Free demo at 
www.circuspon ies.com 

Macworld 
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Cl Copyright 2005 Circus Ponies Software, Inc. All 
Rights Reserved. Circus Ponies. the Circus Ponies logo, 
NoteBook, and the NoteBook logos and icons are 
trademarks of Circus Ponies Software, Inc. 
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Complex character animations in Carrara 4 are 
easier due to an underlying virtual skeleton 
that links together body parts. 

between a flat animation and one that 
conveys realism. Turning on these 
options increases overall rendering time, 
but-thankfully-the rendering engine 
in Carrara 4 feels snappier than the one 
in the previous version (there's no such 
thing as a renderer that's fast enough). 

A new network-rendering feature 
limits you to five computers (Macs 

Carrara 4 Pro 

or PCs; both Mac OS X and Windows 
versions of the software are included), 
all of which must be present under the 
same IP subnet mask-so forget about 
true network rendering using remote 
machines. Network rendering is also 
avai lable as a $199 add-on for the 
less-capable Carrara 4 Standard ($279 
download, $299 boxed). 

Previous versions of Carrara took 
over our Mac's entire screen, and this 
continues to be an issue in Carrara 4. 
Hopefully, th is interface rudeness will 
change in the next revision . 

FRIENDLIER 30 SOFTWARE 

The latest version of Eovia's 30 -
, modeling, rendering, and animation 

application Carrara isn't radically 
different from previous versions, but the 
app does have a smattering of additions 
and tweaks that address Carrara's prior 
rendering and animation weaknesses . 

Added goodies include modeling 
tools that add a subtle but critical 
new capability : object manipulators. 
Click on any object in a scene, and 
colored selection handles for the x-, 
y-, and z-axes appear, allowing you to 
constrain and precisely control scaling, 
movement, and rotation along a specific 
axis, making it much easier to do any 
kind of 30 task. Another important 
addition is that the keyboard's arrow 
keys (when pressed along with the 
Command key) can now nudge an 
object around; holding down the Shift 
key allows you to nudge in much finer 
increments. 

Carrara 4 also adds nice changes to 
the terrain and sky generators, with 
larger image meshes supported in the 
terrain modules (up to 8,192 by 8,192 
pixels, which can yield some seriously 
big, detailed landscapes) and a slick 

multi-layered terrain -texture module 
that lets you create advanced rendered 
effects such as snow (which changes in 
density based on altitude and slope) or 
pockets of water at certain elevations. 
It's not quite as capable as Oaz's 
Bryce ($89.95, www.daz3d.com) , but 
it's still cool. The additions to the sky 
module significantly improve the look of 
rendered fog, haze, and clouds, and add 
to the realism of the atmospherics . 

Improved IK. Eovia has tweaked 
Carrara's inverse kinematics (IK) so that 
creating convincing walking creatures 
is much more straightforward. Morph 
targets make the complex work of 
animating facial expressions more 
manageable-your characters will smile 
more easily, which will make you smile. 
Eovia has also added the ability to 
import sound files and place them in the 
timeline-crucial for syncing movement 
to sound effects, a critical part of the 
animation process. 

Ultimately, rendering is the true test 
of any 30 software, and Carrara 4 has 
lovely additions, including real 30 motion 
blur and blurry reflections, two visual 
elements that often mean the difference 
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New natural-terrain options let you layer snow, 
grass, and rock together in complex ways with 
minimal effort. 

The bottom line. In the rea lm of mid
priced integrated modeling, rendering, 
and animation software, Carrara 4 Pro 
continues to offer a decently balanced 
compromise between power and 
usefulness. It appeals to designers 
looking to punch through their flat 20 
world into 30.-David Biedny 

COMPANY: Eovia 
CONTACT: 650-938-0515, 

REQUIREMENTS: 266MHz G3, Mac 
OS 10.1 or later, 128MB RAM, 300MB 

GOOD NEWS: Long-overdue obiect manipulators and 
nudge keys Improved IK and t1melme editing. 

MacAddict RATED 

0 www.eovia.com 
PRICE: $579 (download), $599 (boxed) 
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disk space BAD NEWS: Interface takes over screen Network 
rendering limited to five computers GREAT 



Evolt E-300 
INTERMEDIATE SLR CAMERA 

When does an SLR not look like an 
SLR? When it's the Olympus Evolt 

E-300, a streamlined, eight-megapixel 
digital SLR that buries the optics 
required for through-the-lens viewing 
inside the camera, thus trimming size 
and weight. The E-300 weighs just two 
pounds, and that's with its Zuiko f/3 .5-
5.6 digital 14-45mm lens (equivalent 
to 28-90mm in 35mm terms), all
aluminum body, rechargeable battery, 
and CompactFlash memory card (not 
included) . 

For an affordable SLR, the E-300 
has a good blend of simplicity and 
sophistication . Beginners can use 
basic scene settings on the mode dial
portrait, landscape, close-up, action, or 
night scene-or twirl the dial to Scene 
to bring up the full 14-scene repertoire 
on the LCD. Advanced photogs will go 
directly to aperture or shutter priority, 
program mode, or full manual mode. 

When you're shooting, the E-300's 
LCD displays information about the 

shots you're taking-you can't preview 
an image on the LCD with digital 
SLRs. Exposure values, flash status, 
resolution , ISO, white balance, shots 
remaining, and battery power are 
displayed in big, bright letters, numbers, 
and icons-an improvement over the 
minuscule, hard-to-read LCD info 
displayed by other cameras . 

Is it on? The E-300's buttons and 
dials are positioned for easy access. The 
review button is especially convenient, 
located just to the left of your right 
thumb. Not so intuitive is the on-off 
switch lever, which seems to be oriented 
the wrong way-it's under the mode 
dial , and instead of pulling it toward 
you to turn on the camera, you have to 
fumble past the camera strap to push it 
away. Another qualm : When framing a 
shot through the viewfinder, we found it 
awkward to shift our eyes to the lighted 
status display that runs down the 
right side of the viewfinder. We prefer 
the under-the-image status-display 

Despite its lack of a 
hump, this is an SLR 
camera. Really. 
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placement found in 
other SLR cameras . 

The camera 
performed smooth ly 

and produced images with good 
dynamic range, detail in both shadows 
and highlights, and accurate color
though we've seen sharper images in 

higher-end SLRs. Shot-to-shot time 
was as fast as we could press 

the shutter release, and 
focusing was quick and 

accurate even under 
low-light conditions. 
Each time the 
E-300 is switched 
on, it's ready to 
shoot in about two 
seconds-not as 
fast as the Nikon 

070 ( ~ 

Jul/04, p50), but 
acceptably perky-even 

though the camera first 
cleans dust particles off the 

sensor (Olympus says that the 
dust collects in a special repository in 

the camera, and that it could be several 
years before the repository needs to be 
emptied-if ever) . 

The camera's built-in flash does an 
excellent job on automatic and has a 
manual option that lets you adjust its 
intensity. The E-300 has an ISO range of 
100 to 1,600, though images get fairly 
noisy past 400. Other nice features 
include shutter speeds from 8 minutes 
to 1/4000 of a second; good resolution 
choices (1, 2, 5, or 8 megapixels); RAW, 
TIFF, JPEG, and RAW+ JPEG modes; noise 
reduction (for long exposures); and 
video out (NTSC and PAL). You can shoot 
sequences at 2.5 fps, but you can only 
shoot four pictures in a row-though you 
can keep shooting single frames while 
the buffer clears, after which you can 
rapid -fire another four. 

The bottom line. The E-300 isn't a pro 
SLR camera because it can't withstand 
grinding, physical punishment. But it is 
perfectly capable of giving professional
looking results at a nice price. As long as 
you treat it right, the E-300 will repay you 
in kind.-Arthur Bleich 

COMPANY: Olympus 
CONTACT: 888-553-444, 
www.olympusamerica.com 
PRICE: $999 with lens 

REQUIREMENTS: USS-equipped 
Mac, Mac OS 8.6 to 9.2or10.1 or later 

CiOOD NEWS: Light weight Top-notch images. Includes h1gh
quahty zoom lens. Long-lasting battery 

MacAddlct RATED 

0 BAD NEWS: L1m1ted sequence mode Awkward v1ew f1nder 
status display. Manual could be more detailed GREAT 

May 2005 MacAddict 41 



42 /1 REVIEWS 
fr better living through smarter shopping 

Business Inkjet 1200d 
CONVENTIONAL PRINTER 

I t seems that photo printers are all 
the rage, but there's still a place for 

business color inkjet printers such 
as HP's Business Inkjet 1200d: in an 
office, where charts, presentations, 
spreadsheets, and text take priority over 
road-trip photos (which, actually, the 
1200d handles pretty darn well , as we' ll 
discuss in a minute) . 

We looked at the $199 USB 2.0-
equipped 1200d, which holds 150 
pages and is suitable for a small office. 
HP offers four different models of the 
1200, and that means delving into 
HP's nomenclature mumbo-jumbo. The 
1200dn ($249) has built-in 10/100Base
TX Fast Ethernet so you can hook it 
up to your office network. The $299 
1200dtn is a 1200dn with a second, 
250-page paper tray for a total capacity 
of 400 pages. And for $349, there's the 
1200dtwn, which is a 1200dtn with Wi
Fi (802.11b and 802.11g) . 

Setting up the 1200d took us less 
than 30 minutes-and we weren't in 
a big rush. It uses four individual ink 
cartridges: black, cyan, magenta, and 
yellow; there's no light magenta, red, 
matte black , or any of the additional inks 
you often see in inkjet photo printers. 
The print heads are separate from the 
ink cartridges, and they are installed 
in a separate carriage. The nice thing 
about having all the ink cartridges and 
print heads separate is that you can 
replace only what you need to replace . 
Replacement ink cartridges and print 
heads are $33.99 each . 

While the 1200d can print on plain 
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Find out how much ink you have left using 
the included HP Inkjet Toolkit utility. 

paper, special kinds of inkjet paper are 
available to get the best results . HP's 
Premium Inkjet Paper (200 sheets , 8.5 
by 11 inches) is $20.99; HP's glossy 
Premium Photo Paper (15 sheets, 8.5 by 
11 inches) costs $9.99; and a pack of 
HP's matte Brochure and Flyer Paper (50 
sheets, 8.5by11 inches) is $9.99. 

Speed and image quality. The 1200d 
is rated at 9 pages per minute (ppm) for 
black in normal quality mode; we got 

Remember when inkjet 

Inkjet Paper, you get crisp and clean 
lines; on plain paper, you get not-so
clean lines. The color accuracy in ou r 
PowerPoint presentation was excellent; 
we didn't see any color shifts, but 
we did notice minor banding in color 

gradients. 
Printing an 8-by-10 -inch photo (you 

can't do borderless prints) in Photoshop 

took about eight minutes, which is 
mighty darn slow when compared to 

printers used only four ink colors? The 1200d does. 

6.2 ppm when printing a 50-page Word 
document-our times are from click 
(when you click Print) to clunk (when the 
print is done), so they include whatever 
image processing needs to be done on 
your Mac. When printing a 15-page, 
full -color PowerPoint presentation, the 
1200d averaged 1.5 ppm, notably pokier 
than its rated 4 ppm-and that was when 
we were printing from a dual 2GHz Power 
Mac GS. A two-page Excel spreadsheet 
took 45 seconds. We were quite pleased 
with the 1200d's speed for business 
documents; no, it's not as fast as a 
monochrome or color laser, but it's also 
not nearly as expensive. 

The 1200d's image quality is good 
for an inkjet printer. On HP's Premium 

a speed-demon inkjet such as the 
Canon i9900 Photo Printer ( t} e 
Nov/04, p46) . The 1200d reproduced 
images containing metallics, dyed 
cloth, and bright colors well, but more 
natural tones, such as skin and earth 
tones, lacked consistency and warmth . 
Remember, the 1200d isn 't designed 
for photo output; if your photo -printing 
demands ever start to grow, consider 
having a dedicated photo printer sit next 
to your 1200d. 

The bottom line. If you're mostly 
printing charts, text, and slide 
presentations, and you're printing less 
than 150 pages per week, you'll be 
happy with the 1200d. It just works
and works well. - Roman Loyola 

COMPANY: Hewlett-Packard 
CONTACT: 800-752-0900, 
www.hp.com 

REQUIREMENTS: USS-equipped 
Mac, Mac OS 9.x or 10.1 or later 

GOOD NEWS: Easy to use. Fast. Built-in duplexing. 
BAD NEWS: Slow photo-printing speeds. Low paper 
capacity for an office with high pnntmg demands. 

MacAddict RATED 

00 
SOLID PRICE: $199 
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Introducing the new Bose® SoundDock™ digital music system. 

C200) Bose Corporation Patent nghts 1s,ued andlor nending ~rhe SoundDOI k 
sistem requires 1Po<i w;th dock connector 1Pod not mcluded 1Pod rs a trade1nark of 
Apple Cornpuier, Inc registered in the US and oth()r co1.ntnos All other rnair.s ar~ 
omperty of Bose Ccrporat·on. Free shipping otter not to be comb.r.00 "'"th other 
otters or applted to PrN1ous ptirchases, and suhjeCT to change wnhoui noitee R15:.. tree 
refers to 30-cav :nal only end does not include <etum sh:~ping Delivery 1s sub;ecr to 
protluc: avadal.uhty Quolti> are reprinted w~.th pern11s$1or. fh<:? G1zrno Page fron1 !he 
(OIJ(l(!f·Joum-Jf, 10/2J04, Da>id Camoy CNET, 10/ 3104 

Bose SoundDock 
digital music system 
(shown with iPod mini) 

BOSE ® 
Better sound through research@ 



Treo 650
1 

ELEGANT PHONE AND PDA 

The Palm OS-based Treo has always 
been the best PDA-and-cell-phone 

combination on the market, and the 
latest version, the Treo 650, features 
refinements that make it even better 
than the Treo 600 : a lovely 320-by-
320-pixel TFT screen and convenient 
(but slow) Bluetooth that lets you sync 
wirelessly to your Mac using iSync. 

Other improvements include a 
removable battery, the addition of call 
and end buttons (making the Treo feel 
more phone-like), and the ability to 

low-light performance and 
added video capture and 2X 
digital zoom . 

Place an IM. The 
included email client, 
VersaMail, was a breeze 
to set up-all we had to 
do was tell it we had 
a .Mac account, and 
the app took care of 
all the settings. One 
bummer is the lack of 
an instant-messaging 
client-you'll have 

Why can't all 

American Novel. 
As you'd probably 
guess, the keys are 
a bit tight, and typing 
can get tiresome
you'll quickly learn to 
live with typos. Also, 

there's only 23MB of 
user-available memory, 
which doesn't leave 
much room for videos, 
pictures, music, or 
games. There is an SD 
card slot, but is it really 
that much to ask for a few 
more built-in megs? take pictures of people and then add 

their mugs to your address book- a 
great tool to ensure you weren't just 
beer-gogglingly addled the night before. 
Although the camera is still only VGA 
quality, palmOne has improved its 

to download the $25 
VeriChat app, which 
lets you chat on every 
major IM service. 

PDA/phone combos be as The bottom line. We're 
nice as this one? 

Although the Treo 
650 includes a QWERTY keyboard, it's 
still not conducive to writing your Great 

willing to forgive the Treo 650's 
imperfections because it's still 

the most elegant fusion of cell phone 
and PDA available.-Cathy Lu 

COMPANY: palmOne 
CONTACT: 800-881-7256, 
www.palmone.com 

REQUIREMENTS: 
USS-equipped Mac, Mac 
OS 10.2 or later 

GOOD NEWS: Beautiful h1gh-resolut1on screen Bluetooth 
Feels like a phone. 

MacAddict RATED 
00 

GREAT 
BAD NEWS: Key spacing a bit tight Paltry built-In memory 

PRICE: $599 (without service activation) 

Primatte Chromakey 2.0 
TIMESAVING PHOTOSHOP PLUG-IN 

Digital Anarchy's Primatte 
Chromakey 2.0 is a clever Adobe 

Photoshop plug-in that slashes masking 
time (removing unneeded portions of 
an image). Chroma key takes any image 

shot against a solid backdrop (blue and 
green are typically used, but any solid 
color works) and replaces the backdrop 
with any digital image you choose. 

Before you use Chromakey, you must 
set up your image layers with your 
subject in the foreground and your 
new background in a layer beneath 
that. Chroma key then creates a mask 
in .your subject's image that removes 
the colored background and replaces it 
with a transparent area. You can then 
clean up the mask by holding down your 
mouse button and scrubbing the areas 
that need to be cleaned. 

Chromakey makes your green-screen images 
easier to mask. 

This is just the simplest type of mask 
Chromakey can do. The ability to pull out 
color through the transparent area of a 
photo (such as glass or lace) or clean up 
wispy hair is truly inspiring. These are 
still time-intensive tasks in Chromakey, 

but they're quicker than manual 
masking. 

Spill cleaner. When light 
bounces off the background 
onto your subject, green or blue 

tones invade your image-this is 
called bluespil/. Chromakey lets 

you see your subject against any color 
so the blue or green spill areas become 
more apparent; you can then eliminate 
those trouble areas using Chroma key's 
Spill Sponge. Pan and zoom features let 
you get in close and check selections. 

The bottom line. Chromakey may be 
expensive for serious amateurs, but it's 
money well spent for pros. We'll spend 
the time we saved using Chromakey 
watching our new DVD set of The Wire, 
trying to find out how Poot and Bubbles 
got their nicknames .-Steven Parke 

COMPANY: Digital Anarchy 
CONTACT: 415-586-8434, 
www.digitalanarchy.com 
PRICE: $299 

REQUIREMENTS: Mac OS 9.2.2 
or X or later, Adobe Photoshop 5.5 
or later, Adobe Photoshop Elements 
2.0 or later 

GOOD NEWS: A great t1mersaver. Masks are fun again' 
Easy to use 

MacAddlct RATED 

0 BAD NEWS: Pricey for non-professionals 

GREAT 
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Aspyr's Call of Duty ( '-' 
Sep/04, p52) is one of the best 

first-person shooters ever made, and 
its United Offensive expansion pack 
doesn't disappoint. Like the original 
game, United Offensive puts you in the 
boots of American, Soviet, and British 
soldiers during World War II-only this 
time, the missions feel bigger and better 
in a budget-bustin' Jerry Bruckheimer 
kind of way. 

Case in point: You start in the 
Ardennes Forest with lOlst Airborne 
Division, holding the line against a 
German counterattack. The forest seems 
to stretch for miles as tanks barrel down, 
artillery shatters trees, bombers drop 
their payloads, and dozens of soldiers 
engage in hand-to-hand combat in 
the foxholes. The Ardennes mission is 
truly epic, but United Offensive packs 
plenty more moments that generate the 
same warm, tingly sense of awe. The 
only downside is that the missions are 
heavily scripted (events always happen 
in a certain order and at certain times), 
reminding you that you're just in a game 
and not actually in the middle of life
threatening action. 

Airborne. United Offensive takes Call 
of Duty to the air for the first time by 
way of a British B-17 Flying Fortress. The 
airborne visuals are stunning, but the 

It's initially awe-inspiring to man the 
guns of a B-17 Flying Fortress, but 
shooting down endless Nazi planes 
gets old quick. 

airborne game play is uninspired . You 
don't pilot the craft; you simply man the 
guns and pick off endless Nazi planes, 
so it gets old fast. We wanted to bomb 
targets down below. 

New weapons include a big 0.30-
caliber machine gun-set it on the 
ground (or window ledge or car hood), 
and then spray a frightful torrent of lead. 
Flamethrowers give you yet another 
way to dispense Allied justice. As for 
graphics, there are plenty of small 
upgrades to boost the game's cinematic 
feel-new fire and smoke effects add to 
the intensity, small sparks now erupt as 
bullets hit metal surfaces, and you can 
even shoot away picket fences . Cool. 

The bottom line. As much as we like 
United Offensive, our one complaint 
is that it doesn't break much new 
ground . We again wonder why there 
are no civilian noncombatants on the 
battlefield. Also, we're ready to play 
a role other than a rifleman-maybe a 
medic, an artillery spotter, or a stealthy 
French resistance fighter. There's still 
plenty of material to be mined, but it 
looks like we'll just have to wait for Call 
of Duty 2.-Helmut Kobler 

COMPANY: Aspyr 
CONTACT: 888-212-7797, www.aspyr.com 
PRICE: $29.99 

REQUIREMENTS: 867MHz G4, Mac OS 10.2.8 or later, 256MB 
RAM, 32MB ATI Radeon 7500 or nVidia GeForce 2 graphics card, 
1.4GB disk space, original Call of Duty game 

GOOO NEWS: Amazing action Lots of m1ss10ns Runs well on mid-level 
Macs and 'Books. 
BAD NEWS: Disappointing airborne m1ss10n No new game innovations. 

MacAddict RATED 

0 
GREAT 

• Over 4,000 Apple Loops 
• HipHop, House, Rock, Metal, 

Reggae, Jazz, Latin, Funk, Soul, ... 
• 222 Software Instruments with a 

Customized User Interface 
• Keyboards, Guitars, Bass, Brass, 

Drums, Percussion, ... 

$99 
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Callisto mk II 
BRAWNY YET PRECISE SPEAKERS 

Serious audiophiles gripe that mass· 
produced computer speakers suck, 

compromising sound quality in favor 
of cabinet designs that conserve desk 
space and match your computer. The 
folks at Jupiter Audio, on the other hand , 
care deeply about sound quality. With 
their Callisto mk II speakers, superior 
sound comes first-desk space be 
damned. 

The big, boxy mk II speakers certainly 
draw attention away from whatever 
you have on your Mac screen. Each mk 
II cabinet is made of medium-density 
fiberboard with an oak or black-oak 
finish and measures 11.63 inches tall, 
6.25 inches wide, and 8.75 inches deep. 
The Aurasound 3·inch woofer and Seas 
shielded dome tweeter are exposed on 
the face of each speaker, calling even 
more attention to the mk lls . 

Master and slave. With the 
mk II system, one speaker 
acts as a master unit that 
connects to your Mac or iPod 
using a mini plug-to-stereo 
RCA cable. The other speaker 
acts as a slave and connects 
to the master via a standard They don't match your Mac, 
speaker cable, like those used but damn, they sound good. 
in home stereo and theater 
setups. (There is no subwoofer.) 

Once we set up the speakers and 
heard the Mac startup sound confirm 
that they were working, we launched 
iTunes and played a variety of songs. 
From rock to rap to rondos, the mk II 
produced a warm, full-bodied sound that 
made us feel good about our eclectic 
tastes in music. We bet that you won't 
miss the subwoofer-the mk lls have a 
range wide enough to handle songs that 

CiOOD NEWS: Awesome. full·bodred sound 

call for thumping bass. The tweeters 
can produce sweet clarity, so you don 't 
miss anything in the high end, either. We 
didn't hear any sound difference when 
we used an iPod with the mk II. 

The bottom line. With a hefty $799 
price, the mk II set may be too expensive 
for casual users. But if you take your 
sound seriously, you'll love 'em-even if 
they don't look particularly high-tech . 
-Roman Loyola 

MacAddict RATED COMPANY: Jupiter Audio 
CONTACT: 630-649-4329. 
www.jupiter-audio.com 
PRICE: $799 

REQUIREMENTS: Mac with 
audio-out port. Y-adapter cable. 
speaker cable 

BAD NEWS: Wood cabinets may not appeal to those who want 
to match components to their Macs Expensive 0 

DJ Console 
TOTABLE AUDIO MIXER 

Hercules' DJ Console replaces your 
turntable and mixer with a small 

USB·powered box that has a mixer and 
turntable-like wheels similar to those 
found on CD DJ decks. The Console is a 
good idea-but it has a few limitations. 

The Console has loads of inputs and 
outputs, including MIDI, 5.1 audio, and 
S/PDIF. It also has front-panel RCA line· 
in ports, plus a 0.25·inch phono·plug 
mic·in port and 0.25-inch headphone 
jack, each with individual level controls. 

The Console's controls are similar 
to those found on a CD turntable. For 
manual beat matching, the Console 
features easy-to-use Pitch Bend buttons. 
Mixing vets will love the FX buttons 
that allow the Console to emulate some 

Tough enough 
for the DJ on the go. 

sweet voltage-controlled effects, 
identical to those found on the Allen & 
Heath Xone professional-grade mixe rs 
(www.allen·heath.com). 

PowerTraktor. The Console comes with 
a custom version ofTraktor DJ Studio, the 
industry leader in DJ software-and it's 
a kick to use. Traktor finds all playable 

GREAT 

media on your Mac, loads them into its 
library, and allows you to select 

songs via the Console's 
handy joystick and song· 
select buttons. 

When it comes to 
scratching, the latency of 

the jog wheel-even when 
minimized in Preferences-is so 

far behind what is actually playing 
that it makes scratching impractical. 

Plus, the Console doesn't have a cross· 
fader that allows a hard cut from channel 
to channel, which is essential for 
scratching. We also found the buttons 
to be extra sensitive; we often triggered 
the Play/Pause button twice when we 
only pressed it once. 

The bottom line. You won't scratch up 
a DJ QBert-like storm with the Console, 
but you'll do well when you're in the 
mix.-Noah Tsutsui 

COMPANY: Hercules 
CONTACT: 514-279-9960. 
http://us.hercules.com 
PRICE: $299 

REQUIREMENTS: 1 GHz G4. Mac OS 
10.2.6 or later. 256MB RAM, 1GB disk 
space. Internet connection 

CiOOD NEWS: Small and durable. A mynad of inputs 
and outputs USB powered. Traktor software 

MacAddict RATED 
00 

SOLID 
rs awesome 
BAD NEWS: Lrmrted scratching capabrlrtres 
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VerticalMouse 2 
COMFORTABLE UPRIGHT MOUSE 

the motion seems 

foreign-it's not 

that it hurts or fee ls 

unpleasant, it's just 

that you're going 

against a learned 

behavior. It took us 

REVIEWS ~ 47 

Overdrive ($20, www 

.usboverdrive.com). 

We liked the precise 

tracking of the mouse, 

thanks to its 1,000-

dpi optical sensor. 

The scroll wheel rolls 
smoothly and is easy 

to use in a vertical 

position. If you're 

Your typical mouse is designed for 

horizontal use; the buttons and 

body are crafted based on the notion 

that you hold a mouse with your palm 

facing down. Evoluent says this is an 

unnatural, twisted, and tense position 

for your arm-sooner or later, you're 

bound to feel uncomfortable. Evoluent's 

VerticalMouse 2 puts your arm in a more 

natural position by using an unusual 

vertical design . 

a day or two to adjust, 

but once we did, the 

VerticalMouse became 

second nature. Looks odd, but feels natural. a southpaw, however, 

you ' ll have to pay a 

premium: The left-handed version of the 

VerticalMouse costs $30 extra. 

It takes some time to get used to Button bummer. The 
the look and feel of the VerticalMouse, 

especially if you've been a Mac user for 

years. You grip the mouse like you're 

giving it a handshake, which feels 

comfortable if you're simply resting your 

hand on the mouse. When you start 

VerticalMouse has five buttons: one 

for your thumb on the left side and four 

on the right side (including a clickable 

scroll wheel) . Without driver software, 

however, you can only use two buttons 

in OS X and one in OS 9. To program 

The bottom line. Thanks to the 

VerticalMouse 2, we no longer have 

to end our marathon gaming sessions 

because of tired wrists. That's a good 
thing ... we think.-Roman Loyola to move the mouse around, however, the other buttons, you need to buy USB 

COMPANY: Evoluent 
CONTACT: 516-872-1250, www.evoluent.com 
or www.team-prestige.com 
PRICE: $74.95, $104.95 (left-handed version) 

Download a FREE trial version of 
Photo to Movie today and get ready to 

be amazed. Experience Photo to Movie's 
powerful features for yourself. Visit our 

web site for details. Retail price $49.95 

Sold at these and other retailers: 
Apple Stores, Fry's Electronics, 
Amazon.com and J&R 

REQUIREMENTS: USB
equipped Mac, Mac OS 9.1.4 or 
10.1 or later 

GOOD NEWS: Comfortable-once you get used to it 
BAD NEWS: You have to pay an extra $20 for software 
to program all the buttons. Left-handed version costs 
$30 more. 

MacAddict RATED 
,Q 

GREAT 

Photo to Movie™ incorporates a powerful version of the 11 Ken Bums effect" to ,,,....,,,,,,,,,.,.,, 
bring photos alive with motion. Photo to Movie also lets you add music tracks, 
voice narration, and a variety of slide-to-slide transitions. Exported movies can 
be imported to iMovie™, burned to DVD, posted on the Web, and even emailed. 

"It's simple and does what it 
does better than any other." 

Mac360.com • "I've gotten more favorable 
comments on my project than 
anything I've done to date." 

6111gg, Phom to Movie user Phot ov1e 
www.phototomovie.com 
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iDive 
INVALUABLE VIDEO-MANAGEMENT SOFTWARE 

The trickiest part about editing video 
in Final Cut Pro or iMovie-organizing 

your taped footage for a project-just got 
a whole lot easier. iDive manages your 
footage by using frame samples and 
customizable annotations so you know 
what's in each and every shot in your 
tape collection. 

iDive works by keeping a list of the 
videos you've digitized through iDive. 
If you have a ton of tapes to index (and 
not a lot of hard drive space), you can 
perform a sampled-video capture, 
in which iDive records frames at an 
interval you set (every 1, 2, 5, 10, or 20 
seconds). You can use the catalog to find 

One major caveat: You can't import 
previously digitized videos into iDive. 
That sucks, but an Aquafadas rep says 
the company's working on an upgrade 
that will make it possible . 

Find it fast. There are two ways to 
view your video catalog in iDive. The 
icon view uses a frame from your video 
to represent your clip, while the tabular 
view lists a thumbnail and associated 
metadata, such as length, timecode, 
format, and aspect ratio . If you click on 
a video in your thumbnail list, you can 
preview the frames of your video in the 
pane below the list. 

iDive's annotation tools are great for 

~ o.. 1n ..,. .._.._ ... w..,., 

sifting through 
your videos . Each 
video has Title, 
Date, and Notes 
fields, and you 
can create lists of 
people, places, 
and events to 
associate with 
your videos 
(though we 

• --· OOGGO Q -" It 

_.,.. - ll llM •Ur ... u · ... 1 __ .... , ·-- -
- Oo<lfl- an. lll:U .,., tilt--· ···- •7.U -I ,_,_ «1•. Ol·U lj l 

.. • •••• - \.I 

encountered a 
glitch where we 
couldn't change 
the name of a 
person unless we 

______ , ___ '-=', relaunched the 

\2:".:'..=:=:'.____:·__:~:_:-_:=:::_ __ ~-::-:::-:::··"::' :=:-::"·:_" __ _:_=. ___ __d}.1 app; Aqua fad as 

Finally, software that does what Final Cut Pro and iMovie don't do: says it's aware 
manage your video clips. 

the tape with the clip you want, and then 
digitize the entire video in your editing 
application . 

Blessed with lots of storage, or only 

have a few tapes? You can digitize your 
videos at full quality and then export 
them to Final Cut Pro or iMovie by 
simply dragging the clip from iDive into 
your editing a pp-it works seamlessly. 

COMPANY: Aquafadas Software 
CONTACT: www.aquafadas.com 
PRICE: $69.95 

of the problem) . 
To find a clip, you 

just enter a keyword into the search box 
and press the Return key. iDive then lists 
the associated videos. 

The bottom line. iDive fills a gaping 
hole in video production with your Mac. 
Now that we know what our stacks 
of mysterious MiniDV tapes actually 
contain, they no longer scare us. 
-Roman Loyola 

REQUIREMENTS: Mac OS 10.3 or later, 256MB 
RAM, 5MB disk space (plus 20MB to 120MB disk space 
per hour of digital video) 

GOOD NEWS: Easy to use Drag-and-drop compatibi lity with 
Final Cut Pro and 1Mov1e. 

MacAddict RATED 
e o o 

GREAT 
BAD NEWS: Minor interface quirks. Can only log video 
d1g1t1zed through 1D1ve 

48 MacAddict May 2005 

We liked 
the wired 
version a tad better. 

The Mouse BT 
ATTRACTIVE WIRELESS 
MOUSE 

We loved MacMice's The Mouse 
( e; Mar/04, p61), and 

now there's a wireless version-The 
Mouse BT. The BT stands for Bluetooth, 
so you'll need either built-in Bluetooth 
or a Bluetooth adapter, which isn't 
included-MacMice recommends O-
lin k's DBT-120 Wireless USB Bluetooth 
Adapter ($45, www.dlink.com). You can 
use Mac OS X's drivers or MacMice's 
MouseCommand to tweak your mouse 
settings, but neither can tell you the 
status of the mouse's battery. Better 
have those spares ready. 

Some of us here at MacAddict 
enjoyed using The Mouse BT; others 
didn't like the feel-it's a lot like Apple's 
wireless mouse, only with two buttons 
instead of one. The scroll wheel is 
delightfully smooth, but if you like scroll
wheel notches, know that the BT doesn't 
have 'em. 

The bottom line. The simple fact that 
The Mouse BT has two buttons and a 

scroll wheel is reason enough to opt 
for this mouse over Apple's wireless 
Bluetooth mouse ($59, www.apple 
.com). And it looks nice, too. 
-Roman Loyola 

COMPANY: MacMice 
CONTACT: 
615-822-9270, 
www.macmice.com 

PRICE: $69.99 
REQUIREMENTS: 
Bluetooth-equipped Mac, 
Mac OS 10.2.8 or later 

X-



is super-fun 
supercross. 

MTX: Mototrax 
FUN BUT PHONY DIRT-BIKE RACING GAME 

As wannabe dirt-bike riders, we 
couldn't wait to get our hands 

on Aspyr's MTX: Mototrax. Will its 
combination oftight·aren;;i supercross 
racing, wide-open outdoor motocross 
racing, and trick riding prepare you for a 
career on the circuit? Nope. Mototrax's 
forte is providing thrills, not realism. 

MTX: Mototrax starts you off with 
a private riding lesson from pro racer 
Travis Pastrana-a good way to learn 
the game's mechanics and physics . He 
teaches you how to handle your bike, 

a turn, or pull back a· wheelie. Even when 
we assigned turning to the joystick or d
pad on various gamepads, it felt like an 
on-or-off deal with no gradation . 

Another break from reality is the 
game's marquee feature : big-air 
jumps-specifically, how you control 
them . Mototrax uses a suspension
compression system (there's an 
on-screen compression-level indicator) 
that lets you control how high and far 
you jump by properly compressing 
and releasing the springs-it actually 

requires precision, takes you on a 
practice race, and 
then sends you on 
your way. On the 
racing circuit, there 
are eight motocross 
and eight supercross 
tracks in venues 
ranging from Arizona 
to Australia, which 

JV' RIDE THE CLUTCH unlike the throttle and 
turning controls. Forget what your driver's-ed 

teacher said. For the fastest starts 
in MTX: Mototrax, hold down both 

Our 1.25GHz 
PowerBook with 
64MB ofVRAM gave 
us smooth gameplay 
once we turned 

the accelerator and clutch, and 
when the start ga te drops, pop 
the clutch. Tapping the clutch also 
helps you negotiate the corners. 

you attack in four classes (the 125cc 
qualifier, plus 250cc East, West, and 
Master classes); you have to win each 
series before getting to your ultimate 
goal: the X Games. 

Digital controls. You can control your 
bike with either a USB gamepad or your 
keyboard . We found it easier to use the 
keyboard to goose the throttle, lean into 

COMPANY: Aspyr 
CONTACT: 888-212-7797 or 512-708-8100, 
www.aspyr.com 
PRICE: $19.99 

GOOD NEWS: Loads of fun Not too tough. 
BAD NEWS: Not very realistic Gamepad support 1s weak 

off anti-aliasing 
and lowered the 

resolution to 640 by 480. Our 1.8GHz 
GS with a fat 256MB Radeon 9800 video 
card gave us perfect fluidity with all the 
eye candy enabled. 

The bottom line. If you're into 
two-wheeled motor sports, then MTX: 
Mototrax is the only game in town-and 
its low-cost / high-fun ratio helps its 
rating.-Niko Coucouvanis 

REQUIREMENTS: 1GHz G4, Mac OS 10.2.8 or 
later, 256MB RAM, 32MB All Radeon 7500 or nVidia 
GeForce2 MX video card or better, 1.4GB disk space 

MacAddlct RATED 
0 

GREAT 

TrayDock 
HANDY HARD-DRIVE 
ENCLOSURE 

•~ 
Need more storage space, but don't 

want to pay for extra enclosures, 
drive controllers, or FireWire 800 
circuitry for multiple external drives? 
Then check out WiebeTech's TrayDock, a 
sophisticated, sturdy metal case made 
to house ATA or Serial ATA hard drives on 
easy-to-install removable trays. 

It's simple to install a drive mechanism 
into a tray-just flip open a metal switch, 
slide out the tray, and attach the drive. 
When you slide the tray back in, you can 
lock it for protection against thievery. We 
loved the look of the case, but we were 
bummed to find minor scratches on its 
surface after some handling. 

The TrayDock has a USB 2.0 port and 
a pair of FireWire 800 ports, though 
you'll need to buy a FireWire 800-to
FireWire 400 cable if your Mac supports 
only FireWire 400 

Multiple slide-'em-in drives. 

(Wiebe Tech offers a three-footer for 
$19.95). After you connect the TrayDock 
to your Mac, you can hot swap drives; 
you can buy extra trays (for $49.95 
each), fit them with drives, and slide 
them in and out of the TrayDock without 
shutting down your Mac. WiebeTech 
also sells the TrayDock with drives 
installed (check out www.wiebetech 
.com I prod ucts/traydock. p hp) . 

The bottom line. The TrayDock may 
be more expensive than some external 
drives, but once you start a-slippin' and 
a-slid in' multiple trays, it's well worth the 
cash.-Roman Loyola 

COMPANY: WiebeTech 
CONTACT: 866-744-8722, www.wiebetech.com 
PRICE: $169.95 (without hard drive) 
REQUIREMENTS: Mac OS 9.1 or X or later, 32MB RAM 
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Picture Rescue 
EMERGENCY PHOTO-RECOVERY UTILITY 

Under the right conditions, Prosoft's 
Picture Rescue can help you recover 

some of your photos from your camera's 
flash memory card after they've been 
lost during a freak hardware meltdown or 
an act of sheer knuckleheaded-ness. 

Picture Rescue is darn simple to 

Results vary. 
There are, however, 
times when you can't 
recover a picture. 
For example, if you 
take twenty photos, 
erase your card, and 
then take another 
ten pies, Picture 
Rescue won't find the 
shots that have been 

eo o Image Recovery Wi ndow 

1 image selected ( 6.2MB) 

( Unselect All ) ( Select All ) ( Recover ) 

Deleted a pie you didn't mean to? Picture Rescue to the rescue! 

use. Its main window consists of three 
controls: a pull-down menu for media 
selection, an Erase button, and a Start 
button to initiate a scan. Connect your 
digital camera (or media card via card 
reader) to your Mac, and Picture Rescue 
automatically detects the cards . Next, 
choose a card and click Start. In mere 
minutes, thumbnails of your recoverable 
images appear in the Image Recovery 
Window. Select the photos you want and 
save them to your hard disk. Done. 

overwritten. If you format your cards on 
your digital camera after each session, 
Picture Rescue may not find anything 

The bottom line. Like a lot of 
emergency utilities, you'll consider 
Picture Rescue a godsend if and when 
you successfully use it. It's a bit pricey at 
$60, but if you' re able to recover at least 
a few precious photos, it'll be money 
well spent.-Gil Loyola 

X-

at all. For example, Olympus and Fuji 
cameras completely erase all data 
during a format, so there's no chance of 
recovering photos. We confirmed this on 
our trusty old Olympus C-211. 

COMPANY: Prosoft Engineering REQUIREMENTS: GOOD NEWS: Easy to use. MacAddict RATED 
CONTACT: 925-426-6100, Mac OS 10.2.3 or later BAD NEWS: May not help in some cases. Pricey. 0 www.prosofteng.com 
PRICE: $59.99 

AirPlay 
FUNCTIONAL FM TRANSMITTER 

We've found yet another FM transmitter for the iPod that 
we like: XtremeMac's AirPlay. We also liked Sonnet 

Technologies' PodFreq (eeeH:k , Aug/04, p58) and Monster 
Cable's iCarPlay ( Mar/OS, p48) . It's nice to know that 
there are real choices out there, especially since many other FM 
transmitters don't work well. 

AirPlay plugs into the earphone jack of your iPod. Find an 
empty station on your radio, set the AirPlay to the same station, 
and you're good to go. AirPlay draws its power from your 'Pod, 

AirPlay 

COMPANY: XtremeMac 
CONTACT: 954-385-9877, 
www.xtrememac.com 

GOOD NEWS: Easy to use Small 

It's small. 
which means your 
battery life shorten

It's cheap. It but not by much. 
works. 'Nuff The bottom line. 
said. AirPlay doesn't let you 

PRICE: $39.95 

save station settings. 
But hey, it's cheap and 
works just fine. 
-Roman Loyola 

REQUIREMENTS: Third- or fourth-generation 
iPod, iPod photo, or iPod mini 

MacAddict RATED 
BAD NEWS: No way to set station presets. 0 

GREAT 

50 MacAddict May 2005 

H-070 FlipUp 
INEFFECTIVE SUNSHADE 

A !though Hoodman 
makes some great 

products, the H-D70 
FlipUp-a sun visor and 
LCD protector for Nikon's 
D70 digital SLR-isn't one 
of them. Also available 
for Canon's EOS Digital 
Rebel, 20D, and 10D; Fuji's 
S2; and Nikon's D2Hx 

GREAT 

and D100; the FlipUp is Looks great. Too bad it doesn't work well. 
intended to shade the D70's 
LCD from sunlight, making it easier to read outdoors. In reality, 
the shading effect is minimal. The FlipUp protects the delicate 
LCD well, but so does the plastic shield provided by Nikon. 

The bottom line. Stick with one of Hoodman's fully enclosed 
LCD hoods and magnifiers-they work great. The FlipUp, 
unfortunately, doesn't.-Rik Myslewski 

COMPANY: Hoodman 
CONTACT: 800-818-3946 or 
310-222-8608, www.hoodmanusa.com 

GOOD NEWS: Solidly built Protects LCD 
BAD NEWS: Doesn't block much light 

PRICE: $29.95 
REQUIREMENTS: Nikon D70 

MacAddlct RATED 

0 00 
SO-SO 
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THE BEST OF THE BEST FROM RECENT REVIEWS 

~fli:!\:f M•lm;I 

Canary 0---
i es HS O 

Warcha lker extraordinai re Noah 

Tsutsui ca lls t his Wi-Fi find er "a 
great device both fo r fi ndi ng 
hotspots ... and testi ng a home or 
office connection." 

Si 
Ro man Loyo la says that thi s 
standalone device makes CD 
and DVD duplicati on 
"a lmost effortless." 

up 

$649.00 

Adobe Photoshop Elements 3.0 $89.99 

Corel Painter IX $429.00 

Macromedia Dreamweaver MX 2004 $399.00 

Nik Multimedia Color Efex Pro 2.0 

$119.99 

$199.99 

$149.00 

$199.00 

$119.00 

$699.00 

LaCie Big Disk Extreme SOOGB $429.00 

LaC ie d2 DVD±RW Double Layer $189.00 

OWC Mercury Pro DVD-/+RW $129.99 

WiebeTech GSJam 1TB $1 ,299.9S 

Feb/04, p44 Just when you thought Photoshop couldn't get better, it did. 

Mar/OS, p36 Adobe 's affordable image editor gets a significant upgrade. 

Feb/ OS, p38 This natural-media champ is now faster and more capable. 

Jan/04, p48 Our favorite Web-design tool adds improved CSS support. 

Jan/OS, p41 You'll be amazed by this plug-in's filters and darkroom effects. 

It 's as close to perfect as any digital SLR camera we've seen. 

Sep/04, p28 Ninety bucks can buy an exceptionally capable photo printer. 

Sep/04, p29 This printer's Photo Black cartridge makes color photos pop. 

Sep/04, p31 Gorgeous prints, CD printing, color-LCD editing-all good stuff. 

OcV04 , p37 This flatbed handles both reflective and film scans with ease. 

Oct/04, p39 Superior image quality earns this scanner our recommendation. 

Oct/04, p3S Killer photo-rescue software comes with th is affordable unit. 

Apr/OS, p4S Quickly duplicate CDs and DVDs without tying up your Mac. 

Aug/04, p5S Cutting-edge technology provides cutting-edge performance. 

Feb/OS, p48 Cram 8.SGB of data onto DVDs with this speedy burner. 

Aug/04, p60 This speedy drive includes everything you need to start burning. 

Aug/04, pS9 This internal 4-drive RAID makes a Power Mac GS scream. 
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HOTMAIL 
I was wondering how to use Hotmail, 
Yahoo, or both with Mail. Can you help? 

ON THE You can use Apple's 
DISC Mail application with 

these and other Web-
HTTPMail Plugin 1.42, 
Mail Forward 2.4 based email services, 

but it requires installing a plug-in called 
HTTPMail Plugin (free, www.automagic
software.com) . This plug-in lets you 
configure a new account in Mail with the 
HTTPMail protocol used by Hotmail and 
Yahoo. You can also try an application 
called Mail Forward ($15, www.sspi
software.com) that lets you forward your 
Hotmail or Yahoo mail to Apple's Mail. 

~~~~~ 
c~w..-..
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Use Mail to access your Hotmail or Yahoo 
account. 

quick 
answers 

DISOBEDIENT DESKTOP 
The icons on my desktop never stay 
organized correctly. How can I fix this? 
Sounds like your .DS_Store file, which 
maintains locations of icons in the 
Finder, might be corrupt. An app called 
Cocktail ($14.95, www.macosxcocktail 
.com) can help. Or you may simply have 
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CRAZY COLUMNS 
Why, when I open a new Finder window 
in column view, do the columns insist 
on stretching out twice as long as 
the longest title in the list? Mac OS X 
should be smarter. 
Column view is a great addition to the 
Mac OS, but those columns can be 
ornery. To reset the width to exactly 
the width of your longest item, Option
double-click on the little vertical double
line widget between columns at the 
bottom of the window. 

ii Console 
fl DigllalColor Merer 
~ Directory Access 

Disk Utility 

i!i. EPSON scan Settings 
I 1 1' • 

6 items. l.S2 GB .avail;ible 

A simple Option-double-click here can 
remedy column-view woes. 

STITCH IN NINE 
Can I digitize images for use on a 
commercial embroidery machine on 
my Mac? 
Sad to say, the Mac has pretty much 
been squeezed out of this market. 
There's one viable option, but it's a 
little dated and a bit expensive: Textile 
Technologies' PowerStitch ($350, 
www.textiletech.com). This pricey 

It's old and expensive, but PowerStitch is 
still pretty cool. 

- II!' 
M~J,W~~.i)\",\l\'~~·• rc 

74 . .1d•tJ~!~r;r:~•,otJ. .ree 

I need a 
cocktail! 

too many 
icons on your 
desktop; you 

may need to move or delete some to 
make your desktop behave itself. 

PDF SKELETON KEY 
How can I print or edit password
protected PDFs? 
That depends on what exactly the 
password is protecting. If the PDF 
is locked so tight that you need a 

app doesn't work natively in OS X, 
but it does fine in OS 9 or the Classic 
environment. And yes, it generates 
industry-standard tajima files . 

AMSCRAY! 
I downloaded a software demo that 
has since expired-now my Mac keeps 
telling me it's expired and prompts 
me to click OK. I have gotten rid of 
everything I can find, but it won't go 
away. What gives? 
To uninstall most software, simply 
trashing the app and its folder is enough. 
There are exceptions, however, including 
system-level utilities such as the items 
in System Preferences. To remove one 
of these, Control-click the item's icon 
in the System Preferences window and 
select Remove from the pop-up menu 
that appears. Some more heinous 
installations will set their applications 
or helper applications to launch 
automatically when you turn on your Mac 
or log in. To check for these weasels, go 
to System Preferences> Accounts and 
look in the Startup Items pane. Highlight 
any suspicious-looking items and click 
the minus icon at the bottom . 

r.:.:ia •• .-1 ... - - ~ L?: t ..... _ _.._.. , __ .itr __ ..,. .. -- ~ ~ .Rm-."""" """""_, 
8 1' l,,-•$1owt.>101 ~ 
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Have you checked your Startup 
Items lately? 

password to even open it, then sorry, 
no dice. If it's simply locked against 
editing or printing, you can use PDFKey 
Pro (www.pdfkey.tk) to create an 
identical, unlocked copy of your PDF. 
This utility costs only €9.99 (about $12 
at press time) . 

X-RATED APPS? 
Can I limit what applications my kids 
use on my Mac OS X computer? 
Yes, as long as each has his or her own 
individual login account. Then you just 
set privileges in the Limitations pane of 
System Preferences> Accounts. 



DIFFICULTY 
RATINGS 

~ 
EASY 

No whining
anyone S It'll take some 

effort, but you 
can do it. 

... This stuff's 
TOUGH for the pros. 
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BENCH MARKER 
Is there any software for Mac OS 

X that I can use to benchmark the 

performance of my computers? 

Are you some ki nd of geek who needs 

to find out exactly which computer is 

faster at every possible function ? Well, 

join the club! Get your geek on with 

Xben ch (http ://xbench.com), a free 

Mac OS X benchmarking utility that 

has become a de facto standard for 

testing Macs. There is even a Web site 

(http :// ladd.dyndns.org/xbench) where 

you can post your results so that you 

can compare your speed demon to other 

folks' speed demons. See if you can 

beat our three-year-old PowerBook's 

score-a whopping 42! 

EJECT! 
Is there a way to open an optical drive 

tray from the command line? 

Sure is! The secret is the drutil command. 

First, get a list of possib le drives, both 

internal and external, by typing druti I 

list. If you have only one drive, type 

dr util tray open to open its tray-oh, 

and drutil tray close to (you guessed 

it) close it again . If you have more 

than one drive, you ' ll need to add the 

ID number from the list (drutil tray 

open -lordrutil tray open -2, for 

example). 

Terminal - bash - 90X40 
Lmt log in: Tue Feb 15 20:22:25 on ttyp1 
Weleo.e to Darv in ! 
Zoller-TtBook :- zotler$ druttt lls t 

Yendor Prod.let Rev Bus ~et 

1 PlOfEfR ow..RV D'JR-1.tW KZ'rl Ftre\flre Apple Shtpptng 

Zol ler-TtBook:- zol ler$ drut t I tray open -1 
Zol ler-TtBook:- zot ler$ drutt I trQ)" close -1 
Zoller-TIBook:- zolle7$ I 

Open your CD tray from the command line. 

This user needs: 

I No Limits I Some Limits r Simple finder I 
~ Simple Andtr has a simplified Dod:: and allows tilt Ust'r 

to dlttaly use only those appfk 11tions- Jhowing in the "My 
Appllc.ulons" foldor in 1he Dock. 

Allow Appfic.alions 

9 • Applic.;uons 
C: It- Utilities 
C It- Applla tlons (Mac OS 91 
1!l • Olhers 

Set some limits for your users. 

ICON DO IT! 
I would love to customize all of my system 

icons; is there an easy way to do this? 
Try The Icon Factory's CandyBar ($12.95, 

www.iconfactory.com), wh ich lets you 

BE A BETTER BREAKER 
What are Unix line breaks in a plain text file? 

Plain text files are unformatted ASCII - There are three different 

character files. This means they are 

stripped of all font , weight, and other 

formatting. Unix uses plain text files to 

conta in configu ration info that makes 

lots of important things happen. The only 

formatting these files use or understand 

is a command to separate one line from 

another-think of it as a carriage return 

on a typewriter. Plain-text ASC II files 

use a base of 127 different characters 

to represent everything, including how 

lines should break. 

San Oodons 
Macintosh ~ 

Unt 8re.Us: •• DOS I Encodl~ Un cud 

{ Cancel 
J ' 

OK 1 

Do your text files break correctly? 

DUPLEXING 
Is there a way to organize my documents so 

they can print on both sides of the page? 

Your printer may not be able to physically 

print on both sides of the paper in one 

pass, but a simple technique can let you 

do double-sided printing with a little 

manual he lp. In the Print dialog, go to the 

Copies & Pages pop-up menu and.se lect 

Paper Handling. Then check the box next 

to Reverse Page Order and choose Even 

Numbered Pages. Go ahead and press 

Print to print these pages : After they've 

printed, take the pages out of the printer 

and put them back in the paper-input 

ON THE change any icon on 

DISC your system-even 
candyBar 2·0·1 the wily Trash icon . 

Bonus: lconfactory provides loads of 

free icons that you can download from 

its Web site . 

~{!of 
~--~'-~-"'-"""'"' *.... ._ 

.. 
CandyBar makes it simple to 
replace any icon on your Mac. 

styles for representing line 

breaks: Unix, DOS, and Mac. Unix 

uses the LF (line-feed) character, DOS 

uses the CR (carriage-return) and LF 

characters, and the Mac just uses the CR 

character. Even the most straightforward 

text editors, such as Apple's TextEdit 

(/ Applications/TextEdit) and Bare Bones 
Software's TextWrangler (free, www 

.barebones.com), can interpret any of 

these correctly, but it's important to use 

Unix line breaks in your Mac OS X and 
Unix configuration text files. To make 

sure your files use the Unix line breaks, 

use a smart text editor such 

as TextWrangler, which lets 

you specify which breaks to 

ON THE 
DISC 

USe in your file . TextWrangler 2.0 

tray, oriented so that the printer will print 
on the blank side-the correct orientation 

varies by printer. Bring up the Print dialog 

again , select Odd Numbered Pages 

(depending on how your printer spits out 

pages, you may have to uncheck Reverse 

Page Order) , and print away. 

SCROLL DIFFERENT 
Can I use two-finger scrolling on my 

PowerBook or iBook? 

The newest PowerBooks sport a 

scrolling trackpad, which allows you 

to use a two-finger drag for scrolling. 

Pretty slick, but what about those of us 

with older 'Books? Good news: Most 

aluminum PowerBooks and recent 

iBooks have similar abilities buried in 

their systems. Go to www-u sers .kawo2 

.rwth-aachen .de/- razzfazz to get the 

hack as well as a script you can run to 

determine if your ' Book is capable. 

,~Buz is a graphic designer living in 
"!!...l Florida. He has been a devoted Mac 

user for over 10 years and has worked fo r 
both Apple and Power Computing . 

S b •t technical questions u m1 or helpful tips directly 
via email (askus@macaddict.com) or c/o 
MacAddict, 150 North Hill Dr., Ste. 40, 
Brisbane, CA 94005. 
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Max Out Your Mac mini 
by Niko Coucouvanis 

WHAT YOU NEED 

Mac mini 

Nerves of steel 

S 
o you scraped up the couch coins and bought yourself 
a Mac mini. Then, wouldn't you know it, before you 
even outgrow the 40GB hard drive, dear old Auntie Em 
clocks out, leaving you a pile of cash-not enough for a 

new Power Mac GS, but enough to upgrade the bejeezus out of 
your Mac mini. You're reading the right magazine, friend-that 
is, if you're either brave or foolhardy enough to crack open your 
mini knowing full well that if you break anything, Apple's gonna 
charge you to fix it. 

If that's OK with you, follow along as we pop the hood 
and max out a min i's RAM to lGB, hop up the hard drive to a 
hon kin' lOOGB, and replace the combo drive with a full-on 

Stage 1: Just Add RAM 9 

Free your Mac mini's inner monster. 

SuperDrive-doubling the min i's price in the bargain . If you 
think the component upgrades are ridiculous , the icing on this 
bundt cake (or is it a petit four?) is pure insanity: Against our 
(lawyer's) better judgment, we show you how to eek a bit more 
speed out of the thing by poking the motherboard's backside 
with a hot stick-overclocking it! 

WHAT YOU NEED 

The mini's stock 256MB of RAM is barely enough to run Mac OS X, much less any memory Putty knife with 1.5-inch 
flexible blade ($1.98, Ace 
Hardware) 

hungry apps. We can remedy that with a lGB DIMM ($219.99, www.crucial.com). 
There's nothing to it-once we bust into the case. Don't forget to discharge 

any static first by unplugging all your peripherals from the mini; then, 
before you unplug the power supply, touch the min i's metal frame . 

Medium-grit sandpaper 

Plastic pry stick or picnic knife 

OK, hacker, time to put your putty knife where your 
mouth is. The target gap is extremely thin-if the blade 

isn't sharp, give it a little attitude adjustment with some 
sandpaper. Grind the blade at about a 15-degree angle to the 
flat sandpaper, but don't overdo it. 

Lay the mini upside down and wedge the putty knife into 
the gap between the plastic bottom and the metal frame - go 
down about half an inch . You can't see them yet, but little 
plastic latches on the inner piece hook into a groove inside 
the sidewall of the outer piece. Push the blade straight in, 
and push out slightly on the putty knife's handle to pry up the 
inner piece. You should hear the latches pop as the pieces 
start to separate. If the gap .doesn't stretch the length of the 

A good, slim 
putty knife slips 

right into the 
gap-if your 

blade is too fat, 
grind it down 

with some 
sandpaper. 

54 MacAddlct May 2005 

r I 
~ 11 r 
r 
( 

:\; --_ ... ____ --------"· 

min i's side, hold the 
gap with your thumb 
while pulling the blade 

RAM: 1GB DOR PC2700184-
pin DIMM ($219.99, www 
.crucial.com) 

out slightly (just far enough to clear the latches), and slide 
the knife over to address the remaining latches. When you 
free all the latches on one side, keep the gap open with a 
finger or two while you give the same putty-knife treatment to 
the other (facing) bottom edge. When you've freed the latches 
along both sides and have a decent gap all the way around 
the mini, hold the bottom piece (which is currently facing up 
since the mini is still upside down) with its ports facing you, 
and carefully angle the inner piece up out toward yourself. Set 
the top section aside for now. 



If a RAM job is all the upgrading you can stomach, relax-you' re 
almost there. If your mini has Bluetooth, you'll have to move 

the antenna; carefully pry it out of its slot, and rest it on top of the 
optical drive. Try to bend the connecting wire as little as possible . Now 
release the slot-locking tabs at each end of the RAM slot and remove the 
existing DIMM. When inserting the new DIMM, make sure it's PC2700 
or greater (our mini came with a PC3200 DIMM) and try not to touch the 
metal connector pins on the business end, nor any of the metal bits on 
the module itself. Press the DIMM straight down into the slot until you 
feel it snap into place. Congratu lations! You just performed the easiest, 
most effective upgrade ever. The only downside is that you now have a 
leftover DIMM that you just removed 
from the mini-we sold ours on eBay Bust that Bluetooth 

for beer money (a 256MB stick fetches antenna out of the way, and 

about $20). your RAM is home free. 

No peer pressure here, but if you're thinking about calling it 1 

a day afte r upgrading your min i's RAM, you should probably 
know that swapping in a bigger or faster hard drive and more 
capab le optical drive is child's play at this point. C'mon, chicken . 
No takers? Fine (bawk, bawk, bawk!) . If you've got a Bluetooth 
antenna, snap it back into place, slap the cover back on your 
mini, and snap the cover shut; now plug 
everything back in, fire the mini up, and 
revel in the righteous speed boost you get 
from such a simple upgrade. 

Like limbs on a school 
bus, keep your latches 

inside the case. 

Stage 2: Upgrade Your Drives 8 

......... ... 
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Want more storage capacity? How does 100GB sound? Need 
more speed? A 7,200-rpm drive will help. Want to burn DVDs? 
Add a SuperDrive. Before you dig in, though, know that the 

button wires are inexplicably taped to the subframe, and if 
you have AirPort and Bluetooth preinstalled, you'll have two 
antennae to remove from the subframe. If you don't have 

min i's hard disk and optical drive both ride along in a removable 
subframe that has a few little booby traps : The min i's power-

preinstalled wireless, 
skip ahead to step 3. 

Th e AirPort antenna wire runs the length of the mini's backs ide, right behind the optical 
drive. Use a fingernail or hard plastic stick (we used a plastic picnic knife) to push the 

release latch as shown in the photo below (top right) . Before pulling the antenna up too far, 
follow the wire back until you find where it's taped to the frame. Carefully remove the tape and 
pull the antenna and its connecting wire up and out of the way. Note that it's still connected to 

the board beneath the frame, so handle with care. 

Jewelers #0 Phillips 
and Jewelers #2 Phillips 
screwdrivers 

Plastic pry stick or picnic knife 

SuperDrive: Pioneer 
DVR-K04 Dual-Layer Slot
Loading Drive ($159.99, www 
.macsales.com) 

Hard Drive: 100GB Seagate 
Momentus 5,400-rpm Ultra 
ATA/100 ($239.99, WWW 

.macsales.com; $199, www 

.newegg.com) or 60GB Hitachi 
Travelstar 7,200-rpm Ultra 
ATA/100 ($175.97, WWW 

.macsales.com; $155, www 

.newegg_com) 

Remove the AirPort antenna from the 
subframe, but leave it connected to 

J the board underneath. 
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Find the Bluetooth antenna on the corner opposite 
the AirPort antenna (above the RAM) . There's no 

latch; just carefully pry the antenna up out of its slot in the 
plastic rail. Before pulling it up too far, follow the wire back 
until you find where it's taped to the subframe. Remove the 
tape, and carefully pull the Bluetooth antenna and its wire up 
and out of the way. Like the AirPort antenna, the Bluetooth 
antenna remains connected to the board under the subframe, 

so just move it out of 
the way; don't remove 
it completely. 

Leave the Bluetooth antenna 

Six screws secure the optical drive; two each on the left and 
right sides and two more securing its data and power ports 

to the interconnect board. Remove all six screws as indicated in the 
photo and put them somewhere safe; don't be ashamed to label 
them . Using your plastic stick, carefully pry the drive away from the 
interconnect board; when you get them separated, slide the drive 
out the front of the frame, away from the interconnect board. 

Now just slide in the replacement drive and carefully plug it into 
the connector on the interconnect board. Replace the screws. If 
you're into the idea of upgrading the hard drive and upping the 
clock speed, read on. Otherwise, reverse the prior directions to 
replace the frame, reattach the antennae (if you've got 'em), and 
slap the lid back on your mini. If you fire 
up your mini and it doesn't recognize 
the new SuperDrive, use Patch Burn 
(free, www.patchburn.de) to install the 

The six screws you need to 
remove are hiding on the 
sides of the drive where 

The min i's power button isn't connected 
to the subframe, but the wire connecting 

that all-important button to the motherboard is . 
If you pull out the frame without freeing that wire, 
you're likely to wreck the delicate motherboard 
connector and probably the power button as 
well - and you'd be rightly cheesed off at us. 
Carefully remove the 
tape that 's securing 
the power-button wire 
to the frame . 

Make sure to remove this 
tape, but leave the power 

plug in place-for now. 

Find and remove the subframe's 
three securing screws (left) and set 

them somewhere safe. Label them if you're 
forgetful or paranoid. Before lifting out the 
subframe, gather the Bluetooth and AirPort 
antennae and notice how their connecting 
wires snake through the slot at the edge 
of the subframe. Carefully guide both 
antennae through the slot as you lift the 
subframe straight up and out. 

Mind the antennae as 
you lift out the frame. 
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To get at the min i's hard drive, flip the subframe over and lay it 
optical-drive-side down. Four screws secure the hard drive-two 

each on the right and left sides-but first, you'll need to get that fan out 
of the way. Remove the fan's three screws and stash them, then flip the 
fan up out of the way and remove both drive-mounting screws on that 
side. Two things about the screws on this side: You may need an angled 
or very short screwdriver to get them; and 
whatever you do, don't remove the tape from 
the little hole in the frame-it's crucial to the 

Flip up the fan to reveal 
the hidden drive-
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Before removing the other two screws, carefully untape the wires that are secured to the 
drive's circuit board-they feed the fan and speaker-and carefully unplug them from the 

interconnect board . Pull the plug, not the wires! Pry with the _______ _ 

plastic stick if you need to. Now remove the hard drive's other two 
mounting screws. Take your trusty plastic stick and carefully pry 
the drive off the interconnect board. Note that the connector is part 
of the board, not part of the drive: Make sure to pry from the drive 
side. When you free the drive from the connector, slide the drive 
out away from the connector and slide in the new one. Be careful 
plugging the new drive in-the pins bend easily if misaligned. 
Return the screws, replace the fan and speaker wires (don't forget 
to plug them in), and you're done. 

D'oh ! My Data! 
If you don't want to start fresh with your min i's new hard drive, make sure to back up the 
contents of your original drive before removing it. Use Disk Utility (/Applications/Utilities) 
to create a disk image of the min i's drive and save the image to an external FireWire drive. 

When you get the mini's new drive installed, boot off the 
mini's software install CD, launch Disk Utility from the 
menu bar (Installer> Disk Utility), and use the Restore 
function to rebuild your old system on the new drive. 

Back up and restore your 
old system if you don't want 

to start from scratch_ 

6 0 0 

f~· ~ vG 

1 We know it's difficult, but 
pull the plug, not the wires-

""'? -- ~.~ 1 
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Stage 3: Overclock the Lil' Sucker 8 WHAT YOU NEED 

If you've never done any 
soldering, now's not the 
time to learn . If you slip up 
even the teeniest, tiniest 

The final step of this mini-maxing is by far the skankiest. 
You haven't yet done anything explicitly warranty 
voiding-but that's about to change. Now it's time to send 
away the children and pacemaker-wearers; we're gonna 
rip out the min i's motherboard and perform micro resistor 
surgery to push a 1.25GHz mini up to a no-nonsense 
1.SGHz speed-a net gain of 250MHz. Or we'll just kill it. 
Grit your teeth now, this might sting a bit. 

amount when performing 

this stage, you run the very real risk of 
fatally frying your lovely new mini - and 

don't come crying to us if you do. 

If your mini has preinstalled Bluetooth and AirPort, remove the two screws 
on the mezzanine board as indicated in the photo, and pull the board 

straight up to remove it. Make sure your Bluetooth and AirPort antennae remain 

attached. 
Now remove the lone screw holding down the motherboard. As you can see in the 

photo, it's near the RAM and mezzanine connectors . What you 
can't see in the photo is that this screw is nearly (but not quite) 
identical to the screws you took out of the subframe-keep an 
eye on this one after you remove it. 

Remove three 
screws to free up 
the motherboard_ 

Jewelers #0 Phillips 
screwdriver 

Plastic pry stick or picnic knife 

Low-heat soldering iron 

Eagle eyes 

Your head examined 
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Now it's time to unplug that power-button lead we untaped from the frame 
while displacing the drives. Find it hiding behind the processor heat sink in 

the back corner near the power button . As always, pull on the plug, not the wires; 
use your plastic pry stick if you need help. The mini's status LED is also plugged 
into the motherboard, up in the front-right corner. Once you unplug the LED, notice 

the LED assembly is mounted on the min i's 
bottom piece. Gently bend the LED assembly 
a wee bit out and away from the motherboard 
to make a little clearance room, then angle 
the board up and out, away from the rear-side 
ports. Lay the 
board on your anti 
static operating 
table (no metal 
tables, please) 
and go scrub up 
for surgery. 

As tough as it is to avoid 
breaking these wee plugs, 

it's even tougher to fix 
them. We reiterate: Pull 

OK, tough guy, time to show some mettle-actually lead, rosin-core solder. Locate the 
resistors labeled R362, R358, R355, and R351 (they're behind the processor, more or 

less); plug in your soldering iron; and say three Hail Marys for each MHz you're trying to gain. 
Look at the weensy little resisto rs; now study the PLL (phase-locked loop) multiplier chart 
below ("Chill PLL")-notice that for some speeds, namely 1.SGHz, you simply remove all 
of the resistors-relatively easy. And if things go horribly wrong and you have to 
return a resistor to its original place, here's a little secret: The resistors 
are of such low ohmage, you can just drop a solder booger in place 
of the resistor (and if you don't know what ohmage is, you have no 
business performing this hack) . If your glob of solder is touching 
both pads, then you just made a resistor-if you're lucky. 

Once you get the speed configuration you want, 
reassemble the mini, cross your fingers, and fire it up. If 
your solder fu is strong, the mini will roar to life, and you'll 
be able to see your new, faster clock speed in Apple Menu 
>About This Mac. If the solder gods are angry, your mini 
will just sit there like a recalcitrant lump-o-'lectronics. 
Before you begin weeping inconsolably, double-check your 
solder work-if it's dirty, clean it up to make sure you haven't 
inadvertently left part of the PLL circuit closed with solder; if 

it's clean, reconfigure your resistors for a lower clock speed and 
try one more time. 

Chill PLL 
Use this handy table to configure your resistors. We chose the path of least resistance, 
removing all of the resistors for a speed of 1.SGHz. 

SPEED R362 R358 R355 R351 

1.25GHz • • • x 

1.42GHz x • x • 
1.SGHz x x x x 

1.58GHz x • x x 

• = resistor in place x = no resistor 

We're using this 
crapola soldering iron 
because our solder 
fu is strong. If yours 

isn't, turn back now, 
or get yourself a good, 

sharp-tipped, low-heat 
soldering iron. 

About This Mile 

Mac OS X 
Version 10.3.7 

( Software Upd.lte ... ) 

Processor 1.5 GHz PowcrPC C4 

Memory l GB DOR SCRAM 

More Info ... 

TM & A.ppl~ Computer. Int. 1983~2004 
All Rights Reserved. 

,~ Niko "Hacksaw" Coucouvanis is pleased as pudding that this upgrade worked, but kinda peeved that he spent more on upgrade parts than on 
~the mini itself. 
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Convert PC Video Files to Quicklime 
by Johnathon Williams 

WHAT YOU NEED 

Mac OS 10.3 or later 

Forty-Two DVDVX Plus ($14.99, www.kaisakura.com) 

Quicklime Pro ($29.99, www.apple.com/quicktime) 

W 
MV, AVI, ASF-the alphabet soup of Mac-incompatible 

video formats can be a vile stew. Doubly so when a 
video clip that you really, really want to see is only 
available in one of these foreign formats. 

Here, we show you how to convert these file types to more 

QuickTime-friendly formats. This method isn't infallible-the 
output can be a bit unpredictable, and files in 

ON THE DISC the latest Windows Media Player format can 
comp letely choke the process-but it's almost 

~----~ always worth a shot. 

1 •nstall Converter and Support Files 
Our workhorse for conversions is Forty-Two DVDVX 
Plus-grab it off the Disc or download it from www 

.kaisakura.com and drag it to your Applications folder. On first 

launch, Forty-Two DVDVX Plus presents its Setup Assistant. Click 
Continue until you get to the Software And Components Check 
window, which prompts you to install five additional packages. 
Four are codecs (software for coding and decoding different 
types of video), and one is a stand-alone movie player. You'll 

Installing Forty-Two DVDVX Plus 
is only half the battle. For more 
converting power, install the 
helper packages, too. 

need them all. 
Now click the Install 

Remaining button. You'll be 

asked to approve some of 
the installations as they're 
downloaded. When you click 
the final Continue button 

in the Setup Assistant, yet 
another installer window will 
open. This one is for DivX, 
another popular codec

install it as well. 

Our converted file is now a QuickTime-compatible AVI 
encoded with DivX. Purists, however, won't rest until 

they've got a native QuickTime movie with a match ing .mov 
extension. To make it so, open the converted file in QuickTime 
Pro and select File > Export. From the Export drop-down menu, 
select Movie To QuickTime Movie. Click Options to select codecs 
for video and audio. MPEG-4 offers terrific quality and good 
compression, but you may choose whatever codec you like. 
You'll probably need to experiment with these settings to find 
the best balance between quality and file size. 

Drag the icon of the file you want to convert from your 
desktop into the square pane at the top left of Forty-Two 

DVDVX Pius's main window. The bottom pane contains a list of 

video presets. The one that we're interested in is QDVD, which 
produces a QuickTime-compatible AVI file. Click it. 

The QDVD preset works best on files with large video 
resolutions (400 pixels wide or more); conversely, it tends to 
resample small-size movies to the preset's default width of 640 
pixels, which can leave them pixelated and quite ugly. 

To preserve your original resolution, click File > Advanced 

~·::.="""' Options. In the drawer that 
,....., ::::::=:"'·'' s:'.::::;. QiD appears, click the Custom Width 

~ ....... -. check box and enter your video's - ,, 
~~ l · l 

cha U Q \loboolo>tl -A..--

Aiolodlte Porubll 
co-

It's a good idea to specify a 
custom width for movies less 
than 400 pixels wide. 

width. Then, click the check 
box next to 2-Pass Encoding. 

Finally, click Start to begin the 
conversion . Even with these 
precautions, the resolut ion may 
still change. If that happens, see 

step 3 to restore it. 

Compression Settings 

~( Video 

Quality ---------~ 

Least Low High Best 

Converting, like translating, is an art, not a science. If your video 
comes out grainy, adjust your encoder settings in Quicklime. 
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60 ~ ~~~;~youriPod 

Put Linux on Your iPod 
by Alex Handy 

WHAT YOU NEED 

First-, second-, or 
third-generation iPod 

Mac running OS 10.3 or later 

iPodlinux (free, http://ipodlinuxinstl 
.sourceforge.net) 

ON THE 

DISC 
IPodllnux 0.3 

s uccessfully installing and running the Linux operating 
system is considered a badge of honor among the 
peecee nerderati. You can do them one better, 
however, by using iPodlinux to install Linux on an 

iPod . Jnstant geek cred! After that, you' ll be able to use Linux 

Installing Linux on your iPod is easy-cheesy, but you'd 
be wise to back everything up-just in case. First, plug 

in your iPod ; if it doesn't automatically mount on the desktop, 
launch iTunes and open iTunes >Preferences. In the iPod section, 
click the box labeled Enable Disk Use. Now launch Disk Utility 
(/Applications / Disk Utility) , select your iPod, and click the New 
Image icon or select Images> New > Image From Disk. Save the 
disk image file somewhere safe on your Mac. You could skip 
this step-but if things go downhill in the next two steps, you'll 
probably regret it after your iPod eats all of your music and won't 
do anything other than flash the question-mark folder at you . 

- 149.1 GB ST3160023 

- hoop\• 

37-3 GB Apple CompJ 

Save As: I ipod_backu~ 

When : i G kibble 

Dfsk Utility 

:::JG 
:J Create a disk 

image for 

backup-just 

Podzilla functions almost exactly like the regular iPod 
menu system, more or less. Under Music, you can 

browse tunes by album, artist, or song, but not by playlist
iPodlinux doesn 't yet support iTunes playlists. No biggie-just 
boot into Apple's interface to listen to music. iPodlinux does, 
however, support the OGG music format, which Apple does not. 

The real reason to use iPodlinux is to record audio files (WAV 
only) without a microphone converter. Connect your iPod to your 
Mac in disk mode, then create a new folder named Recordings 
at the iPod's root level. Eject and disconnect the iPod, boot it 
into Linux, and navigate to Extras > Record . At the bottom of the 
screen, you'll see that the default recordin g quality is a crappy 
8KHz, but iPodlinux lets you crank that up to a healthy 96KHz. 
To record, plug a microphone into the iPod's headphone jack. No 
mic? Your left iPod earbud doubles as a mic in a pinch. 

Unfortunately, iPodlinux's WAV playback is extremely cra sh 
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Despite what nature shows 

say, penguins love Apples

especially in confined spaces. 

to turn your 'Pod into an ad-hoc voice recorder. Download the 
iPodlinux installer from http ://i podlinuxinstl.sourceforge.net 
or grab it off this month 's Disc-but note that iPodlinux doesn't 

currently work on the latest iPods (shuffle, mini, photo, and 
clickwheel models) . Now let 's geek out! 

2 Gentlemen, Start Your Linux 
With your iPod plugged into your Mac, double-dick the 
iPodlinux installer. Agree to the terms of use and click 

the Install button . When the installation finishes, drag the iPod 
icon from your desktop to the Trash to eject the iPod. Unplug the 
data cable , and hold down both the select and menu buttons for 
five seconds to restart your iPod. 

On reboot, your iPod will display the usual Apple logo and 
then briefly show Tux, Linux's penguin mascot, before settling 
into the regular old Apple iPod interface. To boot into Linux, 
restart the iPod, but hold the back-arrow button as the iPod 
boots . This drops you into Podzilla, the iPodlinux interface. 

t7U U 

JPod: stuPod 

Install 

lJnmsull 

iPod-UnulC lnst.allu 

Make Linux Default OS 
Unlike installing Linux 

on a desktop machine, 

prone, so you should download recordings from the iPod 
(/Recordings) to your Mac and listen via iTunes or QuickTime 
Player. There's a lot more you can do with iPodlinux, such as 
play FLAC sound files and connect to the iPod via telnet fo r 
command-line fun . Check out www.ipodlinux.org for all the 
details on thi s evolving operating system. 

CE f Recordings fQ.· loca! disks -i:.J proc .. 
I ' ' .' @; 01162005 232429.wav 
ft sbin .. 

Like any Linux first-timer, you're now wondering, 
"What was the point of this exercise?" 

,~Alex Handy is a crusty old Mac geek who is now made entirely of tin . 
~He biogs at www.gism.net/ blog. 
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by Chris Barylick 

WHAT YOU NEED 

Mac OS 10.3 or later 

Broadband Internet connection 

Built-in or external microphone (headset recommended) 

Skype 1.0 (free, www.skype.com) 

I 
n-game chat is great for coordinating team strategy and 
taunting opponents. The problem is that it's generally more 
trouble than it's worth-fraught with connection problems and 
a general tendency to slow down gameplay for one reason or 

another. What you need is a stand-alone voice-chat application to 

run innocuously in the background while you 
ON THE DISC get your game on. Skype is that application-

and here's how to set it up to add a little human 
interaction to your online gaming. 

Adding voice chat to games brings intrateam communication-and 

interteam trash talking-to fun new levels. 

Skype is a free VoIP (Voice over IP) app that allows users to converse in real time over the 
Internet-Mac, PC, whatever, as long as the computer is running Skype. Beyond that, you 

just need your Mac's built-in mic and speakers, although a headset helps keep things to yourself. 
Since Skype runs alone as a background app, you can use it to chat in any multiplayer game. 

Grab Skype off this month's Disc (or download it from www.skype.com), double-click the 
Skype_1.0.0.0.dmg file to mount the image, and then drag Skype to your Applications folder. 

Before you start your chat-a-th on, plug in your mic (or headset), open System Preferences,. 
and go to the Sound pane. Click the Input tab and click on the audio sou rce you're using. Test 
your mic level by speaking into the mic while watching the onscreen Input Level indicator. 

Choou a d1YIC1 for JOwtd Input -NE 

lnp111 Lev4I: I II I I Q1'fi a 1 a 

Tweak your input level to squelch 

squeal or gain some gain. 

Adjust the Input Volume slider (if necessary) until the peak level is around the middle of the scale . If your gaming setup includes big 
speakers, you may need to spend time tweaking your input level to find the sweet spot between inaudibly low and blowout high. 

Before chatting, you'll need to create a Skype account in order to contact other Skype 
users. Launch Skype and follow the prompts to set up a new account; enter a user name, 

password, and email address . Once you're done, click the Add button to start adding your pals' 
Skype user names to your Contacts list-obviously, this step only works if your pals have already 
installed Skype and told you their user names. This would be a good time to make a test call to 
one of your friends to make sure everything's kosher with the connection; plus, it's easier to fine
tune your input level if you've got a helpful ear on the other end. To initiate a call, just double
click a name in your Contacts li st. 

Wti<ornttoSl)'l)t 

Pinn uf.ta w!Y1would'f'OU1lk110 do: 

Q l llltt;MVh>vt ~ Sl<VPt N..,.. •ndWOlll<llot, 1.:11c>g1n 

e . ...,.,.... ~ .. .... , .. ~. ~ s~ ,,,. 1-. rnc 

Sorry, chief-the best Skype user 

names are already taken. 

Conft~«toplc 

r..--~11'1 

~b-d-m••-, --~ lb ~or~w 

j n :~~~:ate1puml)klnum ::::,.., 
Q U tllll'ir1 

When you're done with the test call, click Hang Up. To initiate a conference call for up 
to five simultaneous users, click Conference or select Call> Start Conference Call from 

the menu bar to summon the Start Conference window. Select a contact you want to invite to 
the session, click Add To Conference, and then do the same for three more contacts. When 
your Conference Participants list is full (you plus four others for a total of five), click the Start 
Conference button; your Mac will make a ringing noise as the recipients accept the calls. Go 
ahead and start yakking to make sure the connection is good. Once the conversation is in full 
swing, leave Skype running and open your multi player game of choice, log into a game server, 
and marvel as the conversation continues unabated. 

See, conference calls don't have to be 

boring and stupid. 
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More Memory = Faster Mac 
Get more memory to run more of your applications faster! 
Top quality memory from owe makes the difference! 

• 4 or 8 memory slots 
• 4 internal drive bays 

• AGP BX video slot 

• 3 PCX or PCI slots 
• FireWire 400/800, USB, 

Bluetooth & AirPort 

3200 DDR C.A.S. 3.0 
Maximum up to 8 GBs! 
1 GB kits (2) 512 MB 

DIMMs $139.99 
2 GB kits (2) 1 GB 

DIMMs $359.99 

PowerMac G4 w/AGP Slot 
• 3 or 4 memory slots 

• 3 or 4 internal 
drive bays. 

• AGP video slot 
• FireWire and USB built-in 

Maximum up to 2 GBs 

256 MB from $31.99 
512 MB from $79.99 

iMac G3, G4, and GS; eMac G4 
• 2 memory slots 

Mac mini Memory 

PowerMacG3 

• l Slot 
·l GB Max 
·DVD & HD 

• 3 or 4 memory slots 
• 2+ internal drive bays 
• FireWire and USB 

(Blue & white only) 

Faster ·· 
=Mac 

Maximum up to 2 GBs 
256 MB from $32 
512 MB from $79 . 
1 GB from $169 ( 

SODIMMs Max. up to 2 GBs 
256 MB from $29 
512 MB from $75 
1 GB from $199 

1 GB PC2700 DOR DIMM 

Only $169.99! 

PC66/ 100 CL2 SDRAM 

Maximum up to 1 GB 
256 MB SPECIAL $25.99! 
256MB x 3 = 768MB, x 4=1GB! 

You've got the right Mac, but does your Mac :-;-;--
have the right memory? With top quality memory ~· !"!S=it 
upgrades from Other World Computing, OS X and ,:5 
applications can run faster and better than ever! Less ·~~:_-=.___·=.._-- -·fl_:J'_. -· 
spinning 'beach balls '! We have memory for just about : ll1i 

every Apple/Mac out there! Call and speak to one of 
our knowledgeable sales reps, or visit L- --=-----~ .::::_ ____ ' 
www.macsales.com/memory to use our online memory guide. 

MA_OS·OS 

CIJI1rEtJ f!IlI1i[JJ] (B11JI£JJII11I0 

Make music, movies, data backups and more! 
~ You can use Apple LJ 
""'" ,,.. '"" '""" '"" iTunes/Discburner, 
"'"" 

0
""""" °""'"'" 'M'"" 

0
''""'M' Toast, or just about 

B GIJ -. 'JfP any CD/DVD authoring 
.......... ~:~;; ,:::::, o .. ,., .. m software available! 

Up to 16X DVD Burn Speeds 
Up to 40X CD Burn Speeds 
Up to 6X Dual Layer Burn! 

I My -

0 
Movies 

Internal 
options 
for iMacs & 
PowerBooks 

Internal options 
for desktop Macs 

--~ rlf 
. Bigger, better, faster, and quieter! 

Upgrade your hard drive today! 

& Seagate. ~ ~~mn· TOSHIBA ~· HITACHI 

SERIAL ATA ATA/IDE S 
Available for the Mac model you have! 

For Minis, iBooks & PowerBooks 
\ 

2.5" Up 
1 

1 
'- to 120GB , 

-.!~~ 
Hard Drive Controllers 

Use Serial ATA hard drives or bigger, 
faster ATA drives with a new PCI hard 
drive controller 

SllG Serial ATA/150 
Mac PCI Controller $59.99 
·Supports up to 2 drives f;,."J 1['.fN 
·Plug and Play 

Sonnet Tempo ATA/133 
Controller $79.99 
·Supports up to 4 ATA drives 
• For OS 8.6-9.2.x & OS X. •; 

• 3yr warranty l®N N®r 
J1Mn r :Ju r 

PRAM Batteries 

For iMacs, eMacs & PowerMacs 
. \ 

Dulldlng Neh•·orliJI For Peopl~ 

3.5" Up 1 , 
to 500GB , 

..Jrom $49!r 
~ , ...r-J 

D-Link 10/100 
Ethernet PCI Card $9.99 



DVD-+RIRW, +R Dl up to 16X, CD-RIRW up to 40X Burn 

OWC Mercury Pro FireWire/USB 2.0 Combo $159.99 
OWC Neptune FireWire only Solution $149.99 
Above include: All Cables, Dantz Retrospect Backup, NTI Dragon burn, 
25 pieces 52X CD-R Med ia, 5 p ieces BX DVD-R med ia, 1 year OWC Warranty 

OWC FireWire/USB 52x32x52x CD-R/RW Solutions 

OWC Mercury Pro FireWire+USB 2.0/1.1 $97.99 o~ 
OWC Neptune FireWire only Solution $89.95 ""'® 
Above include: All C~bles, Dantz Retrospect Backup, NTI Dragon burn, 
25 pieces 52X CD-R Media, 1 year OWC Warranty 

Connect to thousands of new 
USB and FireWire Products! 
ADD Fl REWIRE 400/800* OR 
USB 1.1/2.0* TO YOUR POWERMAC! 

Add\ I 
FireWire I 

" and/or USB -' 
-.lrom $9.9~ 

""~ ..... r-J 
OWC 2-port FW 400 PCI Card for PowerMacs $9.95 
OWC 3-port FW 800+2 Port 
FireWire 400 PCI for PowerMacs $49.99 
OWC 3-port FW 400/5 Port 
USB 1.1/2.0 PCI for PowerMacs $29.95 
• FireWire 800 and USB 2.0 operation req ui re Ap ple OS X 10.2.x or later. 

ADD FIREWIR,E 400/800 TO ANY POWERBOOK! 
owe 2-port FW 400 
PCMCIA for PowerBooks $24.99 
LACIE 2-port FW 800 
PCMCIA for PowerBooks $78.95 

J'zjll •J f •)l 
M-Audio StudioPro 4 
Desktop Audio Monitors $149.00 .:J!:Oii~=~'"--
M-Audio Keystation 49e 
49-Key USB Midi Controller $99.00 
Nova Large Capsule 
Cardioid Microphone $99.00 

=~~~;. ~~~~ • 
Contour Shuttle A/V Controllers ' 
Shuttle Pro v2 Jog/Shuttle c't 
(lS programmable buttons) $84.99 
Shuttle Express Jog/Shuttle 
(5 programmable buttons) $39.95 

Macwor/d Editor's C h o ice April/2005 

011VC Fire11Vire Er USB 

l/J!:). ~ 
U'mt!ID 
awe 
Mercury 
Elite Pro 
The sleek, 
compact 
solution that 
stands or 
stacks. 

Your Drive+ 
Mercury 

=Plug 'n/Play 
External! 

llJ!J.. .t!l!JllP_ .,.-m:i 
awe 
Mercury 
On-the-Go 

FireWlre400 I 
Power ON/OFF 

H igh performance plug & play 

OCPOW9rln FlreWlre400 

Size 
80GB 
120GB 
160GB 
200GB 
250GB 
300GB 
400GB 

FireWire 
Speed Data Buffer 400/USB 

7200RPM 2MB $129.99 
7200RPM 8MB $159.99 
7200RPM 8MB $179.99 
7200RPM 8MB $209.99 
7200RPM 8MB $229.99 
7200RPM 8MB $299.99 
7200RPM 8MB $419.99 

FWSOO/ FWSOO/ 
400* 400/USB 

$159.99 $169.99 
$179.99 $199.99 
$199.99 $219.99 
$229.99 $249.99 
$249.99 $269.99 
$319.99 $329.99 
$449.99 $459.99 

Call for other Available Models and Options! 
• Elite 800 Pro FWB00/400 so lution has same ports as pictured FWB00/400 + 

USB model, w ithout the USS 2.0 port. 
All Mercury Elite Solut ions are Apple HFS+ Preformatted Ready to go and.include: 
Dantz Retrospect, Express Backup Utility(Mac/PC), lntech HD Speedtoo ls (Mac), all 
cables, and a 2 Yea r OWC Warranty. 

Build your own Mercury Elite FW/USB drive 
Case kits include all connecting cables and driving mounting 
screws. Use any 3.5" IDE/ATA hard drive up to 500GB! 

Oxford911+ FireWire 400 Kit $65.99 
Oxford911 Combo FireWire400/USB2 Kit $79.95 
Oxford912 FireWire 800/400 Kit $99.95 
Oxford922 FireWire Combo 800/400/USB2 $119.95 

FireWire FW400 + USB 
Mercury On-The-Go 400 2.011.1 
40GB 5400RPM 8MB Data Buffer $139.97 $149.99 
40GB 5400RPM 16MB Data Buffer $149.97 $159.99 
60GB 4200RPM 8MB Data Buffer $159.97 $169.99 
60GB 5400RPM 16MB Data Buffer $179.97 $189.99 
60GB 7200RPM ' Fastest Ever!' $235.97 $239.99 
80GB 5400RPM 8MB 'Fast-High Cap.!' $219.97 $229.99 
lOOGB 5400RPM 8MB 'Fastest S400RPM' $299.97 $309.99 
Call/Visit www.macsales .com for other 20-lOOGB models. 
All Mercury On-The-Gos are Apple HFS+ Preformatted and include Dantz Retrospect 
Express Backup Util ity (Mac/PC), lntech HD Speedtools(Mac), all cables, AC Power 
Supply, and a 1 Year OWC Warra nty. 

Build your own Mercury 
On-the-Go FW/USB drive 
Case kits include all connecting ca bles 
and driving mounting screws. 
Use any capacity 2.5" IDE/ATA drive 

Oxford911 FireWire 400 Kit $67.99 
Oxford911 Combo FireWire 400/USB2 Kit $79.99 

Neptune "Value Done Right" 
Size Speed Data Buffer 

Features the same Oxfo rd911 
bridge as our highly acclaimed 
Elite Pro fo r all the performance 
and a value that can't be beat! 

40GB 7200RPM 2MB 
80GB 7200RPM 2MB 
120GB 7200RPM 8MB 
160GB 7200RPM 2MB 
200GB 7200RPM 8MB 
250GB 7200RPM 16MB 

$99.99 
$109.99 
$139.99 
$139.99 
$179.99 
$199.99 

Call for other Available Models and Options! 

Neptune FW Solutions include Dantz RetroSpect Express 
backup softwa re (Mac & PC), lntech Speedtools (Mac). all 
cables, 1 yr. OWC Warranty 

For all of your high-speed storage needs! Visit http://www.macsales.com/firewire 



n ) neUJert:ec:'hnology~ 
iPod Replacement Batteries 
Get up to Over 20 Hours of Playing \\ E 1 t 11 
time for iPod with ls~, 2n~, 3rd 0~'!ni~~ a 
and now 4th Generation High tools included 
Capacity Batteries! (On ly 1G/2G 

/3G iPods) 
1st/2nd Gen 1800mAh $29.99 
1st/2nd Gen 2100mAh $39.99 

4th Gen 

3rd Gen "Dock Connector" 850mAh $25.99 
4th Gen 'Click Wheel' 750mAh $25.99 
Replace your short running iPod Battery with 
one that's far better, the longest running internal iPod 
batteries available! Vis it www.macsales.com/ipod for all 
of our great Apple iPod products! 

llJ]1(i]~!.;J mw M 
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High-Capacity PowerBook Batteries 
Up to 50% more Capacity than Original! 
NEW! PowerBook 12" & 17" Batteries now available! 

G415" 'Aluminum' 
53.3 watt hour $129.99 

G4 15" 'Titanium' 
65 watt hour $139.99 
71 watt hour $149.99 

7200mAh $159.99 ~ 
Lombard/Pismo G3 .. 

5400mAh $139.99 

n) RoadTrip0Jf 
FM Transmitter $14.99 
for any iPod or music player - Listen to your music 
through your car's FM radio. Now available in 87.9 MHz 
and 107.7 MHz version (not a power adapter or iPod charger) 

PowerBook G4 17" 

I ,, 
l 
PowerBook G415" $15.99 

15" PowerBook G4 12" I 
iBooks $12.99 II iBook Batteries from $99 

The longest-running laptop internal batteries available 
Call or visit www.macsales.com/batteries for all your 
PowerBook battery needs. 

Protect your computer with 
these great products! 

matias products Matias 
Laptop Armor 
Carrying Cases 
from $78.99 

Connectivity 
Upgrades and add-ons for home and the road! 

D-Linll 
PCMCIA Ethernet Card $19.99 

~IDIGEAR' 
logear 2 Port USB 2.0 PCMCIA Card $38.95 
logear Bluetooth to USB Adapter, 30 Meter $29.99 
logear Compact Firewire 6 Port Hub 1394A $59.99 

G acally- -~ MacAlly BT-Mini 
Programmable Bluetooth Mouse $46.99 
MacAlly iVoice USB Microphone Adapter $14.99 
MacAlly lceCam USB Video Web Camera $29.99 
MacAlly lceCad USB Mini Writing Tablet $39.99 

MA_OS·OS 
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Rain Design iLap 
for iBook and PowerBook 
sizes 12"-17" 
from $49.90 

Village 

~ 
Tronic VTBook 
Add another CRT or Flat 
Panel Display to your 

- Powerbook $246.99 

You don't do 

Hood man 
Laptop Hoods 
for Powerbook and iBook 
12" Models $27.95 
15" Models $28.95 
17" Models $29.95 

Windows? Pay less. Get more. Surf faster! 

Mac-Only 
Internet 

from just saper 
month! 

High-Speed Nationwide High-Speed 
Nationwide Dial-up and DSL Services 
24/7 Toll Free Tech Support & More! 

Visit www.FasterMac.net or call toll free 
800-869-9152 to learn more or to sign up today! 



G4/7455 1.0GHz 
G4/7455 1.2GHz 
G4/74551.4GHz 
G4/7447 1.467-1.SGHz 
Call for BREAKTHROUGH 

G4 Upgrades 1.0 to 1.8GHz 
from $399.95! 
• 100% Compatible w/ all Apple Software 

and Operating Systems /I 
• 30day100% money back guarantee 
• 3 year warranty lets you buy with confidence! ·~ 

· .~ Ca/1800-275-4576 or visit 
www.macsales.com/FASTER for 
New PowerMac G4 'MOD' DUAL 

......,_,.,_...., Processor Upgrades from $599.95! 

Power Up that PowerMac! 
Power up your G3 Beige, G3 Blue & White, & G4 
'Yikes' with Wicked Fast ZIF Upgrades by 
Powerlogix and Sonnet! 

jJ PowerLowx r~.......,. . 'ff! 

G3/1.0GHz w/1 MB L2 1 :1 Cache $259.00 
G3/1.1GHzw/1MB L21:1 Cache $349.00 
High Performance Value! 

.JIMPIY'flff" 

G4/500MHz w/1MB L2 2:1 Cache $159.00 
G4/800MHz w/1MB L3 4:1 Cache $299.00 
G4/1.0GHz w/1MB L3 4:1 Cache $395.00 

x800 GS Dual DVI with 
256MB $495.99 
9800 Pro5pecial Edition 
256MB $297.99 
For AGP Equipped 
PowerMac G4s: 
9800 Pro 128MB $249.99 
9000Pro128MB $127.99 
G3, G4, GS PowerMacs ~ 
with open PCI Slot: 
9200 Pro 128M B $124.99 

.JIMPI Y 'TJ J I" 

• 100% Compatible w/ all Apple Software and 
Operating Systems 

• 30day100% money back guarantee 
Sonnet Encore/ST 
G4/7455@ 1.0GHz $229.95 
G4/7455@ 1.2GHz $299.95 
G4/7455@ 1.4GHz $399.95 
G4/7447@ 1.7GHz $499.95 
Sonnet Encore/ST Duet G4/1.3GHz $695.99 
Visit www.macsales.com/ FASTER to see all the upgrades 
we offer for Powerbooks, PC/ Macs, Clones, Etc! Our 
Upgrade Finder shows you just what makes your Mac 
a FASTER Mac! 

Rock out to this CD created entirely with 
Apple's Garage Band Software and OWC 
Products including the Brian Moore iGuitar! 
www.thegaragealbum.com 

~~-
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~ 
The Power of OS X on Macs 
not supported by Apple! 

www.eshop/macsales!shop/osx-center 



Free shipping on all orders ove 
NEW iPod mini. .. in four new colors. Call MacMall for the com~ 

NEW! iPod mini! 
The new iPod mini offers an extended 
battery life that lasts up to 18 hours! 
t 4GB or 6GB models 
t Holds up to 1,500 songs 
t Only 3.6" tall, 0.5'' thick 

and 3.6 ounces! Nw GB 
-?QGB & 60 
:J ~f 

t Includes iTunes· for 
Mac· and Windows 

iPod' with Click Wheel! 
t 20GB model holds up to 5,000 

songs; 40GB model holds up 
to 10,000 songs 

t Up to 12 hrs. of battery life 
t Create playlists on the go 
t Adjust the speed of your 

audio books 
t Includes both FireWire' and 

USB 2.0 cables 

starting at $294! 

NEW! iPod photo! 
t 30GB and 60GB models 
t Holds up to 5,000 songs or up 

to 25,000 color photos 
t 2" backlit color LCD 
t Enjoy slide shows with your 

own music soundtrack 
t Scroll through color 

thumbnails of your photos 

starting at s344f 

NEW! iPod shuffle! 
t 1 GB model holds up to 

240 songs; 512MB model 
holds up to 120 songs 

t Skip-free playback 
t Provides up to 12 hours of 

playback per charge 
t Weighs less than 1 oz.! 
t High-speed USB 2.0 transfers 
t iTunes' for Mac' & Windows 

starting at s94f 

FREE!* 
With purchase of any iPo 

Shipping! (all orders over $99. 

PodSuit Case!** ($13.99 valu 

FM Transmitter! ($29.99 valu 

Engraving!** ($39.99 value!) 

Speakers! ($9.99 value!) 

'After mail-in rebates. See below for details. 
ttNot available on iPod shuffle. 

Call now or visit 111ac111all.co111 'or 111ore iPod accessories! 

II On Stage 
iPod 
Speakers 
#653811 

~_..- only $10593! 
naviPro eX 
For 4G iPod and iPod 
photo. #358153 

$A499f 
only 6f' • 

. ~ 
a • ... 

+ 

( GRlfFIN TtCHtlOIOGY ) 
-...9"t11tott<f\ftol<>n" .... 

• 

iTrip FM 
Transmitter 
#241722 

s299s1 
only • 

A 1 Headphone 
Amplifier 
#652268 

s72499f only • 

iPod Armor Dr.~otta 
For the iPod Photo 4G iPod. Q 
#177814 -

oo/4999
/ \ lJ 

( GRIFFIN tt01!.roioo' ) 

'IJollflft!MMol<Hjly.< .... 

Pod Freq 

iTalkVoice 
Recorder 
#404836 

s2999f 
only • 

iPod photo version of the 
premium FM transmitter for 
iPods. #180879 1111 

ss999f 
only • 

Now available! 
iTunes Music 
Store Card 

starting at s 7 5 ! 

iPod shuffle USB ti 
Power Adapter 
#188269 11 . 

s2s99f 
only • 

Your n1 Source for Mac Products! Order now: 1-800-965-3282 
Visit us at macmall.com for more Mac solutions! Source Code: MACADDICT 



~te iPod family. 

NEW iPod mini 
starting at 

s794f 
Great Deals on Accessories from MacMall! 

1911 LCD Display 
#372518 PR.!~.~· 

s-.nr99f 
only ~;,;, • 
After $100 mfr. mail-in rebate. 
Pnce before rebate $395.99. 
Offer expires 4/30/05. 

QuarkXPress 6.5 
#958816 

~ 

TuneJuice < "!~~i 
Perfect for extending 
the play time of your 
iPod. #193849 

s7999f 
only • 

17 11 LCD Display 
#486824 GEM 

$1'1:,9991 
only ;;I, • 
After $70 mfr. mail-in rebate. 
Pnce before rebate $229.99. 
Offer expires 4/30/05. 

. i'.l 
10mcga· 

REV FireWire 
Backup Drive 

#459719 

:;:..----' s35·r1 only ;,. 

AirPort Express 
With Air Tunes. 
#448199 • 

s77999J only • 

ilife '05 
ilife Mac ti 

#188278 •. , 

onlys74/ 

Great Flash Deals! 

#660825 

#964647 

#136443 

.f"~ 
t~a, 

512MB Secure 
Digital Card :a:t"' 532'5!' 
256MB CompactFlas~ • 
Card '3-F ' 11 "! 
Dis kGO! 256MB USB 2.0 
Flash Drive ~6"' 521" !' 

'With mfr. mail-in rebate. Offers end 4/30/05. 

NEW Mac mini 
Only 6.5'' x 6.5" x 2"! 
FREE Shipping! r 

'--- :s;:;> 

startingat$494J 

iMac"' GS 
FREE Shipping!' 
FREE 256MB RAM!t 

--= s72941 starting at , • 

PowerBook" G4 
FREE Shipping!' 
FREE up to 512MB RAM!1 

FREE Carrying Case!' 

starting at$7,594J ____ ,......__...,...._ 

Display sold 
separately. 

iBook"' G4 

Power Mac® GS 
_ FREE Shipping!' 

FREE up to 1 GB RAM!1 

• 
starting atS ], 4 94 J 

FREE Shipping!' 
FREE 512MB RAM!t 

startingat$899J 

'FREE RAM OFFER-RAM is free after $119 MacMall mail·in rebate for PowerBook G4 models (pnce before rebate is $119) or $49.95 MacMall mail·in rebate for eMac G4 models (price before rebate is $49.95) or $99 MacMall mail-in rebate for iBook G4 
and Power Mac models (pnce before rebate is $99). No rebate is required for iMac G4 models. Free RAM is not available for Mac mini. All free RAM offers require an additional $39.99 professional installation fee. 'FREE SHIPPING OFFER-Offer applies to 
all orders over $99! Affer MacMall mail-in rebate. Certain restrictions apply. Not valid with any other discounts. HufT)'! Offer ends soon! FREE SPEAKERS OFFER-After $9.99 MacMall mail -in rebate when purchased with any iPod or iPod mini. Pnce before 
rebate is S9.99. #569636 FREE PODSUIT OFFER-After $13.99 MacMall mail-in rebate with purchase of any iPod or iPod mini. Not available for iPod shuffle. Pnce before rebate is $13.99. FREE ENGRAVING OFFER-Get your iPod or iPod mini engraved for 
FREE when you purchase it through MacMall. Not available for iPod shuffle. Place your order now, then visit www.macmall.com/myiPod for details. FREE FM TRANSMITTER OFFER-With any iPod purchase after $19.99 MacMall mail-in rebate. Qualifying 
products: any iPod mini (Griffin IT rip mini #472978), any iPod 20GB - 60GB (Griffin iTrip #472977) or any iPod shuffle (Newer Tech RoadTrip #539343). Price before rebate is $19.99. All offers end 5/8/05 or while supplies last. 



SmartWrap 3-Pack PocketDock 
True it's another colorful hunk of silicone. It's also something 

you should have thought of. Wrap your excess headphone cord 

around the SmartWrap, and away you 'll go in streamlined style. 

Apple's new crop of iPods is coming up without FireWire, once 

a staple in the iPod experience. Our family of PocketDocks lets 

you leave your dock - and your USB cable - at home . . . 
sumaJin 

iSkin Wild Side 
Funk it up to the max, yo. 
Wild Sides come with 
hypnotic wheel cap, 

matching screen Shades, 
and a whole lot of attitude. 

iSkirl 

G ti 

" e 
0 

naviPro eX 
The next generation of 
iPod remote control, with 
album, slide show, or 
chapter navigation. Get it 

for 4G, mini , and black for 
the U2. 

I n ! Technology 

Dr. !Jott~ 

• 

Tune Power iTalk Haute Couture for iPod 
Give yourself a little more Springtime daydreams Formal wear for your iPod. 
time outside with the mean your attention span Sleek leather in black, 
sleekest of external isn't what it could be? iTalk white, red, and silver, 
batteries. Offering up to will record lectures or natural or glossy finish. For 

10 hours of additional meetings for later listening. iPod and iPod mini. 

juice. Like when you're awake. 

•tilJ!ifi• (GRIFFIN) I' /i@:../-

Buy Dr. Bott products at your friendly neighborhood Mac store. 
Find one on line at ,http://www.drbott.com/ phone: 800.541 .1230 



NEWI Coolpix 4600 
Coolplx 5400 . 
Coolp1x 8700 

NIKON 070 
• 6.1 MegaPixers 
• 1 .a~ LCD Screen 
564999 

0 100 -· 
NEW\070 Kit 

E- 1 .... 
NEWl Stylus 500 . ... . 
NEWI Sly Verve D;g ("'3M') 
NEW! Sty Verve Dig S ............ $279.99 

SONY DSC-F828 ~ 
• 1 .a~ LCD Screen 
· 4x Dig.nx Opt. Zoo -
160999 

OSC·S40........................ ALL 
OSC-$60 ........................... ... CALL 
OSC·S90 .............................. CALL 
DSC-EBB 

SONYDSC·T3 
· 5.1 MegaPixels 
• 2x Digital Zoom 
• 2.5" LCD Screen 
530499 

· 7 .1 MegaPixels 
· 4x Optical Zoom 
146999 

A85 .. . 
Pro 1 
A510 

ESO .. .... $249.99 
xso ...... $239.99 

IN FOCUS X2 

· 5888 x 4000 pixels 
• 4000 DPI Optical 
Resolution 
· USS 

NIKON Coolp1x 8400. NIKON D2H 
· 8 0 MegaP1xels · SLR Type Dig Came. 
· 10 OpV4x Dig Zoom · 5 47 MegaP1xets 
151999 · Uses Nikon AF·D/l/S 

NEWI Coolpix 5600 $224 99 s164999 
NEWI Coolpix 5900 ........... $279.99 NEWJ D2HS ............ ....... ....... CALL 
NEW! Coolpix 7600 .. .. ....... $309.99 NEW! D2X .... .... ... ... ..... ... $3699.99 
tjEWI Coolpix 7900 .... $329.99 
OLYMPUS C770 

4.0 MegaPixels 
· 1 Ox Opical Zoom 
130999 

· 6.1 MegaPixels CC.D 
· 2.0" LCD Screen 
160999 

LS-40 .. 

................ $3299.99 
............. 5289.99 
............ 5319.99 
...... ...... .. 5359.99 
...... .... .. 5389.99 

JVC GZ·MC200 
• 2. 12 MegaPixels 
· 1 Ox Optical Zoo 
• 200x Digital Zo 
• 1.8" Color LCD 

........ $619.99 

............ CALL 
............ .. ...... $3 19.99 

.. . .... .. . 51949.99 
.... 51549.99 

........... $3699.99 

NEW! DHR·1000 .. ... . $2979.99 

SONY DCR·PC350 
· 3.0 MegaPixels 
· l Ox Optical Zoom • 
· 2.5" LCD Screen 
• SLUETOOTH 

• 32" 
· HDTV 
• W·XGA LCD 
5249999 

PD·42WX84 .. 
LT·26WX84 
HD-522575 

Elura 65 .•.. ....... . ... $369.99 
Elura 70 ... . ...... $419.99 
NEWI Elura 80 ........... $389.99 
NEW! Elura 85 ........... $419.99 

JVCGR·HD1 
· 200x Digital Zoom 
• 1 Ox Opt. Zoom 
• 3.5" Color LCD 
·USS 

1164999 

NEW! GR·D250 .. . .... $279.99 
NEW! GR·D270 .. . .... $289.99 
NEWI GR·D295 . . .... $319.99 
NEWI GR·DF430 . .. ....... CALL 
NEW! GR·DF450 ............ CALL 
NEW! GR-DF550 ........... CALL 
NEW! GR·XS .............. CALL 

SONY HDR·FX1 
· 12x Optical Zoom 
• 3.5" LCD Screen 

Special! DSR·PDX10.$1499.99 
Special! DSR·PD170 .$2399.99 
NEWI DCR-TRV280 .... $264.99 
NEW! DCR·TRV480 .... $304.99 
NEW! HDR·Z1 ... ..... ... $4049.99 

PANASONIC PV-GS250 
· 3. 1 MegaPixels 
• 2.5" LCD Screen 

NEWI PV·GS16 ..... .... $339.99 
NEW! PV·GS19 ........ $299.99 
NEW! PV·GS31 . . ... $329.99 
NEW! PV·GS35 ...... ... .. $389.99 
Special! PV·GS55 ... 5349.99 
NEWI PV·GS65 .. . ... $449.99 
NEWI PV·GS1 SO ........ $499.99 
NEW! PV·GS400 ........ $879.99 
SV-AV50A .. . .... .. .... $249.99 

Slylus 3000 ..... ..... ...... 51179.99 

Optura 30... . .. ... $449.99 
NEW! Optura 50 ........ $549.99 
NEW! Optura 60 ........ $609.99 
NEWI Optura 400 ...... $589.99 
Optura XI ..................... $719.99 

SONY DCR·HC1000 
· 12x Optical Zoom 
· 150x Digital Zoo .. 
• 2.5" kCD 

s94999 . • 

NEWI DCR·HC21 ........ $339.99 
NEWI DCR-HC32 ....... $399.99 
NEWI DCR-HC42 ....... $459.99 
NEWI DCR·HC90 ....... $709.99 

NEW! DCR·DVD7 ...... $549.99 
NEW! DCR·DVD92 ..... $489.99 
DCR·DVD101 ............. 5469.99 
NEW! DCR-DVD103 ... $529.99 
DCR-DVD201 ....... .. .... $579.99 
NEW! DCR-DVD203 ... $569.99 
NEW! DCR·DVD403 ... $689.99 

PANASONIC AG·DVX100A 
· 3-CCD Imaging 

·Super VHS-
• 12x Optical 
• IEEE-1394 

5229999 · · · 
AG-DV2500 .... . $1279.99 
AG-DVC200 ........... $2649.99 
AG·DVC7 ......... . ... $749.99 
Special! AG-OVC30 ... $1349.99 
NEW! AG-DVC60 ...... $1749.99 
NEW! AJ·HDX100 .......... . CALL 
NEW! VDR·M54 ........... $449.99 
NEW! VDR-MSS ..... .. ... $529.99 

..... . $504.99 
.......... $569.99 
.......... $669.99 

Policy: Visa, Mastercard, Discover, American Express, Diners Club, Money Orders, Certified Check, (Personal Checks up to 14,000.00 with name and address imprinted on check). C.O.D. orders are also accepted. Orders by mail please 
print name address and phone number clearly. Shipping methods - in the Continental U.S.A. will be via Fedex, U.P.S. or Air Mail. Over size items via truci<. Shipping and Handling are additional. 21 days for return or exchange (video & dig
ital 7 days) with prior authorization only. (Call customer service for authorization number). Shipping and Handling are not refundable. All returns are subject to a minimum restocking fee of 5%. Prices may reflect mail-rebate. All returned 
merchandise must be in new condition and must include all packaging and printed material in original, unaltered condition. Broadway Photo is not responsible for typographical errors. All items are covered by USA, International or Broadway 
Photo and Video Warranty. Prices subject to change. Please check our website for current prices. All our merchandise Is brand new and factory fresh. Quantities are limited. Thank you and enjoy your order. MA 5/05 



[j 
_J 

~~~~tw.iiiiWl-..~~~~W:- Free Shipping 
We Have Over 20 PowerBook on Any Order 

$75RAM 
Rebate on Any 

New CPU!t 

Looking for 
Selection? configurations to Choose From! Over $100!* 

12" G4/1.33GHz: 256M8 RAM, 
6068 HD, Combo drive, 56k modem 
Airport Extreme .. .. . .. . . .. .. .. .. .. . . . . . .. .. .. $1299 

12" G4/1.5GHz: 512MB RAM, 6068 HD, Combo drive, 
56k modem, Airport Extreme, SMS, Scrolling trackpad . . $1494 

15" G4/1.5GHz: 512M8 RAM, 80GB HD, Combo drive, 
56k modem, Airport Extreme, SMS, Scrolling trackpad .$1994 

17" G4/1 .33GHz: 512MB RAM, 80GB HD, Superdrive, 
56k modem, Bluetooth .. . .. .. .. .. .. . .. .. .. .. .. .$2399 
17" G4/1 .67GHz: 512GB RAM, 100GB HD, Superdrive, 
56k modem, Airport Extreme, SMS, Scrolling trackpad .. $2694 

You can't find a cleaner, 
more reliable Certified 
Pre-Owned Mac than a 
PowerMax machine. We 
literally refurbish hun· 
dreds of pre-owned Macs 
every month. Each 
machine is extensively 
cleaned, bench-tested and • ..:=..• .. iiii...• 
carries a 90-Day Warranty. 

Special Offers on Custom-Configured Machines 
G4/1.25GHz Mac Mini: 512M8 RAM, 4068 HD, 
C-Ombo drive, 56k modem ... . .......... .... . .. . ... $574 

G4/1 .25GHz Mac Mini: 512MB RAM, 40GB HD, 
Combo drive, 56k modem, Airport Extreme Card . .... . ... . . $653 

64/1 .0GHz iMac: I GB Apple RAM, 80GB HD, C-Ombo drive, 
56k modem 15-inch display ........ . . .............. . $1298 

G5/1 .6GHz iMac: 512MB RAM, 8068 HD, Combo drive, 
56k modem, 17-inch display .. . ....... . . . . . ..... .. . . $1374 

Build Your Own Xserve 
RAID --Ask Us How! ex~~~~~t~inis 
Certified Pre-Owned Specials 

Power Mac Dual G4/450MHz Graphite 
256130/DVD·RDM - 5 more like this ...... . $729 
Power Mac G4/800MHz QuickSilver 
256110/SuperDrive - 14 more like this . . . . $1109 
Power Mac G4/1.2GHz Mirrored Door 
256180/Combo/dual boot - 6 more like this $1479 
Power Mac G3/350MHz Yosemite 
12816/DVD·RDM - 28 more like this . ...... $259 
15-inch PowerBook G4/400MHz Titanium 
640110/DVD - 15 more like this ... . . ... . . $949 
14-inch iBook G3nooMHz Snow 

The PowerMax warehouse is 
stocked with over 1000 different 

Mac configs; from fully 
loaded G5 Power Mac Duals 
to Certified Pre-Owned Indigo 
iMacs -- we've got it all. We'll 
even custom-configure a 
Mac for you. Get more RAM, 
larger hard drives, wireless 
networking and more! 

:r.:::.::~-~=,,,.. .... 

This powerful electronic 
microscope (up to 200x) con· 
nects to your computer via USB. 

, Takes stills and Quick Time 
movies. Kit includes ProScope, 
software and 50x lens. 

Just $249 

256130/Combo - 75 more like this ...... . . $769 
~~z::;:~~~-;;;;;;-~--~ 

Dr. Bodelin's laptop Bumpers 
Extend the life of your laptop with 
Dr. Bodelin's Laptop Bumpers. 
These simple, removable and 
affordable cushions help cool and 
protect your precious machine. They 

Become a Preferred 
Customer with PowerMax! 

OWER 

even angle your laptop for more • ; 
ergonomic keyboarding! ,.. 

1
mult1pfe , 

Just $14.99 , ~o or choices, 
""'· available! l PowerMax Batteries 

j Our exclusive PowerBook batteries last longer than 
any other brand! Starting at $119 

Local: (503) 624-1827 • Fax: (503) 627-1635 

Email: sales@powermax.com 

Knowledge is Power 

Authorized 
Reseller Prices subject to change without notice. Credit card orders s!Jictly verified against fraudulent use. With use of credit card as pay

ment, customer acknowledges that some products are subject to final sale. Many prices are limited to stock on hand. All brand 
Apple Specialist names are registered trademarks of their respective holders. Not responsible for typographical errors. 

Are You A Member Of A User Group? 

www.applemugstore.com 
PowerMax is a division of CSNW, Lake Oswego, OR 

Macintosh User Group members enjoy access to a very special 
Apple-sponsored web site featuring super deals on the latest Apple 
products and more! If you are currently not a member of an Apple 
User Group and would like access to the Mug Store special offers, 
discounts and resources, then contact an Apple User Group near 
you and sign up! 



Macworld 
BEST OF 
SHOW ---.. ~ .. 

• Connect to AirPort 111xpress 
to controt iTunes 

• Connect directly to Mac 
to control iTunes, OVD, 
QukkTime and more! 

0 .., 
I 

Part# URM·17A MSRP $59 ~ 

~~---..--" 
The Ideal. Presentation lioQH 

• RF coanecti"i.ty 
• Laser pointer 
• 2-button mou~e 
• Programmable 

Part# PR·US2 MSRP $5.9 

.,, rvt:. DAN Connections for your Computer 
E\&; '~,-,.. www.keyspan.com 

Gacally"' 

• Fast, advanced, proprietary techniques. 
• All operating systems; Mac, Windows, OS/2, 

Netware and UNIX 
• All storage devices including SAN, RAID and 

NAS systems. 
• Instantly retrieve recovered data 

witl1 DataExpress••. 
• Recommended and certified by all 

hard drive manufac~ ·re·c. 
• Government Contn - ; 

''We Can Save It!" • Featured on MacAddict,MacWorld, 
CNN, BBC and others. 

Sinu 1985 

Visit DriveSavers at www.drivesavers.com 
©2003 DRIVESAVERS. INC 400 BEL MARIN KEYS BLVD., NOVATO. CA 94949 INTL: 415-382-2000 

INCREDIBlE DEAlS 
iMacs • PowerMacs • Hanl llriVes • CDROMS •RAM• Mtniters •Video Cards· service Pans· MORE 

i Macs starting at 

Monitors starting at 

Pr· ters 

roJ Madefor 

~ iPod 

All Nevv iPod Accessories 

[fil LlJUJ ~WAVE 

Bluetooth Stereo And 
Tune Streaming Headset 
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Call us for dealers near you 1.800.644.1132 or visit us at: www.macally.com 
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FAMILY HISTORY - GENEALOGY 

REUNION®8 
Reun ion 8 is the perfec t t oo l t o 
organize your family history. Plenty of 
room for names, dates, places, stories, 
notes, tidbits, and 
sources. Include 
all your favorite 
pictures, sounds, 
and home movies. 
Aut o m ati c ally 
build multimedia 
we b p ag es to 
share your family 
hi st o ry on the 
Intern et! Print larg e, colorful tree 
charts, timeline charts, and fan charts 

for family reunions. Fun 
and educational fo r the 
w hole family. Reunion 8 
takes advantage of OS X 
and includes over x 
1 00 new fea tures 
and enhancements! 

Leister Productions 
web site/demo: www.LeisterPro.com 

e-mail: info@LeisterPro.com 

Handles for !books, 
Ti, 12, 15, 17 PB 

Handles & 

Want better signal and 
easier transport where 

ever you roam? 
QuickerTek has you 

covered on both ends. 

Visit us online 
today! 

Go farther. 
~~ 

www, quickertek. com 

Auto/Air Power Adapters 
for all 

Ti tanium G4s & iBook models 
Replacement Mini 

AC Adapters 
for all 

Titanium G4s & iBook models 
(65 Watts max.) 

Lind adaplersfcaturc: 
•Fault prolcction circuitry 

with Automatic reset 
•Durable.ABS housing 
•Nylon carrying case 

Mini AC ndaJ)tcrsfcah1rc: 
• 100 - 240 auto s1uitch ing input 
• Fold away outlet prongs 
• Conuinient cable UJrop 

with Velcro .,.... Strap 
• 4 . .1 x J.6 x J .J " 

LUonAuxiliary Power Packs 
For all Ti G4s & iBooks 

Extend your laptop runtime 
3 to 4 times longer 

Lightwieght 
2.4(MP6o)lbs - 3.4(MP9o)lbs 

Size -11 .25 x 8.5 x .5" 

Order online at: 
www.lindelectronics.com 

or call #800-897-8994 to order 
lJnd Hectronlc~. Inc. (•.JJ-4 Cumbrid)..tt· Stn:ct, ~1iruu.:apolis. MN S5-l:.t0 ').;:.?.~'J:!""·b:JO:J 



••lhhitillf~ Nf W( Advanced molecular 
release agent safely 

~!filTPl 
l:.m-11111n4I 

~---::;...:;_; 

cleans ALL Displays, 
Lenses, CDs and 
much more! 

11 ... it's the best display-cleaning 
juice I've ever used. II 

Bob Levitus 
Houston Chronicle 

www.radtech.us/ma 

Software Savings for Students, Teachers, and Schools! 
Get up to 85% off retail software prices on the brands you know and use •.• 

f Adobe® 
~ Photoshop CS 
~ Save! 57% 
< Order Today! 
• Get the Best for Less! 
~ 

Macromedia® 
Studio MX 2004 
Save! $710 
Now! $189.95 

4 Programs - 1 Price! 

Ouark® 
QuarkXpress 6.1 
Save! $856 
Now! $189.95 

The lnduslly-Standanl! 

"" , ,; ' ro: ~~ ,~ J~ . ' 

~'' 
-- -

Wacom® 
lntuos3 fixB 
Save! $50 
Now! $279.95 

Great Graphics Tool! 

We carry thousands of industry-leading software and hardware products at huge discounts for students, teachers and schools. These special prices are 
ONLY for the academic community. And our prices are typically $10-$20 lower than most college bookstores! Call or visit us online today and start saving! 

Adobe® Macromedia® 
Acrobat Pro 7 .. .. ..... ... Save 69% Flash MX 2004 ................ ..... $95 
Creative Suite ............ Save 69% Dreamweaver MX 2004 ....... $95 
Video Collection ........ Save 55% Contribute 3 ........................ . $89 

Alias® MakeMusic® 
Maya Complete Student... .. $289 Finale 2005 ............................. $199 

Canopus® Microsoft® 
ADVC-300 AID Converter ... $399 Office 2004 Student/Teacher .. $139 

This Month's Featured Titles: 
hp Business Inkjet 1200d ... $309 
Eovia Carrara 4 Pro ............ $139 
Apple iWork ....... ............. ...... $75 
Inspiration 7.6 ... .. ..... .. .......... $49 
Avid Xpress Pro Student ..... $295 
Painter IX ... ..... ....... ....... ........ $95 
Epson Stylus Photo R1800 .. $499 
Sibelius 3 ....................... ..... $209 

Parents: 
Buy for your 
students at home 
or away at college! 

Give us a call anytime! 1-800-294-4035 ACAD 
SUPERS Visit us online! MA.AcademicSuperstore.com 
---~ --- - ~ ----· · - -- ---- -----·-- - - - / 
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918-~~;-6340 (6227) 

G3 & G4 lbOOkS IMac& eMac 

G3366 $379• G3Traytoad $199t Beige $69' DP1.8Ghz $1749' 
G3 500 $4491 G3 Slolload $299• BUe& wti1e $219' DP 2.0 Ghz $2149' 
G3700 $5291 G4Aa!Panel $449 ----
G3800 $609• AirPort Cards Ch AirPort Extreme Kensington 
==~=~~ ~; $109 ~ SGg SludioMo~;: wireless 

tll11llilJ GI Hf;fJfl 1IA;ldtbMEd]i ~! " lntego z1p 100MB disks 3/416110 pack s10113119132 Internet 
~:~ ~~g~: ~~~sP~~=r~~c~rive $1912~~~ v~ Security 
H lpz1p eoMB MP3 Player s29 ' Barrier 
HlpZip Auto Adaptor $14 • • 
Pocket Zip Disks $4 ·-=''{..~tlon ~,.!·~':1£d1t1an 
Peerless FW drive 10GB $49 • VlrusBllrrier • VirusBanlet 

Peerless 10GB Cart/ Extra FW Base $34/14 Fl ICul~YN 1 ~H~ $59/149 · c.on111111 Barr1er · Conten!Blltrie< 

FotoShow T•ovol Kit/ Remote s19119 Ill ....,.,ess ' · S54! $39 · 's4g~ 
FoloShow AC Adaptor/S-Vldco Cable $19/4 flnalCulProHQtt s99 MSRP s 129 MSRP 

~!~~o~:~r~~e;~~·~~GB 5:! •tt;f1!1AfflmlEJ9 
40x12x48 FW CORW SGS ~62· PC.:.=tt.,~,._. $19 
J az SOpln HD to 50pln Centronics Cable $14 ~ 
Zlp Monitor MllT'Or S4 

FREE w/online$10pu""8se Gaire!CD-•llm•rnlilrl!'l flil -Fi)! I ' :r;~~;':!ji-l::lil - 1::1 • 1-1.Wa ~~tt~~~~r ~1: 
=~(:'JxiHD §~33 GroiE! l 1l7Muftilrld'~~· SS 

,...,oM ••tV•s Seemegmacs.canl trdan Office 2004 ~~i.o. 19 

~ ~~~=FW ~~~ Standard -$179/249 •• 
A.~I~i~(f~0 s~Efg~~~~~~lac1cdnWstu Pro $469 = ' • • 

I 
AJJplecare Megaoeals : . ; 

BodyGloveNotebookcasesrrtsw.lo1T' S24 'i:.~1eMac sr,~ ·' - ~ '. : ; 

~~~~l~~~~;~1~~~rfTargusDe1coo ~: ~ ~::E::kG~Gs ii!! , :: ', ' . .. ,: 
Brenth~~:r.5"'~~~~/~o/IMSPI' 

MttllittOne •<Mrsizt!d/Fusionflex SS6/94/94 

iEm'J.I.§JJ·M iflh§· 
MacAlty Mod la Keyboard $34 Nyko 2button Optical S12 

~~~m;~l~~v~go~~~ard m =g=lt ~; 
Grnvl9 use Gomopod $9 Apple Pro Mouse~ S38 

• ., I I :.-f: I :J<-i. :J ! t)l,li1l Ii iW 
Harman Kardan JBl 
Champagne ....... $34 Creatures --er-
Champagne-.-- $34 19.SSpeakers 
Duets $24 Invaders {80 watts!) 

559 
$13 
549 

~utualPCl•M'•dowsXP· 
S194 

iLife '04 
$35 

MacOSx.J~ntll!r 
OEM/RElai $59/99 

CEMNli!OO/OICD- 564189 
CEM WTe:::flTc:dPro4$150 
i\til1'TedltcdPro4S164 

. . FREE Norton SystemWO<ls rn !OEM) avaio1t0wi1lt any 120 on!ine pttttltase! 

p:f;~~;,im.;/if8;~sc:t:~ WE BUY MACS! -Je~~r~is~;8rat:~1i~~'i~i~u~Pv90~?gn 
Soo wobsito/or~Pofk:ios We s tock many parts! ttFree ground shipping only available !or online orders 

See all these deals and more at www.meuamacs.com,macaddlct 

~ a u 
• w 

0: 

~ 
0: 
<( 
~ 

Trai lVue co lor op tio ns 

Providing Complete 
Solutions to CAD/ AEC & Design Professionals 

VectorWorks 

$975 Encad T-200+ 
Industry Standard MacOSX 

2d/3d CAD Software 
Unbeatable 

Mac Draft Bundle 

$299 $2,999 
Easy to Use 2d CAD 

SEH IC-105 
<!ili UZR iModeler Print Server J.ib"CtlD 

Web $99 $189 
Create 3D Models Using Connect Your Printer 

Your Digital Camera To Any Network 

• MacDraft P.E. $119 • Encad and HP Printers 
• DWG Viewer $49 • SEH Networking 
• Microspot Interiors $129 • Plotter Paper and Ink 
• 20 lb Bond Paper $ 7 .11 /Roll 

Call us or check out our website for a complete selection of 
our products. Academic prices are also available. 

1-800-622-7568 
www.macroenter.com 

Metrovue 3 pack 

ValueAdde 
Reseller 



~ .. some call them Hoods! 
(800) 818-3946 

www.HoodmanUSA.com 
::: -· 

We 've got all the memory solutions you need for: 

Power Mac G5 ~ 
Power Mac G4/G3 ~ "'""" 
iMac/eMac ~ .o'tOOo/~ 
PowerBook G4/G3 ]£: ·;.;,.,· 
iBook G4/G3 ~ 

SUPER LOW LOW PRICES! 
SUPER SAVINGS on Apple'" 9ear! 

iPod Mini Silver 4gb 8hr battery $179 
with Free Ground shipping 

AirPort<l\ 

PowerBook 64 15" 1.336Hz $1699 
256mb/60gb/Combo/BlueTooth/56K/AirPort 
with Free Ground shipping 

AirPort® Card 
Original 802.11 B 

Original Apple Service Part Batteries-In Stock! 
15" Ti PowerBook 64 Battery 
iBook 12" 63 300-466 Battery All $99 
iBook all 12" white models Battery limited quantities available 

Check Us Out for iPod Goodies, Hard Drives and Accessories! 

800-46l-ll60 
Note: Prices are subject to change. 

ONLYS79! 
Adapter for iMac G3 $ 39 

MAJ09 

iPodMi11i's 
l11Stoc1im 

SAVE BIG 
Instant Rebates 

www.macsolutions.com 
FREE Ground Shipping oo all lpple Towers & Displays 
• Note:AJJp1e Productsareavallabletoourrepealcustomersonly. 

ti Apple Specialist 
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Come On, Show 
Your Site Some Love ... iMacG5 

256mb-$55 
512mb - $99 

~---1Gig - $249 , 

High-Performance 
Mac Memory 

iBook G4 

256mb- $69 
512mb-$99 
1Gig - $299 Get a FatCow"' 

• 1 Gig of disk space 
• 30 Gigs of monthly transfer 

· 100 email boxes 
8·25 W bM ·1 month • e a1 

• Spam & virus filtering 

• ShopSite Shopping Cart 

• SiteDelux Site Editor 

Get a MiniMoo 
• Domain parking 

• 1 email account •. 
• WebMail 
• Spam & virus filtering 
·Customize your own 

coming soon page 

• No Setup Fees 

- Web Statistics 
- CGI, PHP, MySQL 
- Search Engine Tools 
- Message Board 
-Toll-Free Support 

PowerMac G5 
512mb - $99 
1Gig - $199 
2Gig -$389 

PowerBook G4 

eMac DOR 

256mb - $55 
512mb- $99 

) 1Gig - $199 

Secure Online Ordering: 

512mb - $99 
1Gig - $299 

G4DDR 

512mb - $99 
1Gig - $199 
2Gig -$389 

WWW. RAMJET.COM 
1-800-831-4569 

12 issues for only $12 

MOBILE MAGAZINE is the world's leading 
authority on mobile technology 

A savings of 83% off the 
newsstand ratel 

Subscribe to Mobile at 
www.mobilemagazine.com 

or call toll-free 
800-266-3312 

Offer good in U.S. only. One year, Canada: U.S. $26 (includes GST) . 
One year, Foreign: U.S. $39. 

Prepaid in U.S. funds. Newsstand price per issue is $5.99. 
Please allow 6-8 weeks for mailing of first issue. 



1.800.797.7321 www.raindesigninc.com rain design • 

Simply Talk ... 
. . . and leave the typing to us. 

Still only 

$149.00 ~ 
with USB 0 
headset! ~ 

ilisten 

MacS peech is the only company cuITently developing 
dictation software for Macintosh. iListen users enjoy the 
ability to dictate into virtually any application, hands-free 
correction, and the largest set of voice commands available 
on any platform. 

Available at the finest Mac resellers 
or from www.macspeech.com. "Mac-only" 

company 

MacPrices.com 
Nothing But (Mac) Prices MAC 

OFALL • 
TRADES 

WE BUY AND SELL 

USED MACS 
Find the lowest price! 

Get the best free bundles! 

www.macprices.com 

TonJ of the Holte.It 
~ iPou Gear in Stocki 

~ ~werBookJ/ Tower.JI 
Parl:J/ Parl:J/ Parl:J/ 

lowest Prices 
. fast Deliverv 

EvervtbinuMacintoslL..Evervthinul 

WWWJllC-1110.COm 
800-525-3888 
Broken Powerbook? 

Fixlt. Cheap • 

avoid cost ly service 
do-it-yourself Powerbook & iBook repair 

free onl ine Fixlt Gu ides 
thousands of parts and upgrades 

6-month warranty on most products www.pbfixit.com 

Exclusive-hosting provider for 

MacAddi t 

Special web site hosting offer 
for MacAddict Readers! 

Web Hosting 
Co-Locatio 

www.lnno-Tech.com(MacAddict 

lnnoTech 
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LETTERS 
PATTERN 
RECOGNITION 
Here's something I came 
across recently that I 
haven't seen mentioned 
elsewhere. Look at the 
Mac OS 10.3 (aka Panther) 
install disc (top left) and 
the soundtrack CD for the 
Denzel Washington biopic 
Malcolm X (top right). 

00 
Imitation is the 
sincerest form 
offlattery. 

Notice anything? Makes you 
wonder about Tiger-will its 
logo resemble my design 
with the crossed golf clubs 
(bottom left)?-Peter Weisz 

MAKES CENTS 
I noticed in What's New 

(Mar/OS, plS) that logear 
(www.iogear.com) is selling 
its 20GB 1.8-inch Ion combo 
drive for $249.9S-the same 
price as its 40GB model. 
I think I'll buy two of the 
20GBs instead of one 40GB. 
That 's just good shopping 
cents. (Tee-hee ... get it? 
Cents? Sense?)-Paul Barker 

We get it, Paul , we get it
and we got the prices of the 

Survey 
Says 
Here are the results 
of our January 200S 
survey. Check out 
www.macaddict.com 
each month for a new 
online poll. 

78 MacAddict May 2005 

Ion drives wrong. At press 
time, they were $209.9S for 
the 20GB unit and $2S9.9S 
for the 40GB one.-Max 

INSTABLOG 
I enjoyed "Blog Your .Mac 
HomePage" (Mar/OS, pS2). 
I have a blog of my own (www 
.wizardswords.blogspot 
.com) that I built in about 30 
minutes using Blogger. To 
find this service (it's free, by 
the way) go to Google.com, 
click More, scroll down, and 
click the red-orange B icon . 
If you like what you see, get 
busy and make a blog! I can't 
write a line of code, but I can 
use Blogger.-Wizard 

TAPED DECK 

WINDOWS XXXP 

My son Ben, an avid card
trick enthusiast as well as 
a creative artist, did some 
cutting and taping when he 
got his new iPod last week. 
The result was his new 
Loaded Deck iPod case! 
-James Steele 

Bill Gates is sleeping in my bed. How can I get 
him to go away?-A. Venglar 

Oh , that Ben-what a 
card! - Max 

Aww, why would anyone want to boot cute Iii' 
dreamboat Billy outta bed?-Max 

Giving new meaning to the 
term recording deck. 

LAST YEAR, 
LOST YEAR 
In your iWork 'OS preview 
("Think Big," Mar/OS, p16), 
you claim Keynote 2 is "an 
upgrade to the presentation 
software released last 
year." This isn't true. 
Keynote was released in 
2003, not 2004. Keynote 
2 was relea sed a full two 

Which Apple expo announcement 
most thrilled you? 

70% 
Mac mini 

93S respondents 

10% iPod shuffle 

9% ilife '05 

7% iWork '05 

4% John Mayer's 
Grammy nominations 

years after the original 
Keynote.-Tony 

Ah, how time flies when 
you ' re having fun .-Max 

BAND OF 
iBROTHERS 
I teach Intermediate Band 
at a high school. Last year, 
in an attempt to update 
what I felt was a slightly 
demeaning name, I started 
calling it the iBand. The kids 
loved it, and the name has 
really caught on.-0. Rutan 

BITTER PHIL 
Your articles on Halo 
("Halo's Here," Nov/03, 
p39; Reviews, Mar/04, 
p38) have made my life a 
wasteland of Grunts, Elites, 
and Hunters covered in 
purple pus, not to mention 
frumpy, creepy Flood 
dripping in brown goop. 



The Flood remind me of 

my ex-wife-they just keep 

coming and coming, just 

like the ex and her attorney 
at the divorce hearing. 

- Ph illip Anthony Briles 

MOM'S AN ADDICT 
Our family got a new iBook 

G4 after a recommendation 

from me, a die-hard Mac 

fan. After showing my mom 

how it works, she's now 

on the thing all the time! 

Is there any way to get her 

off the iBook and back to 

Windoze?-Lucas Wagner 
Lucas, Lucas, Lucas-that's 

your poor, long-suffering 

mom you're talking about! 

Save your lunch money, 

buy a Mac mini, and let 

the ol' lady have some 

fun .-Ma 

EYEHOMEOWNER 
I recently purchased an 
Elgato EyeHome digital 

media player ($199, www 

.elgato.com) and found 

that many of the problems 

associated with your earlier 
review ( __,._; May/04, 

p55) have been eliminated 

with the new EyeHome 1.52 

update. I have a dual lGHz 

Power Mac G4, four internal 

and six external drives, 

4,000 photos in iPhoto 5, 

15,000 songs and books 
in iTunes, 96 TV shows 

in an EyeTV archive, 100 

MORE FUN WITH SSH 

MPEG movie files (mostly 

EyeTV-archived shows), 

and 150 DVD movies. I 

have no problems playing 

a movie downstairs on my 

Eye Home unit while doing 

other work on my Mac-it 

works flawlessly. If I were to 

rate the updated Eye Home, 

I would give it four-plus 

stars.-Greg Speck 
Glad to hear that Elgato has 

spruced up its EyeHome

but we call our blue review

ratings buttons "widgets," 

not "stars."-Max 

The new Mac mini cookie 

requires little dough. 

SMART COOKIE 
When I was making 

Christmas cookies with my 

grandparents, we had a 

little blob of dough left, so 

I made an Apple. That tells 

you how often this loyal 

12-year-old reader is 

thinking about Macs. 

-Keanan Koppenhaver 
Kudos to Keanan "Keebler" 

Koppenhaver, the Cookie 

King! - Max 

The March '05 issue's Unix University mentions that you 

can connect to a Remote Login-enabled Mac from another 

Mac. What you forgot to mention is that you can connect 
from just about any other computer that has an SSH 

cli ent, no matter what OS it's running-Windows, Mac OS 
9 or earlier, Linux, Solaris, lrix, whatever. For example, I 

regularly control iTunes on my Mac OS X-equipped eMac 

by running MacSSH (free , www.macssh .com) on my Mac OS 

8.1-equipped PowerBook 540.1 use one of the more useful 

commands in Mac OS X, osascript, to run iTunes-controlling 
AppleScripts on my eMac from the command-line interface 

of MacSSH on the PowerBook 540.-Andrew Seidl 

Win a Set 
of ProSticks! 
This month, win a set of ProSticks-maxi-muscular, 

audiophile-quality powered speakers from DVForge ($399, 

www.macmice.com) . Just write the best caption for the 

picture below and send it in! 

Only one entry per contestant. 

Entry Form 

Write a caption for this picture. 

CONTESTANT INFORMATION 

Full Nameo 

Address, 

Cit' Stateo 

Zi 

Email or telephone: 

Send email e ntries to: contest@macaddict.com with the subject: ProStlcks Contest 
(Don't forget to include your address Information!) 
Send s nail-mall entries to: ProStlcks Contest , MacAddict magazine, 
150 North Hill Dr., Ste. 40, Brisbane, CA 94005. 
Deadline for entry: May 31, 2005. 
Contest results wlll appear In our Sep/05 issue. 

Contest Rules The judges will be MacAddict ed itors and will base their decision on 33 percent humor, 33 percent 
originality, and 33 percen1 creativity. All entries must be received no later than May 31, 2005, with the wi nn er 
announced around September 2005. By entering this contest, you agree that Future Network USA may use your name, 
likeness, and Web site for promotional purposes without rurther payment. All prizes will be awarded. and no minimum 
number or entries is required. If two or more people enter identical winning captions, the entry received first will be 
awarded the contest prize. Prizes won by minors will be awarded to thei r parents or legal guard ian s. Future Network 
USA is not responsible for damages or expenses the winners migh t incur as a result ofthls contest or the receipt of a 
prize, and winners are responsible for income taxes based on the vatue oft he prize received. A list of winners may al so 
be obtained by sending a stamped. self-add ressed envelope to Future Network USA c/o MacAddict Co ntest, 150 North 
Hill Dr., Ste. 40, Brisbane, CA 94005. This contest is limited to reside nts of the United States. No purchase necessary, 
void in Arizona, Maryland, Vermont, Puerto Rico, and where prohibited by law. 

Winner! 
Congratulations to Matthew Echert, 

who won a copy of Macromedia's 

Studio MX 2004 ($899, www 
.macromedia.com). And special 

thanks to the 117 readers who 

contributed some variation of 

"C'mon baby, light my fire ." 

OK, now where are the 
Rip and Mix ports? 
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UNIT PRICE: $155.171/b. 
Reg. Price: $499 

SAVE $196 on 4 
Thru Tue. Mar. 01 



What Mac users are saying 
about Earthlink® High Speed. 

You love your Mac. What about your Internet? 

Meet Earth link High Speed. Get your heart racing with 

a blazing-fast connection that's up to 3M bps. You'll 

download your free iTunes and photos in a snap, 

watch movies, play games, and more. And with 

Earth link, there's a lot more to love than speed: 

> Protection from online scams, email viruses, and spam 

> Free dial-up access for 20 hours a month 

> 8 email addresses, each with 10MB ofwebspace 

> Address Book syncing 

> Award-winning, Mac-friendly customer support 

> 20 FREE song downloads from iTunes 

Call: 1.866.263.7370 
Click: www.earthlink.net/golmacaddict 

•Offer good for a limited time. Service not available in all areas. Certain taxes and 
fees may apply. Prices subject to change w ithout notice. Otter available to select 
new Earthlink High Speed subscribers only. May not be used in conjunction wi th 
any other offer. DSL offer requires a 12·month subscription. Early·termination 
fees apply. Introductory offer of first 6 months w ill be billed at $19.95 per month; 
$39.95 per month thereafter for 1 .5Mbps service. Includes standard DSL instal· 
ration kit. Does not include shipping and handling charges. Additional equipment 
may be required. 01her restrictions may apply. ~ •Tue iTunes Music Store Gift 
Certificate code will be sent to your Earthlink email address after your first complete 
monthly payment is received. Please allow 4- 6 weeks processing time. See 
iTunes Web site for redemption usage instructions. 

© 2005 EarthUnk, Inc. Earthlink and the EarthUnk logo are registered trade
marks of Earthlink, Inc. iTunes, Mac and the Mac logo are trademarks of Apple 
Computer. Inc. registered in the U.S and other countries. Trademarks are property 
of their respective owners. All rights reserved. ______ _:F~22::;6"'::.:;53:::_7:_.!:::===~---J 




